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Trilithic Company Profile

Trilithic is a privately held manufacturer founded in 1986 as an engineering and assembly
company that built and designed customer-directed products for telecommunications, military, and
industrial customers.  From its modest beginnings as a two-man engineering team, Trilithic grew
over the years and broadened its offerings of RF and microwave components by adding
broadband solutions to its product line.  This was accomplished with the acquisition of
components manufacturer Cir-Q-Tel and instruments manufacturer Texscan.

Today, Trilithic is an industry leader providing telecommunications solutions for major broadband,
RF, and microwave markets around the world.  As an ISO 9000:2001 certified company with over
40 years of collective expertise in engineering and custom assembly, Trilithic is dedicated to
providing quality products, services, and communications solutions that exceed customer
expectations.

Trilithic is comprised of five major divisions:

• Broadband Instruments and Systems
Offers test, analysis, and quality management solutions for the major cable television
systems worldwide.

• Telecom Solutions
Offers affordable, easy-to-use instruments for testing and measurement of Telecom
networks.

• RF Microwave Components
Provides components and custom subsystems for companies specializing in cellular,
military, and other wireless applications.

• Emergency Alert Systems
Leading supplier of government-mandated emergency alert systems used by broadcast
TV, cable TV, IPTV, DBS, and radio stations.

• XFTP
Offers a specialty line of field technical products for cable operators and technicians, as
well as a line of products for installing electronics in the home of the future.
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Section I: The Basics

WorkBench Software
(and WorkBench Lite Software)

for the 860 DSP, 860 DSPi, 860 DSPh, 860 DSPr, and 8300 FST
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Helpful Website

The following website contains general information which may be of interest to you:

http://www.trilithic.com

Trilithic’s website contains product specifications and information, tips, release information,
marketing information, Frequently Asked Questions (FAQs), bulletins and other technical
information. You can also check this website for product updates.

Where to Get Technical Support

Trilithic technical support is available Monday through Friday from 8:00AM to 5:00PM EST.
Callers in North America can dial 1-317-895-3600 or 1-800-344-2412 (toll free).  International
callers should dial 1-317-895-3600 or fax questions to 1-317-895-3613. You can also email
technical support at techsupport@trilithic.com.

For quicker support response when calling or sending email, please provide the following
information:

• Your name and your company name

• The technical point of contact (name, phone number, email)

• The version number of the WorkBench software (this appears in the Help menu About
WorkBench... selection)

• The version number of the Windows software (including any service packs and patches)

• The database that you are using

• A detailed description of the problem you are having, including any error or information
messages

1. General Information
Chapter 1
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How this Manual is Organized

Thank you for choosing Trilithic’s WorkBench Software. This manual is provided with the
WorkBench Software to help the user become better acquainted with the software and to become
productive faster. This manual is divided into the following sections:

• Section I: The Basics - provides Trilithic contact information, describes how this
Operation Manual is structured, provides installation and registration instructions, and
gives an overview of the WorkBench Software and it’s basic features. Before using the
WorkBench Software, it is recommended that the user read this section for an overview of
features, setup, basic commands and other important details.

• Section II: Managing Devices and Data  - provides details on how to connect to the 860
DSP, 860 DSPi, 860 DSPh or 8300 FST as well as how to import and export data to and
from the devices. This section also includes information on how to analyze the data
collected from these devices.

• Section III: Configuration Files - provides information on how to configure Channel
Plans, Locations, Auto-Test Macros, Task Sheets and Text Files.

• Section IV: Managing Configurations  - provides details on how to create configuration
packages for the 860 DSP, 860 DSPi, or 860 DSPh.

• Section V: Trilithic Data Manager (TDM) Component - provides information on how to
configure and use the TDM component of WorkBench to send and receive information to
and from the 860 DSP and 860 DSPi remotely over the internet.
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Conventions Used in this Manual

This manual has several standard conventions for presenting information.

• Connections, Menus, menu options, and user entered text and commands appear in bold.

• Section names, Web and email addresses appear in italics.

A NOTE is information that will be of assistance to you related
to the current step or procedure.

A CAUTION alerts you to any condition that could cause a
mechanical failure or potential loss of data.

A WARNING alerts you to any condition that could cause
personal injury.
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Overview

WorkBench is the Windows-based companion software for 860 DSP series devices and the 8300
FST. It is a Web-linked application that supports and augments the many functions and features of
Trilithic’s 860 DSP Interactive Cable Analyzers and 8300 FST Forward SpeedSweep Transmitter.

The 860 DSP performs most of its functions through Digital Signal Processing technology rather
than dedicated hardware, making it easy to keep the 860 DSP current with changing applications
and conditions. WorkBench lets you install and configure continuous feature updates quickly and
easily. You can also expand the features available to you on your 860 DSPs by purchasing
additional performance options, downloading them from the Trilithic Web site, and installing them
at your convenience.

2. Introduction
Chapter 2

Features

You can use the WorkBench software to do the following:

• Customize your device to meet your specific needs and preferences by configuring the
navigation menus

• Choose and edit channel plans, locations, auto-test macros, and configuration packages

• Set a wide variety of device measurement options, test mode options, and performance
limits for auto-test functions

• Analyze and report on data collected from your device, including performance to user-set
limits such as analog signal amplitudes, digital signal power, signal quality, carrier/noise
ratios, MER and other measures of digital performance, and key return path
measurements

• Identify and download firmware updates and new options from the Trilithic Web site that
can then be stored in WorkBench until it is convenient for you to load them into your device

• Install and configure firmware updates to enhance existing features and add new
capabilities

• Receive announcements of new features and functions, firmware revisions and updates,
new product options, and other performance enhancements by clicking the banner at the
bottom of the WorkBench Navigator window

With WorkBench, you can create the most effective menu structure and set all of your devices to
have uniform features, settings, and configurations. Your technicians won’t have to spend time
reconfiguring or relearning how to use individual units; they can instead get right to work with no
lost effort. You’ll soon see that the WorkBench software is a powerful adjunct to Trilithic’s devices
that makes configuring, maintaining, and customizing any number of devices a snap.
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3. Software Installation
Chapter 3

Once you have made sure that your system meets the minimum requirements, you’re ready to
install the WorkBench software.

Be sure to check the CD for release notes that may affect the
installation and configuration process!

Check with your network or systems administrator if you’re not
sure about your current login account permissions.

WorkBench System Requirements

To install the WorkBench software, your computer must meet the following minimum requirements:

• 200 MHz Pentium-II

• 64 MB RAM

• 100 MB free disk space

• Windows NT 4.0, 2000, XP, or Vista

• Color monitor running at 256 colors or higher, 800 x 600 minimum screen resolution

• Windows-compatible mouse

• Standard 9-pin serial port and/or Ethernet adapter (860 DSP Ethernet interface is optional)

• Trilithic 9-pin to 1/8" stereo connector cable (included)

It is also strongly recommended that you have an Internet connection for using the WorkBench
software’s online feature, which lets you get the latest updates and newest features.

Installation Instructions

To install the WorkBench software, do the following:

1. Depending on the operating system you are installing the WorkBench software on, you may
need to log on as the local administrator.

2. Insert the WorkBench software CD in the appropriate drive.
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3. If you have Autorun enabled for the CD-ROM drive, the WorkBench software setup program
will start automatically. Otherwise, click Start, then click Run, and type [drive]:\setup.exe,
then click OK. (Substitute the appropriate drive path in the command.)

4. If a previous version of the WorkBench software is found the following screen will appear.
Select Yes to remove the previous version of the WorkBench software.

5. The “Preparing to install...” screen appears.

The setup program examines your system for the Microsoft
DAC and Microsoft .NET Framework components before
installation. If either of these components are missing from your
system, the installer will install them for you before continuing
with the WorkBench setup.
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6. After a moment, the “Welcome to the InstallShield Wizard for Trilithic WorkBench” screen
appears. Select the Next> button to continue.

7. The “Destination Folder” screen appears. Enter information on this screen as follows:

Folder: By default, the installation procedure installs WorkBench in the
C:\Program Files\Trilithic\WorkBench\ folder. You can select a different location by
selecting the Browse button.

Select the Next> button to continue.



WorkBench Software - Section I: The Basics
I-12

8. The “Installation Type” screen appears.

If you want to change the installation settings, select the <Back button; otherwise, select the
Install button.

Select the Full Access radio button if you want the users of this application to have access
to all features including both data and device management. This is the default option and is
recommended for most users.

Select the Limited Access radio button if you want the users of this application to have
access to only those features necessary to perform data management. All features that
assist in device configuration will be inaccessible.

9. When you are satisfied with your entries, click the Next> button. The “Ready to Install the
Application” screen appears.
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10.The WorkBench installation procedure installs the files and the Trilithic WorkBench icon on
your desktop. The “Installing Trilithic WorkBench” screen appears to display the status of
the installation.

11. When installation is complete, the “InstallShield Wizard Completed” screen appears.
Select the Finish button
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4. Registering WorkBench
Chapter 4

Overview

WorkBench is a fully-functional software package and all features of the program are accessible
once the program has been installed and registered.  WorkBench Lite includes the same features
as WorkBench, however the Datalog functions of the program will be automatically disabled 30
after WorkBench Lite is installed.  You can register the software online or by telephone.

Registering Online

To register WorkBench online, perform the following steps:

1. From the Help menu, select Register Online....
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2. The WorkBench Registration Form screen appears. Enter information in the fields as
follows:

First Name: Enter the
registrant’s first name. (Required
field.)

Last Name: Enter the
registrant’s last name. (Required
field.)

Postal / Zip Code: Enter the zip
or postal code. (Required field.)

Country: Select the country from
the drop-down list. (Required
field.)

Address: Enter the first line of
the company address. (Required
field.)

City: Enter the city. (Required
field.)

State / Province: Enter the state
or province. (Required field.)

Telephone: Enter the phone
number. (Required field.)

Email Address: Enter the registrant’s email address. (Required field.)

Company: Enter the company name. (Required field.)

Job Title: Enter the registrant’s title.

Product Key: Enter the product code that accompanied your software. (Required field.)
The product code is located on the back of the WorkBench software’s CD sleeve.

License Key: This display-only field contains the license key that uniquely identifies the
computer on which the software is installed.

Serial Number: Enter the serial number that accompanied your software. (Required field.)
The serial number is located on the back of the WorkBench software’s CD sleeve.
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3. When you are satisfied with your entries, select the Get Activation Code button.
WorkBench connects to a Trilithic server via the Internet and registers the software. The
Registration Confirmation screen shows that the registration was successful. Be sure to
copy the activation code for your records.

The WorkBench software is licensed on a per-machine basis.
Once the software has been registered, any attempt to register
the same product code on additional computers will be
unsuccessful. To move the WorkBench software to a different
computer, please contact Trilithic customer support for
assistance in transferring the license.
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3. The Trilithic Product Registration screen appears.
Enter information in the fields as follows:

Product Key: Enter the product code that
accompanied your software. (This is a required field.)

License Key: This display-only field contains the
license key that uniquely identifies the computer on
which the software is installed.

Registration Key: Enter the registration key you
received from Trilithic. (This is a required field.)

Registering By Phone

If you prefer, you can register WorkBench by phone. This is done by calling Trilithic and obtaining a
registration key for your software, then entering the information in the WorkBench software, as
follows:

1. Call Trilithic from 8:00am to 5:00pm (Eastern time) Monday through Friday at
1-800-344-2412 to request a registration key. Write this key down.

2. From the Help menu, select Register by Phone....
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4. When you are satisfied with your entries, select the Register button. The Trilithic Product
Registration screen appears, confirming the registration.

The WorkBench software is licensed on a per-machine basis.
Once the software has been registered, any attempt to register
the same product code on additional computers will be
unsuccessful. To move the WorkBench software to a different
computer, please contact Trilithic customer support for
assistance in transferring the license.
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5. Guided Tour of WorkBench
Chapter 5

1. Command Menu - This area is contains the commands to access files, change view
settings, connect and retrieve data from devices, arrange open windows, and access
support and help information.

2. Toolbar - This area is used as a shortcut to most commands that are accessible through
the Command Menu.

3. Navigator Window - This area is used to organize and access all of the data created and
managed by the WorkBench software.

1

2

3

4

5

Overview

Once you have installed the WorkBench software, you’re ready to learn your way around. Start
WorkBench by double-clicking the Trilithic WorkBench icon on your desktop.

WorkBench versus WorkBench Lite

WorkBench is a fully-functional software package and all features of the program are accessible
once the program has been installed and registered.  WorkBench Lite includes the same features
as WorkBench, however the Datalog functions of the program will be automatically disabled 30
after WorkBench Lite is installed.  The software online or by telephone, and the upgrade from
WorkBench Lite to WorkBench can be configured at that time.  Refer to Chapter 4: Registering
WorkBench for additional information.
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4. Data Window - This area is used to display channels plans, device data, graphs, and
Internet browser pages.

5. Event Log and Task Window - This area is used to display a log of events that take
place in WorkBench and tasks that need to be completed.

Command Menu

Main Menus

The Command Menu has six basic menus, as described in the following table.

Menu Commands 

File 

Setup new channel plans, locations, macros, task sheets  

(TDM Component Required), text files, configuration packages, 
and connections 

Import and export channel plans, locations, macros, tasks and 
task sheets (TDM Component Required), data logs, and 
screen captures 

Setup printer settings 

Setup general, database and device options 

Exit WorkBench 

View 
Show or hide the toolbar, status bar, navigator, log/tasks, and 
refresh the current view 

Device 

Start the Configuration Wizard, set individual configuration 
settings for each type of device, set the date/time of devices to 
match PC system time, re-boot devices, and apply firmware 
guides to devices 

Data 
Start the Data Collection Wizard for collecting data from 860 
DSPs and start the Data Query Wizard for searching and 
analyzing data collected from 860 DSPs 

Window 
Change the configuration of open windows in WorkBench and 
arrange the WorkBench icons 

Help 

Open help topics, submit online support requests, submit 
online problem reports and comments, check for software 
updates, register WorkBench online or by phone, register the 
TDM Component (TDM Component Required), and view the 
current software version of WorkBench 
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File Menu

Menu Commands 

New 
Setup new channel plans, locations, macros, task sheets, text 
files, configuration packages, and connections 

Close Close the current document 

Save Save the current modified document 

Import 
Import channel plans, locations, macros, task/task sheets, data 
logs, and screen captures 

Export 
Export channel plans, locations, macros, task/task sheets, data 
logs, and screen captures 

Print Prints the active document or screen 

Print Preview Lets the user preview the document that is about to be printed 

Print Setup Setup printer settings 

Options Setup general, database and device options 

Exit Exit WorkBench 
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View Menu

Menu Commands 

Toolbar Show or hide the toolbar 

Status Bar Show or hide the status bar 

Navigator Show or hide the navigator window 

Log Show or hide the event log and task window 

Refresh Refresh the current view 
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Device Menu

Data Menu

Menu Commands 

Data Collection 
Wizard 

Starts the Data Collection Wizard for collecting data from the 
860 DSP & 860 DSPi Field Analyzers 

Data Query Wizard 
Starts the Data Query Wizard for searching and analyzing data 
collected from 860 DSP & 860 DSPi Field Analyzers 

 

Menu Commands 

Configuration 
Wizard 

Starts the device configuration wizard 

860 DSP 

Configure the following settings for the 860 DSP & 860 DSPi 
Field Analyzers; General, Level, Scan, Depth of Modulation, 
CSO/CTB, Forward Sweep, QAM, Web Browser, Network 
Test, Return Test, VoIP, Telemetry Search Set, Navigation 
Menus, and Limits 

860 DSPh 
Configure the following settings for the 860 DSPh Headend 
Analyzer; General, Network, Measurement, SNMP, and Inputs 

860 DSPr 

Configure the following settings for the 860 DSPr Headend 
Analyzer; General, Level, Scan, Scan Limits, Depth of 
Modulation, CSO/CTB, Forward Sweep, QAM, Web Browser, 
Network, Network Test, Return, VoIP, Telemetry Search, FDR, 
and Navigation 

8300 FST 
Configure the following settings for the 8300 FST Forward 
SpeedSweep Transmitter; General and Network 

Set Date/Time Sets the date/time of devices to match PC system date/time 

Re-Boot Re-Boots devices after configuration 

Apply Firmware 
Upgrade 

Applies firmware upgrades to devices 
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Menu Commands 

Cascade Cascades the open windows in WorkBench 

Tile Tiles the open windows in WorkBench 

Arrange Icons Arranges the icons in WorkBench 

 

Window Menu

Help Menu

Menu Commands 

Help Topics Goes to the main help screen 

Submit Online 
Support Request 

Displays the WorkBench online technical support request web 
page 

Submit Online 
Problem Report or 
Comments 

Displays the WorkBench online customer response web page 

Check for Updates Displays the WorkBench software update web page 

Register Online Displays the WorkBench online software registration web page 

Register by Phone 
Displays the WorkBench window for entering a WorkBench 
Software Registration Key that is obtained over the phone 

Register TDM 
Component 

Displays the WorkBench window for entering a Trilithic Data 
Management Registration Key that is obtained over the phone 

About WorkBench 
Displays information about the version of the WorkBench 
software 
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Toolbar Icons

The WorkBench toolbar provides a quick way to access a number of convenient commands
and features.

Icon Description 

 

Start a new channel plan, location, macro, text file, configuration package, or 
connection (same as the File/New command) 

 
Save the current modified document (same as the File/Save command) 

 
Prints the active document or screen (same as the File/Print command) 

 
Show or hide the Navigator Window (same as the View/Navigator command) 

 

Show or hide the Event Log and Task Window (same as the View/Log 
command) 

 
Configure device parameters (context varies based on which type of device is 
selected) 

 
Launches the Trilithic Data Manager (TDM) Report Console. 

 
Collect data from the 860 DSP logs (same as the Data/Data Collection 
Wizard command) 

 
Query saved data logs (same as the Data/Data Query Wizard command) 

 
Group data by Company Name (same as the right-click menu on the Data 
Tab of the Navigator Window) 
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Icon Description 

 

Group data by Operator Name (same as the right-click menu on the Data Tab 
of the Navigator Window) 

 
Group data by Workgroup Name (same as the right-click menu on the Data 
Tab of the Navigator Window) 

 
Group data by Location Name (same as the right-click menu on the Data Tab 
of the Navigator Window) 

 

Group data by Task Information (same as the right-click menu on the Data 
Tab of the Navigator Window) 

 

Group data by Type (same as the right-click menu on the Data Tab of the 
Navigator Window) 

 
Resets all data grouping to default settings (turns off grouping) 

 
Do a primary sort of data by log name (same as the right-click menu on the 
Data Tab of the Navigator Window) 

 
Do a primary sort of data by log type (same as the right-click menu on the 
Data Tab of the Navigator Window) 

 
Sort by log name in ascending order (same as the right-click menu on the 
Data Tab of the Navigator Window) 

 
Sort by log name in descending order (same as the right-click menu on the 
Data Tab of the Navigator Window) 
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The toolbar icon and Help menu item for problem reports and
comments is intended to provide Trilithic with feedback relating
to the stability and function of the WorkBench software. Please
note that this form is not intended to provide technical
support—a reply will not be sent. For technical support, please
follow the steps outlined previously in this manual.

Icon Description 

 

Sort by log date in ascending order (same as the right-click menu on the Data 
Tab of the Navigator Window) 

 
Sort by log date in descending order (same as the right-click menu on the 
Data Tab of the Navigator Window) 

 
Displays the contact screen for problem reports (same as the Help/Submit 
Online Problem Report or Comments command) 
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Navigator Window

The Navigator window is used to organize and access all of the data created and managed by the
WorkBench software.

When WorkBench first starts, the Navigator window appears to the left of the WorkBench screen.

The Navigator Window has four tabs, as described in the following table.

Global Tab
When the WorkBench software opens, the Navigator Window

will default to the  tab as shown to the right.

Tab Description 

 
Displays channels plans, locations, macros, text files, configuration 
packages, and provides a quick link to the application options 

 Displays the various queries and data sets in the WorkBench software 

 Displays the devices that have been set up in the WorkBench software 

 
Links to the Trilithic web site for additional information, notes, bulletins, 
and firmware upgrades 
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From the  tab, the following options are available:

Option Description 

 

Double-clicking this option opens the Application Options 
Window to the General Tab (this is the same as selecting the 
File/Options command) 

Selecting the plus (+) sign next to Application Options will display 
the General, Databases, Devices, and TDM Options (TDM 
Component Required); double-clicking any of these options will 
open the Application Options Window to the selected option tab 
For more information on configuring TDM Options, see  
Section VI: Trilithic Data Manager (TDM) Component 

 

Double-clicking this option or selecting the plus (+) sign next to 
Local Files will display a list of all the text files in WorkBench 
Using this option is described in the Creating and Maintaining 
Text Files Section 

 

The Trilithic Data Manager (TDM) Component is required to use 
this option 
For more information on using this option, see Section VI: 
Trilithic Data Manager (TDM) Component 

 

The Trilithic Data Manager (TDM) Component is required to use 
this option 
For more information on using this option, see Section VI: 
Trilithic Data Manager (TDM) Component 

 

Double-clicking this option or selecting the plus (+) sign next to 
the 860 DSP will display a list of the Packages, Channel Plans, 
Auto-Test Macros, Locations, and Task Sheets (TDM 
Component Required) in WorkBench 
Using this option is described in the Creating and Maintaining a 
Configuration Package Section�For more information on using 
Task Sheets, see Section VI: Trilithic Data Manager (TDM) 
Component 
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Data Tab

The  tab is displayed as shown to the right.

From the  tab the following options are available:

Option Description 

 

Double-clicking this option or selecting the plus (+) sign 
next to  

860 DSP will display the Saved Queries and Query 
Results tree options 

 

Selecting the plus (+) sign next to Saved Queries will 
display all of the queries saved in WorkBench 

Double-clicking any of the saved queries will start the 
Data Query Wizard with the saved query parameters 
already selected 

 

Selecting the plus (+) sign next to Query Results # will 
start the Data Query Wizard if no query is defined 
(same as the Data/Data Query Wizard command) 

Double-clicking any of the query results or selecting the 
plus (+) sign next to Query Results # will display all of 
the data that was returned when the query was 
executed 

Double-clicking on any of the data that was returned 
when the query was executed will display the data in 
the Data Window 
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Devices Tab

The  tab is displayed as shown below.

From the  tab the following options are available:

Option Description 

 

Right-clicking this option will display a menu to create 
a new connection to a 860 DSP or to show offline 860 
DSPs 

Double-clicking this option or selecting the plus (+) 
sign next to 860 DSP will display a list of the 860 
DSPs that are connected to WorkBench; double-
clicking any of 860 DSPs from this list will display a 
list of the Channel Plans, Auto-Test Macros, 
Locations, and Text Files associated with that 860 
DSP 

 

Right-clicking this option will display a menu to create 
a new connection to a 860 DSPh or to show offline 
860 DSPhs 

Double-clicking this option or selecting the plus (+) 
sign next to 860 DSPh will display a list of the 860 
DSPhs that are connected to WorkBench; double-
clicking any of 860 DSPhs from this list will display a 
list of the Channel Plans and Auto-Test Macros 
associated with that 860 DSPh 
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Online Tab

The  tab will allow WorkBench to be connected to the
Internet, and once connected, provides up-to-date access to
information and tasks such as checking for software and
firmware updates, inquiring about the latest products and
options available for the 860 DSP, and requesting technical
assistance for your WorkBench software or 860 DSP units.

The information in the Online tab is updated periodically with
new options. Click on any of the links in the Online Tab to go to
the appropriate section of the 860 DSP Web site.

Option Description 

 

Right-clicking this option will display a menu to 
create a new connection to an 860 DSPr or to 
show offline 860 DSPr’s 

Double-clicking this option or selecting the plus (+) 
sign next to the 860 DSPr will display a list of the 
860 DSPr’s that are connected to WorkBench; 
double-clicking any of the 860 DSPr’s from this list 
will display a list of the Channel Plans associated 
with that 860 DSPr 

 

Right-clicking this option will display a menu to 
create a new connection to an 8300 FST or to 
show offline 8300 FSTs 

Double-clicking this option or selecting the plus (+) 
sign next to 8300 FST will display a list of the 8300 
FSTs that are connected to WorkBench; double-
clicking any of 8300 FSTs from this list will display 
a list of the Channel Plans associated with that 
8300 FST 
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General and Database Settings

To configure the general settings of the WorkBench software, perform the following steps;

1. The first time that the WorkBench software is started, the general settings need to be
configured. From the File menu, select Options, the Application Options Window
appears with the  tab displayed.

2. Enter general settings in the following fields:

Company Name: Enter the company name.

Address 1: Enter the first line of the
company address.

Address 2: Enter the second line of the
company address.

City: Enter the city.

State/Province: Enter the state or province.

Zip/Postal Code: Enter the zip or postal
code.

Country: Enter the country.

6. Configuring WorkBench
Chapter 6

The company name and address information are displayed on
the header of printed reports.

Asset ID: Enter the asset ID or security message you wish to be displayed on the 860
DSP splash screen during start up.

Asset ID Password: Enter a password to prevent unauthorized changes to the asset ID or
security message that is displayed on the 860 DSP screen.

Old Asset ID Password: When you wish to change your  Asset ID Password, enter the
new password in the Asset ID Password field and then enter the old password in this field
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Distance Units: Select the distance unit from the drop-down list. The options available to
select from are feet (ft) and meters (m).

Auto-Hide Navigator: Select this check box to hide the Navigator Window automatically
when you view data in the Data Window. When the Data Window is closed, the Navigator
Window is automatically displayed again.

Enable Online Web Content: Select this check box to enable the Online Tab in the
Navigator Window to display the information from the WorkBench Online Web site.

Enable Start-Up Animation: Select this check box to enable the start-up splash screen
animation.

Enable Start-Up Sound: Select this check box to enable the start-up sounds.

Enable TDM Component: Select this check box to enable the TDM Component (TDM
Component Required). For more information about the Trilithic Data Manager Component,
see Section VI: Trilithic Data Manager (TDM) Component.

3. When done configuring the general settings, select the Database Tab.

4. The  tab appears, enter database
settings in the following fields:

Type: Select the type of database. The default
database is set to the Microsoft Jet 4.0 database
engine (this database engine is used by Access
2000 and Access XP). The Microsoft Jet 3.5
database engine (used by Access 97), or
Microsoft SQL Server can also be selected.

The measurement unit selected in this field is used for
measurements throughout the WorkBench software. This
affects the various data wizards and the data logs.

Measurement Units: Select the measurement unit from the drop-down list. The options
available to select from are dBmV, dBuV, or dBm.
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Give consideration to where the data from TDM is stored. To
prevent the loss of data, consider storing this data on a
centralized server that is backed up regularly.

To facilitate the sorting and retrieval of saved data, consider
creating a separate database that contains only data from a
specific group of technicians or from a particular job function as
opposed to a single database for all records.

If using WorkBench with the TDM Component, the SQL Server
must be selected. The SQL Server will need to be purchased
separately and installed on the TDM server. Otherwise, simply
accept the defaults by selecting the OK button. The Jet 4.0 and
Jet 3.5 database engines are included with the WorkBench
software and need no additional configuration.

Use the Microsoft Windows Data Link Properties wizard to
make and verify a database connection by selecting the New
Connection... button.

If the selected database does not already exist, it will be created
and initialized after selecting the OK/Apply button.

The database holds the data gathered from the 860 DSPs,
configuration package information, and other data. The
WorkBench software sets up a default Jet 4.0 database when
installing the software. This database will be acceptable for
most installations without and further configurations.
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Server: This option is used only if the Microsoft SQL Server option is selected in the Type
field. Enter the name of the server on which the SQL Server database resides. The default
for this field is (local) for the computer on which the WorkBench software is installed.

Authentication: This option is used only if the Microsoft SQL Server option is selected in
the Type field. Select Windows NT/2000/XP Authentication to use the operating system’s
built-in user accounts, or Database Authentication to use SQL Server user authentication
when signing in to the server.

Username: This option is used only if the Microsoft SQL Server option is selected in the
Type field and Database Authentication is selected as the login method. Enter the
username for the server.

Password: This option is used only if the Microsoft SQL Server option is selected in the
Type field and Database Authentication is selected as the login method. Enter the
password for the server.

Set Current: Set the currently selected connection in the Previous Database Connections
list as the current database.

Remove: Remove the currently selected connection from the list. The will not delete the
database from disk.

New Connection...: Make and/or verify a database connection.

5. When done configuring the database settings, select the OK button.  WorkBench is now
configured.
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Overview

You may need to interact with Trilithic to do any of the following:

• Provide general feedback

• Submit a report on a problem

• Request a new feature or a change to an existing feature

• Get product support

You can submit feedback directly to Trilithic:

Trilithic, Inc.
9710 Park Davis Drive
Indianapolis, IN 46235 USA
(317) 895-3600 or (800) 344-2412
(317) 895-3613 (fax)
support@trilithic.com

You can also submit feedback or requests for product support through WorkBench.

Online Customer Feedback

To submit online feedback, do the following:

1. From the Help menu, select Submit Online
Problem Report or Comments.

7. Online Services
Chapter 7

The online customer feedback can also be displayed by
selecting the Trilithic logo  on the WorkBench toolbar.
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2. The Customer Feedback web page appears. Select the product to submit feedback on
WorkBench or 860 DSP and enter feedback information in the following fields:

OS: Enter the operating system that
WorkBench is running on.

Software Version: Enter the WorkBench
software version.

Product Key: Enter the product key that came
with this version of WorkBench. Enter
“unregistered” if no product key is available.
(Required field.)

First Name: Enter the user’s first name.
(Required field.)

Last Name: Enter the user’s last name.
(Required field.)

Postal / Zip Code: Enter the zip or postal
code. (Required field.)

Country: Select the country from the drop-
down list. (Required field.)

Address: Enter the company address.
(Required field.)

City: Enter the city. (Required field.)

State / Province: Select the state or province
from the drop-down list. (Required field.)

Telephone: Enter the phone number.
(Required field.)

Email Address: Enter your email address.
(Required field.)

Company: Enter your company name. (Required field.)

Job Title: Enter the user’s job title.

Comments: Enter your description of the problem or the change request.
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When submitting feedback, a reply will not be sent. Information
collected from WorkBench users is used by Trilithic to provide
continuous improvement to its products and services.

3. When done entering the feedback information, select the Submit button.  The user
information and comments are sent to Trilithic where they will be reviewed.

2. The Trilithic Online Support Forum
redirect web page opens in WorkBench.
The Trilithic Online Support Forum web
page will open in a separate Internet
browser window. If the separate web
page does not open, select the hyperlink
from the redirect web page in
WorkBench.

3. Select the WorkBench Technical Support Forum and review the existing posts for an
answer the WorkBench problem or create a new post that will be reviewed and answered
by a Trilithic moderator.

Online Support Request

To submit a support request, do the following:

1. From the Help menu, select Submit Online
Support Request.
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Device Firmware Upgrades

Trilithic periodically issues updates to 860 DSP, 860 DSPh, and 8300 FST firmware. These
updates are posted on the Firmware update page for downloading to the user’s computer.

To update the firmware:

1. From the Help menu, select Check for Updates.

2. The  appears WorkBench software
update web page opens. Follow the
instructions on the web page to update
the WorkBench software or perform a
firmware upgrade of the 860 DSP, 860
DSPh, and 8300 FST.

3. If you have not already done so, connect the 860 DSP(s) you want to update.

4. If more than one 860 DSP is connected, select one or more devices from the list shown on
the Devices tab.

5. From the 860 DSP menu, select Apply 860 DSP Upgrade. The standard File Open dialog
box appears.

6. Select the firmware patch you want to apply and click Open. (You can only apply a single
patch at a time, so if you have several patches to apply, you’ll need to apply them
individually.)

7. The WorkBench software downloads the firmware patch to the 860 DSP(s) you have
connected to the computer.

8. When the update process is complete, the 860 DSP(s) will reboot to apply the changes.
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Section II: Managing Devices and Data

WorkBench Software
(and WorkBench Lite Software)

for the 860 DSP, 860 DSPi, 860 DSPh, 860 DSPr, and 8300 FST
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1. Introduction
Chapter 1

Overview

Once the WorkBench program has been installed, you can begin managing devices.  The
WorkBench application is capable of managing all configuration parameters for the following
devices:

• 860 DSP

• 860 DSPi

• 860 DSPh

• 860 DSPr

• 8300 FST

In addition to configuration management, WorkBench allows complete management of data files
for a variety of tests and measurements.
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Devices Tab

File Menu Toolbar

Overview

Now that the installation and configuration of WorkBench is complete, the next step is to connect
WorkBench with the 860 DSP, 860 DSPi, 860 DSPh, 860 DSPr, or 8300 FST.  You can add new
devices to WorkBench or maintain connections with devices that are already known or polled by
WorkBench. In this section we discuss how to add new devices, disconnect devices, and manage
device connections.

Connecting To Devices

To add a new device to WorkBench perform the following steps:

1. Perform one of the following steps to create a new connection:

From the File menu hover over New, and then select Connection.

OR

From the Toolbar click on the  icon and then select Connection.

OR

From the  tab, right-click on the type of device you wish to add, and then
select New 860 DSP connection, New 860 DSPh Connection, New 860 DSPr
Connection, or New 8300 FST Connection.

2. Managing Devices
Chapter 2
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2. The Connect To a Device window will appear. From this window you will choose how to
connect to a device. Perform one of the following steps based on your device connection
type:

Connect to a device on a local serial port - Select this option if you wish to connect
to a device via a serial port. From the Serial Port drop-down list select the serial port to
which your device is connected, see the figure below.

OR

Connect to a device on the network - Select this option if you want to establish a
network connection to the device. Enter the IP address and specific communications
port of the device (i.e. 192.168.1.1:24010) in the Network Address field, see the
figure below.

OR

Connect to a detected device - Select this option if you want to connect to a detected
device on the network, see the figure below.

Select the  button to rediscover any devices connected
to the network.

Serial Port Network
Device

Detected Device
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3. When you have completed entering the connection information, select the  button.
The WorkBench software will poll the serial port or IP address to connect with your device.

The Status field is a read-only area of the window that displays
the status of the device connection when trying to connect to a
device.

4. When WorkBench makes a connection with your device, the software will display the
Device Properties window specific to the connected device as shown below.

860 DSP or 860 DSPi

8300 FST

860 DSPh

860 DSPr

The Operator Name pull down list is not functional in the 860
DSPh or 8300 FST Device Properties windows.
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6. When you have completed entering the information in the

Device Properties window, select the  button.
The new device will now appear in the list of devices in the

 tab of the Navigator Window as shown to the
right.

7. You can repeat this process as necessary to add more
devices to WorkBench.

5. Enter the following information into the corresponding fields in the Device Properties
window:

Operator Name - Enter the name of the device or the operator name.  For the 860
DSP, 860 DSPi, and 860 DSPr, the Operator Name field is a pull-down list that allows
as many as three operator names to be entered and edited.

Company Name - Enter the company name or location of the device.

Description - Enter any description desired to help remember important aspects of
this device.

Remember this device for future sessions - Select this check-box (selected by default if
auto-connecting) if you would like WorkBench to remember this device in the future.

The Details and Connections fields are a read-only area of the
window that are provided for information purposes only.

You can show all of the devices that WorkBench knows about,
whether they are connected to WorkBench or not, by right-
clicking any type of device from the Navigator Window and
selecting Show Offline Devices from the right-click menu.
Devices that are not connected will appear with their icons and
names grayed out.
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Disconnecting Devices

To disconnect a device from WorkBench, from the  tab of the Navigator window right-
click the device that you want to disconnect and select Disconnect from the right-click menu. To
reconnect any device, follow the steps that are outlined in the Connecting to Devices section.

8300 FST

860 DSPh860 DSP or 860 DSPi

860 DSPr
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Maintaining Device Connections

You can modify which devices WorkBench remembers and auto-connects to when detected, as
well as, maintain which serial ports and IP addresses are polled for the 860 DSP, 860 DSPi,
860 DSPh, and 8300 FST from the WorkBench software as follows:

1. Perform one of the following steps to create a new connection:

From the File menu select Options, see the figure below.

OR

From the  tab, double-click on Application Options, see the figure below.

2. From the Application Options window, select the  tab.

File Menu Global Tab



WorkBench Software - Section II: Managing Devices and Data
II-11

3. Enter the following information into the corresponding fields in the  tab of the
Application Options window:

Remember newly detected devices for future sessions: Select this check-box if
you want WorkBench to remember connected devices.

Known Devices: Select a device from the devices shown in this field.

• You can display the Device Properties window (and change names and

descriptions) by selecting the  button.

• You can delete the device from the WorkBench software entirely by selecting the

 button.

• You can elect to auto-connect to a device when detected by selecting the
AutoConnect field.

Polled Serial Ports: This field contains the serial ports that the WorkBench software
polls.

• You can remove a serial port by clicking on the port and selecting the 
button.

• You can add a serial port to this list by clicking on an available serial port in the

Available Serial Ports field and selecting the  button.

Polled Network Addresses: This field contains the IP addresses that the WorkBench
software checks for a device.

• You can remove an IP address by clicking on the address and selecting the

 button.

• You can add an IP address by entering the IP address in the Network Address:

field and selecting the  button.

4. When you are satisfied with your entries, select the  button to exit and save or

select the  button to exit without saving.
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Overview

In addition to performing a variety of tests and functions, the 860 DSP, DSPi, and DSPr can save
data to be transferred to WorkBench for analysis and reporting. This chapter shows you how to
transfer data logs from a connected 860 DSP, DSPi, or DSPr to WorkBench. You’ll also see how
to create custom queries as well as how to import and export data using WorkBench.

Data 
Icon 

Data Type File 
Extension 

Report Types 

 Bit Error Ratio ber Text and Graphics 

 CM Stats stat Text Only 

 
Carrier Second Order / Triple Beat 
CSO/CTB 

cso Text and Graphics 

 Carrier-To-Noise c2n Text Only 

 Depth of Modulation dom Text Only 

 FDR fdr Graphics Only 

 FM Deviation fm Text Only 

 Forward Sweep fswp Graphics Only 

 Hum hum Text Only 
 

3. Managing Data
Chapter 3

If you are running WorkBench Lite, the data logging features of
the program will be disabled after 30 days.  To continue using
the data features, register the WorkBench software.

Data Log Types

Data logs are viewed through the Devices tab of the Navigator window or using a custom query
in the Data tab of the Navigator window.

Depending on their features and options, the 860 DSP, DSPi, or DSPr can upload many different
types of data logs as shown below.
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Data 
Icon 

Data Type 
File 

Extension 
Report Types 

 LCD Screen Capture lcd, bmpz Graphics Only 

 Leakage leak Text Only 

 Level lev Text Only 

 Ping ping Text Only 

 QAM qam Text and Graphics 

 QAM EVS qevs Graphics Only 

 QAM Lite qaml Text Only 

 Return Sweep Analysis rsa Text and Graphics 

 Reverse Sweep rswp Text and Graphics 

 Reverse Test rtst Text and Graphics 

 Scan scan Text and Graphics 

 Spectrum Analyzer spec Graphics Only 

 Throughput thru Text Only 

 Tilt tilt Text and Graphics 

 Trace Route rout Text Only 

 Traffic Control traf Text and Graphics 

 VITS vits Graphics Only 

 VoIP vrtp Text Only 

 Web Log wlog Text Only 

 Wi-Fi wifi Text Only 
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Although it will normally be desirable to store all of your data
logs in the WorkBench database (using the Data Collection
Wizard), you can also open data logs directly from an 860 DSP
by locating the desired data log on the Devices tab, right-clicking
on the file, and selecting Open from the pop-up window. This
method is convenient if you need to generate a report quickly.

Using the Data Collection Wizard

To transfer data from an 860 DSP or 860 DSPi to the WorkBench software, perform the following
steps:

1. Connect the 860 DSP or 860 DSPi to the WorkBench computer using the steps outlined in
Chapter 2: Managing Devices, Connecting to Devices.

2. Select the  icon or from the Data menu, select
Data Collection Wizard.

3. The Welcome to the Trilithic 860 DSP Data
Collection Wizard screen appears. Select the

 button.
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5. The Remove 860 DSP Files screen appears. You must choose from one of the two

options described below before selecting the  button:

Yes, remove data logs from 860 DSP devices (Recommended) - Select this option
(the default) to read data from the device, save the information to the database, and
then delete the logs on the device. This frees up storage space on the device.

No, do not delete files - Read the data from the device but do not delete the data
logs.

4. If more than one 860 DSP(s) is connected, the Select 860 DSP Devices screen appears.
You must choose from one of the two options described below before selecting the

 button:

Collect files from all 860 DSP devices - Select this option (the default) to read data
from all connected devices

Collect files from selected 860 DSP devices - Select this option to read the data
from only the devices that you choose.
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7. If you have multiple devices connected, the Select Additional Devices screen appears
prompting you to select one or more devices from which data will be uploaded. You must

choose from one of the following two options before selecting the  button.

No, I’m ready to complete the wizard Select this option if you have collected data
from all the devices and are ready to complete the wizard.

Yes, continue collecting data from additional 860 DSP devices Select this option
if you wish to collect data from another device.

6. When you are satisfied with your entries, select the  button. The Collect and
Save Data screen appears to indicated the progress of the data collection as the wizard
reads the data and saves it to the database.
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8. When you are satisfied with your entries, select the  button.

• If you selected Yes in the Select Additional Devices screen, the wizard lets you
select other devices and then collects the data from each of them. At the end of the
data collection process, the wizard then displays the Select Additional Devices
screen again.

• When you select No in this screen and select the  button, the Trilithic 860
DSP Data Collection Wizard Complete screen appears and displays a list of the

data files collected. Select the  button to close the Data Collection Wizard.
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Using the Data Query Wizard

To perform a query into the data collected by the Data Collection Wizard, perform the following
steps:

1. Connect the 860 DSP or 860 DSPi to the WorkBench computer using the steps outlined in
Chapter 2: Managing Devices, Connecting to Devices.

2. Perform one of the following steps to create a new data query:

From the Data menu, select Data Query Wizard, see the
figure to the right.  Proceed to step 3.

OR

From the  tab, double-click Query Results #
or select the plus (+) sign next to Query Results #,
see the figure to the right.  Skip to step 4.
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3. If you select Data Query Wizard from the Data
menu, the Welcome to the Trilithic 860 DSP Data
Query Wizard screen appears. Select the

 button.

4. The Select Query Parameters screen appears. You must select the Query Mode and then

enter the criteria used to perform the query before selecting the  button. To reset
the query criteria to the default values, select the  button.

Query Options

Query Mode - Select either “All selected
parameters must be matched” or “One or more
selected parameters must be matched” from the
drop-down list.

Display Results - Select the name to display
the Query Results as (This option is only
selectable if the mode was entered via the Data
Query Wizard).
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Query By Date

Date - Select either “--Any--” or “Between and
Including...”, “On or After...”, “On or Before...”, or
“Within Last” from the drop-down list.

Start Date - To enter the start date, select the
Month, Day, or Year and use the up and down
arrow keys to adjust the values or select the
down arrow at the right hand side of the field to
select the date from a calendar. This field is only
available when the Date field is set to “Between
and Including...” or “On or After...”.

End Date - To enter the end date, select the
Month, Day, or Year and use the up and down arrow keys to adjust the values or select
the down arrow at the right hand side of the field to select the date from a calendar. This
field is only available when the Date field is set to “On or Before...”.

Number of Days - To enter the number of days, select the field and enter the number of
days using your keyboard. This field is only available when the Date field is set to
“Within Last”.

Query By Data Type

Data Type - To search by any of the data logs
described earlier in this chapter, select the
data log name from the drop-down list.
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Query By Pass/Fail

Pass/Fail - Select “--Any--”, “Passed Limits”, or
“Failed Limits” from the drop-down list.

Query By Location

Location Type - Select “--Any--”, “Headend”,
“Trunk Amp”, “Line Extender”, “Fiber Node”, or
“Field Test” from the drop-down list.
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Query By Keyword

You may choose from one to three distinct
keywords or phrases to search. Perform the
following steps for which keyword search you wish
to perform;

Keyword - Select “--Any--”, “Exactly Matches...”,
“Begins With...”, “Ends With...”, or “Contains...”
from the drop-down list.

Keyword Search - Enter the keyword to
search.

Limit Keyword To - Select “--Any--”, “Log
Name”, “Operator Name”, “Company Name”,
“Description”,  “Location Area”, “Location
AmpID”, “Any Task Attribute”,  “Task Attribute #”,
or “Task ID” from the drop down list.

5. Once you have selected all of the criteria for your

data query, select the  button to perform
the query. The Trilithic 860 DSP Data Query
Wizard Complete screen will appear, select the

 button to exit the Query Wizard.
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Viewing Data Query Results

To view the data logs that match your query criteria perform the following steps.

1. From the Data tab of the Navigator window,
perform one of the following actions;

• Select the plus (+) sign next to the
Query Results #.

• Double-click Query Results #.

2. The data logs included in the query results will
be displayed. Select the data log that you
would like to display by clicking on the name of
the data log.

3. To open the selected data log, perform one of
the following actions;

• Double-click the data log name.

• Right-click the data log name and
select Open from the pop-up menu.

4. The selected data log will open in the Data
window.

Your view may differ depending on how you have chosen to
group your data logs. You may need to open additional group
folders to access the data log that you desire.

For more information on how to analyze specific data logs, see
Chapter 4: Analyzing Data.
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Grouping Data Query Results

To allow you to more easily find the data you’re looking for, you may chose to group your data
logs. To group you data logs, perform one of the following actions;

Select Query Results # and choose the
corresponding grouping toolbar icon as
described below.

OR

Right-click on Query Results # and hover over
View and then select the grouping that you
desire.

The following types of data log grouping are
available and can be set using either method
described above:

  Group By Company

  Group By Operator

  Group By Workgroup

  Group By Location

  Group By Task Attribute or Task ID

  Group By Data Type

You may select more than one type of grouping at a time by
repeating the procedure above for each of the types of data
grouping that you desire.

To reset your grouping to the default settings (all grouping off),

select the Reset All Grouping  button or select Reset
Grouping from the right-click menu.
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Sorting Data Query Results

To allow you to more easily find the data you’re looking for, you may chose to sort your data
logs by ascending / descending name and date. To sort you data logs, perform one of the
following actions;

Select Query Results # and choose the
corresponding sorting toolbar icon as
described below.

OR

Right-click on Query Results # and hover
over View and then select the sorting that you
desire.

To sort names or dates by either ascending or
descending order, select the corresponding
toolbar icon or select the sorting you desire from
the right-click menu.

  Primary Sort by Name

  Secondary Sort  Ascending

  Secondary Sort  Descending

  Primary Sort by Date

  Secondary Sort Ascending

  Secondary Sort  Descending

You cannot sort by name and date at the same time. Only one
can be chosen at a time. The corresponding ascending/
descending setting will then be used to determine the final sort
order.
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Saving Data Logs to a Local File

You can save data logs to your local drive to allow you to move data from one WorkBench
software installation to other WorkBench software installations within your company.

Perform the following steps to save a local copy of any of the data logs described earlier in this
chapter:

1. Perform one of the following steps to select the data log(s) to save:

After connecting to a device or using the Data Collection Wizard, from the 
tab, right-click on the desired data log(s) to save, and then select Save Local File As.

OR

After using the Data Query Wizard, from the  tab, right click on the desired data
log(s) to save, and then select Export to Local Disk.

Devices Tab Data Tab

To select more than one data log at once for batch processing,
select the first data log that you would like to save, and then
hold the CTRL key on your keyboard while using your mouse
to select the other data logs.
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2. Perform one of the following steps to save the local
data log file(s):

If you selected only one file to save, The Save
window will appear. From this window you will
choose the location and name of the data log to

save and then select the  button.

OR

If you selected more than one file to save, The
Browse For Folder window will appear. From
this window you will choose the location to save

the data logs to and then select the 
button.
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Importing Data Logs from a Local File

You can import data logs to allow you to move data from one WorkBench software installation to
other WorkBench software installations within your company.

Perform the following steps to import any of the data logs described earlier in this chapter;

1. From the File menu hover over Import, and then select Data Logs.

2. The Open window will appear. From this window you
will choose which data log(s) to import and then

select the  button.



WorkBench Software - Section II: Managing Devices and Data
II-30

Opening and Closing Data Logs

Once you have collected the data from your 860 DSP, DSPi, or DSPr, you can use WorkBench to
view the data. To open any data log, perform one of the following actions:

After saving a data log to a local file, from the  tab, right-click on the desired data
log(s) to open, and then select Open.

OR

After using the Data Collection Wizard, from the  tab, right-click on the desired data
log(s) to open, and then select Open.

OR

After using the Data Query Wizard, from the  tab, right click on the desired data log(s)
to open, and then select Open.

Global Tab Devices Tab Data Tab

To close any data log, perform one of the following actions:

From the File menu, select Close.

OR

Select  the gray “X” in the upper right corner of the Data window.
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Saving Screen Captures to a Local File

You can save screen captures to your local drive to allow you to move screen captures from one
WorkBench software installation to other WorkBench software installations within your company.

1. Perform the following steps to save a local copy of a screen capture:

After opening a screen capture using the steps described in the previous section, from
the File menu select Export to Bitmap.

OR

After using the Data Collection Wizard, from the  tab, right-click on the
desired screen capture(s) to save, and then select Export to Bitmap.

OR

After using the Data Query Wizard, from the  tab, right click on the desired
screen capture(s) to save, and then select Export to Bitmap.

Devices Tab Data TabFile Menu

To select more than one screen capture at once for batch
processing, select the first screen capture that you would like to
save, and then hold the CTRL key on your keyboard while
using your mouse to select the other screen captures.
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2. Perform one of the following steps to save the local
screen capture file(s):

If you selected only one file to save, The Save
window will appear. From this window you will
choose the location and name of the data log to

save and then select the  button.

OR

If you selected more than one file to save, The
Browse For Folder window will appear. From
this window you will choose the location to save
the screen captures to and then select the

 button.
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Importing Screen Captures from a Local File

You can import screen captures to allow you to move screen captures from one WorkBench
software installation to other WorkBench software installations within your company.

Perform the following steps to import a screen capture:

1. From the File menu hover over Import, and then select Screen Captures.

2. The Open window will appear. From this window you
will choose which screen capture(s) to import and

then select the  button.
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Exporting Proof-Of-Performance (POP) Data Files

POP is a Proof of Performance software utility from FamilyWare, Inc. used by many cable
companies for reporting FCC proof test results.  WorkBench is capable of exporting several of the
860 DSP data log types to the TSD file format used by the POP software.  The table below shows
the POP data types supported by WorkBench, and the corresponding 860 DSP data log types.

Data 
Icon 

860 Data Type POP Data Type 

 Scan 

 Tilt 

 Level 

VSL (Visual Signal Level) 

 
Carrier Second Order / Triple Beat 
CSO/CTB 

CCD (Carrier to Coherent 
Disturbances) 

 Carrier-To-Noise C/N (Carrier to Noise) 

 Hum Text only 
 

The POP software requires that a VSL measurement be
previously imported corresponding to the channel of every C/N,
HUM, or CCD measurement.  If you are using WorkBench to
create a TSD file that includes these measurements, you must
export the corresponding VSL data from a Scan, Tilt, or Level
data log prior to appending the C/N, HUM, or CCD data.

Perform the following steps to export a data log to a POP (TSD) file:

1. Follow the procedure described in Opening and Closing Data logs earlier in this section to
open any of the data log types listed above.
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2. From the File menu, hover over Export, and then
select POP Data File.

3. The Save As window will appear. From this window
you will choose the location and name of the POP

data file to save and then select the  button.

4. The Export POP Data File window will appear as shown below.

5. To change the file name or location in which to save the file, simply enter the path and file
name in the area provided or select the button to the right to make the Save As window
reappear.



WorkBench Software - Section II: Managing Devices and Data
II-36

6. Enter the POP Import ID code that identifies the test point location from which the data
was taken. This is a four digit alphanumeric identifier, and is required by the POP software.

7. If exporting VSL data from a Scan, Tilt or Level data log, you must enter a Sample
Number identifying which of the four measurement samples of a 24 hour test this data
represents.

8. If you have selected an existing file for export, the Append Data If File Exists check-box is
used to specify whether WorkBench will append the new data to the existing data, or
overwrite the existing file.

If this check-box is not enabled, any existing data in the
selected file will be overwritten and lost.

9. Once you have finished making changes, select the  button to export the file.

For more information on importing TSD files into the POP
software, refer to your POP software documentation.
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Printing Without Preview
To print any data log that is open without a
preview, perform the following steps:

1. Press the Ctrl+P keys on your keyboard
or from the File menu, select Print.

2. The Print window will appear.

3. If you wish to change any printer settings
do so at this point.

4. Once you are satisfied with you printer

settings, select the  button to

print the document or select the 
button to exit without printing.

Printing Reports

Before printing you may want to setup your printer by first
selecting Printer Setup... from the File Menu. WorkBench will
use the settings of your default Windows printer if you choose
to skip this step.
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Printing With Preview

To print any data log that is open with a preview,
perform the following steps:

1. From the File menu, select Print
Preview.

2. A new print preview window will appear in
the Data window. You can then use the
buttons at the top of the print preview
screen as follows:

 - Use this button to print the
document.

 or  - Use these
buttons to scroll through multiple page
data logs.

 or  - Use these
buttons to change the view from one
page to two pages.

 or  - Use these
buttons to zoom in and out on the
document.

 - Use this button to close
without printing.

3. After you have selected the 
button, the Print window will appear.

4. If you wish to change any printer settings
do so at this point.

5. Once you are satisfied with you printer

settings, select the  button to

print the document or select the 
button to exit without printing.
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Data Log Properties

After a data log has been opened, the Data Log Properties of

the test set can be displayed by selecting the  button from
the toolbar at the top of the Data window. An example of the
BER Data log Properties is shown to the right.

The fields displayed in the Data Log Properties window are
as follows:

Name: Displays the file name of the data log.

Description: Displays the file name, device name, and IP
address of the device in which the data log was retrieved
from.

Data Type: Displays the test type, in this case BER.

Data Version: Displays the WorkBench data type and
WorkBench uses this value to determine how to display
the test data. This value is not user configurable and may
change as individual tests are modified to include new data that has not been shown
previously.

Log Date: Displays the date that the test was performed.

Calibration Date: Displays the date that the device was last calibrated.

Unit ID: Displays the CPE MAC address of the test device.

Operator and Company: This is the name of the operator who conducted the test and the
company in which the test was performed for. This is a user configurable field that can be
setup as shown in Section III:  Managing Configurations, Chapter 7: 860 DSP and 860
DSPi Configuration Packages.

Temperature: Displays the internal temperature of the device when the test was performed.

Location Type, Location Area, and Location Amp ID: Displays the location that the test
was conducted. These fields are user configurable and can be setup as shown in Section III:
Managing Configurations, Chapter 3: Locations.

Result: This displays the Pass Fail results for tests that were conducted as part of an Autotest
Macro. This field will display N/A if the test was conducted outside of an Autotest Macro.

4. Analyzing Data
Chapter 4
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Switching Between Text and Graphic Views

WorkBench can display reports in both a text view and a graphics view for the following data logs:

To switch your view between the text and graphics views, perform the following actions:

• To display the text view of the report, select the  button from the toolbar at the top of the
Data window or press the T key on your keyboard.

• To display the graphic view of the report, select the  button from the toolbar at the top of
the Data window or press the G key on your keyboard.

Data 
Icon 

Data Type 

 Bit Error Ratio 

 Carrier Second Order / Triple Beat CSO/CTB 

 Return Sweep 

 Reverse Sweep 

 Reverse Test 

 Scan 

 Tilt 

 Traffic Control 
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Using the Zoom Tools

You can zoom to view graphic report information in a variety of ways using the toolbar buttons or
the appropriate shortcut keys. Zoom and position values appear on the report’s summary pane.

Available Zoom Tools For Each Type of Report
The specific toolbar buttons for the zoom options vary slightly from report to report as follows:

Data 
Icon 

Data Type Available Zoom Tools 

 Forward Sweep             

 QAM        

 QAM EVS             

 Return Sweep             

 Reverse Sweep             

 Reverse Test             

 Scan                

 Spectrum Analyzer             

 Tilt             

 Traffic Control            
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Zoom Toolbar Buttons and Shortcut Keys

The following table provides a description of the each of the zoom tool buttons and their
corresponding keyboard shortcut keys.

Button Keyboard Shortcut Description 

 F Zoom Out Full – Best Fit Vertical and Horizontal 

 X Zoom Out Full Span – Best Fit Horizontal 

 M Zoom to Markers – Horizontal Zoom to Current Marker 
Locations 

 1 
Single Channel Zoom to Marker 1 – Horizontal Zoom 
to show One Channel 

 5 
Five Channel Zoom – Horizontal Zoom to show Five 
Channels (Marker 1 at Center) 

 9 Nine Channel Zoom – Horizontal Zoom to show Nine 
Channels (Marker 1 at Center) 

 Y Zoom Full Scale – Best Fit Vertical 

 Shift + [Up] Zoom In Span – One Channel to the Right, One 
Channel to the Left 

 Shift + [Down] 
Zoom Out Span – One Channel to the Right, One 
Channel to the Left 

--- Ctrl + Shift + [Left] Previous Start Channel - Zoom Left Side Out 

--- Ctrl + Shift + [Right] Next Start Channel – Zoom Left Side In 

--- Alt + Shift + [Left] Previous Start Channel - Zoom Right Side Out 

--- Alt + Shift + [Right] Next Start Channel – Zoom Right Side In 

 Ctrl + Alt + [Left] 
Frame Left – Move Frame 1 Channel Left (Number of 
Visible Channels Does Not Change) 

 Ctrl + Alt + [Right] 
Frame Right – Move Frame 1 Channel Right (Number 
of Visible Channels Does Not Change) 
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Button Keyboard Shortcut Description 

 [Up] Frame Up – Move Reference Level Up 1 dB 

 [Down] Frame Down – Move Reference Level Down 1 dB 

 Ctrl + [Up] 
Zoom Out Scale – Increase Vertical Scale (Available 
Values are 1, 2, 5, and 10 dB per Division) 

 Ctrl + [Down] 
Zoom In Scale – Decrease Vertical Scale (Available 
Values are 1, 2, 5, and 10 dB per Division) 

 

Viewing Coordinate Values

When you move the mouse cursor over the graphical display, a crosshair will appear. This will
display the coordinate values of the crosshair location at the top of the graph.

Selecting Channels

For Scan, Forward Sweep, and Tilt data logs, you may select any channel within the
measurement range as follows:

• From the channel plan that is displayed in the bottom portion of the Data window, you may
select the desired channel within the selected data log.

• Use your mouse to select the markers located at the bottom of the graphical display in the
Data window and then move your mouse to drag the marker to select the desired channel.
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Marker Tools

You can use WorkBench to set and adjust markers on a graphic report. Marker values and levels
appear on the report’s summary pane.

Setting Markers
You can set markers by performing one of the following actions:

• To set the left marker, move the mouse cursor over the graphical display and then select
the left mouse button.

• To set the right marker, move the mouse cursor over the graphical display and then
select the right mouse button.

• For Scan, Forward Sweep, and Tilt data logs, select a channel from the channel plan
that is displayed at the bottom portion of the Data Window. When selecting channels
from the channel plan, select the left mouse button to set the left marker or select the
right mouse button to set the right marker.

• For QAM EVS and Spectrum Analyzer data logs, select the  button to set the
markers to the peak value that is displayed.

• For BER, CSO/CTB and FDR data logs, you can select the up or down arrow to the
right of the Marker 1 or Marker 2 fields shown in the report’s summary pane.
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Moving Markers

You can move the markers by performing one of the following actions:

• Use your mouse to select and drag the triangle-shaped “grips” at the bottom of the
graph

• For Scan, Forward Sweep, and Tilt data logs, select a channel from the channel plan
that is displayed at the bottom portion of the Data Window. When selecting channels
from the channel plan, select the left mouse button to move the left marker or select the
right mouse button to move the right marker.

• For BER, CSO/CTB and FDR data logs, you can select the up or down arrow to the
right of the Marker 1 or Marker 2 fields shown in the report’s summary pane.

The following table provides a description of the each of the marker tool keyboard shortcut
keys.

Keyboard Shortcut Description 

[Left] 
Move Both Markers Left One Channel, or One Carrier in 
Carrier Mode 

[Right] 
Move Both Markers Right One Channel, or One Carrier in 
Carrier Mode 

Ctrl + [Left] Move Marker 1 Left by One Channel/Carrier 

Ctrl + [Right] Move Marker 1 Right by One Channel/Carrier 

Alt + [Left] Move Marker 2 Left by One Channel/Carrier 

Alt + [Right] Move Marker 2 Right by One Channel/Carrier 
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The Location fields will be displayed in a report’s summary pane as follows:

Type: This displays the type of location where the test was performed from.

Area: This displays the area of the cable system that the location belongs to.

Amplifier ID: This displays the name of the amplifier being tested.

Power: This displays the power setting for this location (In, Out, or Through).

Voltage: This displays the voltage setting (Low, Medium, or High).

Feeder: This displays the feeder line that the test was performed from (1 - 9).

Reverse Pad: This displays the value of the reverse pad being used in dB.

Reverse EQ: This displays the value of the reverse EQ being used in dB.

Forward Pad: This displays the value of the forward pad being used in dB.

Forward EQ: This displays the value of the forward EQ being used in dB.

Trunk Termination: This displays whether the location was a trunk termination (Yes or No).

Location Data in Reports

The Location Fields shown above are user configurable fields
that can be setup as shown in Section III:  Managing
Configurations, Chapter 3: Locations.

To add location data to your test reports, you must first enable
location data to be added to the data log as shown in Section III:
Managing Configurations, Chapter 7: 860 DSP and 860 DSPi
Configuration Packages.
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Bit Error Ratio (BER Mode)

The BER data log is a report in text and graphic formats that shows the number of bit errors
occurring during the test period.

• The channel number for which the test was conducted will be displayed in the channel table
at the bottom of the Data window.

• When in the Corrected Errors or Uncorrected Errors Graph Views, the measurement
results will be displayed in the BER report’s summary panel at the left side of the Data
window.

• The coordinate values (Time, Errors) of the mouse cursor will be displayed at the top of the
Data window above the graph.

Corrected Errors Graph View

To view the BER
Corrected Errors

Graph, select the 

button or press the C
key on your
keyboard.

An example of the
BER Corrected
Errors Graph is
shown to the right.

5. Example Data Logs
Chapter 5
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Text Data View

To view the BER Text

Data, select the 

button or press the T
key on your keyboard.

An example of the
BER Text Data is
shown to the right.

Uncorrected Errors Graph View

To view the BER
Uncorrected Errors

Graph, select the 
button or press the U
key on your
keyboard.

An example of the
BER Uncorrected
Errors Graph is
shown to the right.
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Measurement Results

The fields displayed in the BER report’s summary pane are as follows:

Marker (Displayed in Corrected and Uncorrected Views Only)

Time: Displays the time at the location of the marker.

Corrected Errors or Uncorrected Errors: Displays the total number of corrected or
uncorrected errors at the location of the current marker.

BER

Scan Time: The total number of seconds the test required.

QAM Lock: This box is checked if the chipset has locked onto a QAM channel.

FEC Lock: This box is checked if the forward error correction routine has locked onto
a QAM channel.

Pre-FEC BER: The bit error rate prior to forward error correction.

Post-FEC BER: The bit error rate after to forward error correction.

Total Corrected: The number of code words corrected by forward error correction.

Total Uncorrected: The number of code words not correctable by forward error
correction.

Error Seconds: The number of seconds that had at least one code word that was
corrected.

Severely Errored Seconds: The number of seconds that had at least one code word
that was uncorrectable.

Markers

For the Corrected Errors Graph and the Uncorrected Errors Graph, you can set a single
marker at any time within the measurement range. The number of corrected or uncorrected
code words that correspond to the time that the marker was set to will be displayed in the
summary pane. To set a marker perform one of the following actions:

• Move the mouse cursor over the
graphical display and then select
the left mouse button.

• Select the up or down arrows to
the right of the Time field to change the time in 1 second increments.
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CM Stats (CM Stat Mode)

The CM Stats data log is a report in text format that
shows the upstream and downstream cable modem
test results.

An example of the CM Stats Text Data is shown to the
right.

The fields displayed in the CM Stats report are as
follows:

CM Statistics Measurements

Downstream Annex:  This displays the
downstream DOCSIS Annex (A or B) used by the
cable modem.

DOCSIS Mode: This displays the DOCSIS Mode
(1.1, 2.0, 3.0, etc.) used by the cable modem.

MAC Address #: This displays a sequential
number assigned to reference and identify the
MAC address assigned to the cable modem.

MAC Address: This field displays the MAC
address assigned to the cable modem.

Upstream Measurements

Upstream Frequency:  This displays the
upstream frequency in MHz used by the cable
modem.

Upstream Rate: This displays the upstream
symbol rate in KSPS used by the cable modem.

Upstream Power: This displays the upstream transmit level in dBmV used by the cable
modem.

Upstream ID: This displays the channel descriptor used by the cable modem (1 to 16).
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Downstream Measurements

Downstream Frequency: This displays the downstream frequency in MHz used by the cable
modem.

Downstream Rate: This displays the downstream symbol rate in MSPS used by the cable
modem.

Downstream Power: This displays the downstream receive level in dBmV used by the cable
modem.

Downstream Modulation: This displays the downstream QAM type used by the cable
modem.

Downstream Bandwidth:  This displays the downstream channel bandwidth in MHz used by
the cable modem.

Downstream Signal/Noise: This displays the downstream MER or SNR in dB used by the
cable modem.

Primary Capable: This displays the channel that has been designated as the primary carrying
DOCSIS 3.0 timing information.  By designating a primary channel, DOCSIS 2.0 modems can
log on to a DOCSIS 3.0 system.
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Carrier Second Order / Triple Beat (CSO/CTB Mode)

The CSO/CTB data log is a report in text and graphics formats that shows the amplitude of two
common intermodulation products, CSO (Composite Second Order) and CTB (Composite Triple
Beat), present within a selected analog video channel.

• The channel number for which the test was conducted will be displayed in the channel table
at the bottom of the Data window.

• When in the Graph View, the measurement results will be displayed in the CSO/CTB
report’s summary panel at the left side of the Data window.

• The coordinate values (Frequency, Carrier Level) of the mouse cursor will be displayed at
the top of the Data window above the graph.

Graph View

To view the CSO/
CTB Graph, select

the  button from
the toolbar at the top
of the Data window
or press the G key on
your keyboard.

An example of the
CSO/CTB Graph is
shown to the right.

For more information on how to use the Zoom Tools that are
located in the toolbar at the top of this data log report, see
Chapter 2: Analyzing Data, Using the Zoom Tools.
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Text Data View

To view the CSO/CTB Text

Data, select the  button
from the toolbar at the top of
the Data window or press
the T key on your keyboard.

An example of the CSO/
CTB Text Data is shown to
the right.

Measurement Results

The fields displayed in the CSO/CTB report’s summary pane are as follows:

Graph

Offset: This displays the frequency offset in MHz.

Frequency: This displays the frequency at the current marker position in MHz.

Level: This displays the power level at the current marker position in dBc.

Type: This displays the type of the intermodulation product at the current marker
position (CSO or CTB).
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CSO/CTB

Carrier Level: This displays the measured carrier level in dBmV.

CSO: This displays the CSO (Carrier Second Order) level in dBc.

CTB: This displays the CTB (Carrier Triple Beat) level in dBc.

DSP Result: Shows that the 860 DSP or 860 DSPi hardware worked successfully
during the test. This field can be ignored unless it displays a result other than OK. If the
field displays an error code, contact Trilithic for support.

Markers

For the Graph view, you can set a single marker at any CSO or CTB  for the measured
channel. The Offset, Frequency, Level, and Type that correspond to the current marker
location  will be displayed in the summary pane. To set a marker perform one of the following
actions:

• Move the mouse cursor over the graphical display and then select the left mouse button
on any of the Offset Frequencies.

• Select the up or down arrows to the right of the Offset field to chose from a Frequency
Offset Value of -1.25, -0.75, 0.00, 0.75, or 1.25 MHz.
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Carrier-to-Noise (C/N Mode)

The Carrier-to-Noise data log is a
text only report that displays the
carrier-to-noise ratios for a single
channel.

An example of the Carrier-to-Noise
Text Data is shown to the right.

The channel number for which the
test was conducted will be displayed
in the channel table at the bottom of
the Data window.

Measurement Results

The fields displayed in the Carrier-to-Noise report are as follows:

Carrier: This displays the measured carrier level in dBmV.

Noise: The measured noise level in the specified Noise Bandwidth in dBmV.

C/N: The difference between the carrier level and the noise level in dB.

Limit Results: This displays the Pass or Fail results for tests that were conducted as part
of a Autotest Macro. This field is not displayed if the test was conducted outside of an
Autotest Macro.

DSP Result: Shows that the 860 DSP or 860 DSPi hardware worked successfully during
the test. This field can be ignored unless it displays a result other than OK. If the field
displays an error code, contact Trilithic for support.
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Depth of Modulation (MOD Mode)

The Depth of Modulation data log is a
text only report that displays the depth of
modulation.

An example of the Depth of Modulation
Text Data is shown to the right.

The channel number for which the test
was conducted will be displayed in the
channel table at the bottom of the Data window.

Measurement Results
The fields displayed in the Depth of Modulation report are as follows:

Depth of Modulation: This displays the percentage of depth of modulation.

Limit Results: This displays the Pass or Fail results for tests that were conducted as part
of a Autotest Macro. This field is not displayed if the test was conducted outside of an
Autotest Macro.

DSP Result: Shows that the 860 DSP or 860 DSPi hardware worked successfully during
the test. This field can be ignored unless it displays a result other than OK. If the field
displays an error code, contact Trilithic for support.



WorkBench Software - Section II: Managing Devices and Data
II-57

Frequency Domain Reflectometer (FDR Mode)

The Frequency Domain Reflectometer data log is a graphics only report that displays the
measurement results as shown below.

• The measurement results will be displayed in the FDR report’s summary panel at the left
side of the Data window.

• The coordinate values (Distance, Return Loss) of the mouse cursor will be displayed at the
top of the Data window above the graph.

Measurement Results
The fields displayed in the Frequency Domain Reflectometer report’s summary pane are as
follows:

Graph

Ref Level: This displays the user adjustable Reference Level. Select the up or down
arrows to the right of the field to adjust the Reference Level in 1 dBmV increments.

Start Freq: This displays the user adjustable Start Frequency in MHz. Select the up or
down arrows to the right of the field to adjust the Start Frequency by the Channel
Spacing defined in the instrument configuration.
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Stop Freq: This displays the user adjustable Stop Frequency in MHz. Select the up or
down arrows to the right of the field to adjust the Stop Frequency by the Channel
Spacing defined in the instrument configuration.

The Channel Spacing is a user configurable field that can be
setup as shown in Section III:  Managing Configurations,
Chapter 7: 860 DSP and 860 DSPi Configuration Packages.

Step: This displays the user adjustable Step. Select the up or down arrows to the right
of the field to adjust the Step in 1 MHz increments.

Markers

Marker 1: This displays the distance to the location of Marker 1 in ft.

Return Loss 1: This displays the return loss from the location of Marker 1 in dBRL.

Marker 2: This displays the distance to the location of Marker 2 in ft.

Return Loss 2: This displays the return loss from the location of Marker 2 in dBRL.

Delta: This displays the difference in distance between Marker 1 and Marker 2 in dB.

FDR

Cable Velocity Factor: Shows the cable velocity factor that is selected on the 860
DSP at the time the test is performed.

DSP Result: Shows that the 860 DSP or 860 DSPi hardware worked successfully during
the test. This field can be ignored unless it displays a result other than OK. If the field
displays an error code, contact Trilithic for support.

Markers

For the Graph view, you can set markers at any distance from the device. The Distance and
Return Loss that correspond to the marker location will be displayed in the summary pane. To
set a marker perform one of the following actions:

• Move the mouse cursor over the graphical display and then select the left (left marker)
or right (right) mouse button.

• Select the up or down arrows to the right of the Marker 1 or Marker 2 field to chose
from a Frequency Offset Value of -1.25, -0.75, 0, 0.75, or 1.25.
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FM Deviation (FM DEV Mode)

The FM Deviation data log is a text only
report that shows the instantaneous and
peak FM deviation of the selected audio
frequency.

An example of the FM Deviation Text Data
is shown to the right.

The channel number for which the test was
conducted will be displayed in the channel
table at the bottom of the Data window.

Measurement Results
The fields displayed in the FM Deviation report are as follows:

FM Deviation: This displays the instantaneous FM Deviation in kHz.

Peak FM Deviation: This displays the peak FM Deviation in kHz.

DSP Result: Shows that the 860 DSP or 860 DSPi hardware worked successfully during
the test. This field can be ignored unless it displays a result other than OK. If the field
displays an error code, contact Trilithic for support.
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Forward Sweep (Sweep Mode)

The Forward Sweep data log is a graphics only report that shows the various configurations of the
test points you encounter when you perform a sweep test.

• The channel numbers for which the test was conducted will be displayed in the channel
table at the bottom of the Data window.

• The measurement results will be displayed in the Forward Sweep report’s summary panel
at the left side of the Data window.

• The coordinate values (Frequency, Level) of the mouse cursor will be displayed at the top
of the Data window above the graph.

Normalized Sweep View
To view the
Normalized Sweep

Graph, select the 
button from the
toolbar at the top of
the Data window or
press the N key on
your keyboard.

An example of the
Normalized Sweep
Graph is shown to
the right.

The Normalized
Sweep Graph shows
the difference
between a stored
reference and the current levels (may be the same test point at a different time, or a different
test point down the line in the network).

For more information on how to use the Zoom Tools that are
located in the toolbar at the top of this data log report, see
Chapter 2: Analyzing Data, Using the Zoom Tools.
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Scan Data View

To view the Scan
Data View Graph,

select the  button
from the toolbar at the
top of the Data
window or press the
D key on your
keyboard.

An example of the
Scan Data View is
shown to the right.

The Scan Data View Graph compares the levels at two different points in the cable system. In
this view, the light blue line is a plot of the measured scan of all channels. The dark blue line is
a reference scan that was previously taken at a different place on the cable network and stored
for reference purposes.

For more information on how to use the Zoom Tools that are
located in the toolbar at the top of this data log report, see
Chapter 2: Analyzing Data, Using the Zoom Tools.
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Split View

To view the Split View

Graph, select the 
button from the
toolbar at the top of
the Data window or
press the S key on
your keyboard.

An example of the
Split View is shown to
the right.

The Split View Graph shows both the Scan Data View (Top) and the Normalized Data View
(Bottom) on the same graph.

For more information on how to use the Zoom Tools that are
located in the toolbar at the top of this data log report, see
Chapter 2: Analyzing Data, Using the Zoom Tools.

Measurement Results
The fields displayed in the Forward Sweep report’s summary pane are as follows:

Graph

Ref Level: This displays the user adjustable Reference Level. Select the up or down
arrows to the right of the field to adjust the Reference Level in 1 dBmV increments.
This field is not displayed in the Normalized Sweep View.

Scale: This displays the user adjustable Vertical Scale. Select the up or down arrows
to the right of the field to chose the Vertical Scale to a value of 1, 2, 5, or
10 dB/Div
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Start Freq: This displays the user adjustable Start Frequency in MHz. Select the up or
down arrows to the right of the field to adjust the Start Frequency by the Channel
Spacing defined in the instrument configuration.

End Freq: This displays the user adjustable End Frequency in MHz. Select the up or
down arrows to the right of the field to adjust the End Frequency by the Channel
Spacing defined in the instrument configuration.

The Channel Spacing is a user configurable field that can be
setup as shown in Section III:  Managing Configurations,
Chapter 7: 860 DSP and 860 DSPi Configuration Packages.

Scan Data (Displayed in Scan Data and Split Views Only)

Marker 1: This displays the frequency in MHz and channel number at the location of
Marker 1.

Level 1: This displays the level in dBmV of the data trace (not the reference trace) at
the location of Marker 1.

Ref Delta 1: This displays the difference in dB between the reference trace and the
data trace at the location of Marker 2.

Marker 2: This displays the frequency in MHz and channel number at the location of
Marker 2.

Level 2: This displays the level in dBmV of the data trace (not the reference trace) at
the location of Marker 2.

Ref Delta 2: This displays the difference in dB between the reference trace and the
data trace at the location of Marker 2.

Ref Delta 2: This displays the difference in dB between Level 1 and Level 2.

For more information on how to adjust Markers in this data log
report, see Chapter 2: Analyzing Data, Marker Tools.
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Sweep Normalized (Displayed in Normalized Data and Split Views
Only)

Marker 1: This displays the frequency in MHz and channel number at the location of
Marker 1.

Normalized 1: This displays the difference in level between the reference level
between the reference trace and the data trace at the location of Marker 1.

Marker 2: This displays the frequency in MHz and channel number at the location of
Marker 2.

Normalized 2: This displays the difference in level between the reference level
between the reference trace and the data trace at the location of Marker 2.

Marker Delta: This displays the difference in dB between Normalized 1 and
Normalized 2.

Forward Sweep

Data Test Point: This displays the name of the data test point.

Data Low Pilot: This displays the expected carrier level in dBmV of the lowest tilt
enabled frequency. This is used in conjunction with the Data High Pilot to remove tilt
from the Data Trace.

Data High Pilot: This displays the expected carrier level in dBmV of the highest tilt
enabled frequency. This is used in conjunction with the Data Low Pilot to remove tilt
from the Data Trace.

Data Offset: The value of the tap in dB at the test point used to measure the Data
Trace. This value is added to all data measured by the instrument.

Ref Test Point: This displays the name of the reference test point.

For more information on how to adjust Markers in this data log
report, see Chapter 2: Analyzing Data, Marker Tools.
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Ref Low Pilot: This displays the expected carrier level in dBmV of the lowest tilt
enabled frequency. This is used in conjunction with the Ref High Pilot to remove tilt from
the Reference Trace.

Ref High Pilot: This displays the expected carrier level in dBmV of the highest tilt
enabled frequency. This is used in conjunction with the Ref Low Pilot to remove tilt from
the Reference Trace.

Ref Offset: The value of the tap in dB at the test point used to measure the Reference
Trace. This value is added to all data measured by the instrument.

DSP Result: Shows that the 860 DSP or 860 DSPi hardware worked successfully during
the test. This field can be ignored unless it displays a result other than OK. If the field
displays an error code, contact Trilithic for support.

The Forward Sweep Fields shown above are user configurable
fields that can be setup as shown in Section III:  Managing
Configurations, Chapter 7: 860 DSP and 860 DSPi
Configuration Packages.
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HUM (HUM Mode)

The HUM data log is a text only report
that shows the detected HUM on the
channel.

An example of the HUM Text Data is
shown to the right.

The channel number for which the test
was conducted will be displayed in the
channel table at the bottom of the Data
window.

Measurement Results
The fields displayed in the HUM report are as follows:

60 Hz: Displays the percentage of 60 Hz HUM on the channel.

120 Hz: Displays the percentage of 120 Hz HUM on the channel.

< 1 kHz: Displays the percentage of HUM below 1 kHz on the channel.

Limit Results: This displays the Pass or Fail results for tests that were conducted as part
of a Autotest Macro. This field is not displayed if the test was conducted outside of an
Autotest Macro.

DSP Result: Shows that the 860 DSP or 860 DSPi hardware worked successfully during
the test. This field can be ignored unless it displays a result other than OK. If the field
displays an error code, contact Trilithic for support.

50 Hz and 100 Hz will be displayed if you selected 50/100 Hz
instead of 60/120 Hz in the Level Mode Parameters Screen as
shown in Section III:  Managing Configurations, Chapter 7: 860
DSP and 860 DSPi Configuration Packages.
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LCD Screen Capture

The LCD Screen Capture report is slightly different from the other reports available in WorkBench.
No data is analyzed, the report is simply a screen capture from instrument’s screen as shown
below. Captured screens can be useful for identifying specific instances of tests, menu structures,
and recording configuration information.
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Leakage (Leak Mode)

The Leakage data log is a text only report that shows the
leakage level that was recorded.

An example of the Leakage Text Data is shown to the right.

Measurement Results

The fields displayed in the Leakage report are as follows:

Level: Displays the measured leakage value in μv/meter.

Limit Results: This displays the Pass or Fail results for tests that were conducted as part
of a Autotest Macro. This field is not displayed if the test was conducted outside of an
Autotest Macro.
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Measurement Results
The fields displayed in the Level report are as follows:

Video: Displays the measured level in dBmV of the video signal.

Audio: Displays the measured level in dBmV of the audio signal.

V/A Delta: Displays the delta in dB between the measured levels of the video and audio
signals.

If the Level report is of a digital channel then the fields Video,
Audio, and V/A Delta are replaced with Digital, which shows the
measured level of the digital carrier.

DSP Result: Shows that the 860 DSP or 860 DSPi hardware worked successfully during
the test. This field can be ignored unless it displays a result other than OK. If the field
displays an error code, contact Trilithic for support.

Level (Level Mode)

The Level data log is a text only
report that shows the video and
audio levels on a channel.

An example of the Level Text Data is
shown to the right.

The channel number for which the
test was conducted will be displayed
in the channel table at the bottom of
the Data window.
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Ping (PING Mode)

The Ping data log is a text only report that shows the results of a
network PING test.

An example of the PING Text Data is shown to the right.

Measurement Results

The fields displayed in the Ping report are as follows:

Host Name: Displays the name of the remote machine that was contacted.

IP Address: Displays the network IP Address of the remote machine that was contacted.

Packet Delay: Displays the time in milliseconds between the sending of each packet.

Packet Size: Displays the actual payload size of the packet in bytes.

Packets Sent: Displays the number of ping packets that the instrument attempted to send.

Packets Received: Displays the number of ping packets successfully returned to the
instrument.

Packets Lost: Displays the number of packets that did not get echoed back.

LPR: Displays the ratio of packets lost to packets sent.

LPR (%): The LPR stated as a percentage.

Packet Errors: Displays the number of packets that could not be transmitted.
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Min Ping Time: Displays the minimum time, in milliseconds, taken by a successful round
trip transmission/receipt of a ping packet.

Avg Ping Time: Displays the average time, in milliseconds, taken by a successful round
trip transmission/receipt of a ping packet.

Max Ping Time: Displays the maximum time, in milliseconds, taken by a successful round
trip transmission/receipt of a ping packet.

Latency: Displays the average round trip packet time divided by two (2), plus any CODEC
and Buffer delays from the setup.

Jitter: Displays the remainder of the maximum adjacent packet delay less the minimum
adjacent packet delay, then divided by two (2).

Limit Results: This displays the Pass or Fail results for tests that were conducted as part
of a Autotest Macro. This field is not displayed if the test was conducted outside of an
Autotest Macro.
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QAM (QAM Mode)

The QAM data log is a report in text and graphics formats that shows the signal qualities of a
QAM modulated channel.

• The channel number for which the test was conducted will be displayed in the channel table
at the bottom of the Data window.

• When in the Graph View, the measurement results will be displayed in the QAM report’s
summary panel at the left side of the Data window.

• The coordinate values [Constellation Graph (I, Q), EQ Taps Graph (Time, Level), BER
Corrected Errors (Time, Corrected Errors), or BER Uncorrected Errors (Time, Uncorrected
Errors) of the mouse cursor will be displayed at the top of the Data window above the
graph.

Constellation View

To view the
Constellation Graph,

select the  button

from the toolbar at the
top of the Data
window or press the
Q key on your
keyboard.

An example of the
Constellation Graph
is shown to the right.

For more information on how to use the Zoom Tools that are
located in the toolbar at the top of this data log report, see
Chapter 2: Analyzing Data, Using the Zoom Tools.
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EQ Taps View

To view the EQ Taps

Graph, select the 
button from the toolbar
at the top of the Data
window or press the E
key on your keyboard.

An example of the EQ
Taps Graph is shown to
the right.

EQ Taps Text Data View

To view the EQ Taps Text Data, select the 
button from the toolbar at the top of the Data
window or press the T key on your keyboard.

An example of the EQ Taps Text Data is shown to
the right.
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BER Corrected Errors View

To view the BER Corrected Errors

Graph, select the  button from the
toolbar at the top of the Data window.

An example of the BER Corrected
Errors Graph is shown to the right.

BER Uncorrected Errors
View
To view the BER Uncorrected Errors

Graph, select the  button from the
toolbar at the top of the Data window.

An example of the BER Uncorrected
Errors Graph is shown to the right.



WorkBench Software - Section II: Managing Devices and Data
II-75

BER Text Data View

To view the BER Text Data

View, select the  button from
the toolbar at the top of the
Data window.

An example of the BER Text
Data is shown to the right.

Measurement Results

Graph (Constellation
Graph View Only)

Zoom: This displays the
number of squares of
data that are visible on
the graph.

View: This displays the
size of the data block
being displayed.

Marker

EQ Tap: This displays the time in μμμμμSec that the current marker is set to. This is
displayed in the EQ Taps Graph View Only.

Distance: This displays the distance represented by the EQ Tap at the location of the
current marker. This is displayed in the EQ Taps Graph View Only.

Level: This displays the level in dB at the EQ Tap at the location of the current marker.
This is displayed in the EQ Taps Graph View Only.

Time: This displays the time that the current marker is set to. This is displayed in the
BER Corrected Errors and BER Uncorrected Errors Graph Views Only.

Corrected Errors: This displays the corrected errors at the location of the current
marker. This is displayed in the BER Corrected Graph View Only.

Uncorrected Errors: This displays the uncorrected errors at the location of the current
marker. This is displayed in the BER Uncorrected Graph View Only.
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QAM

Level: This displays the level in dBmV of the QAM modulated channel.

MER: This displays the Modulation Error Ratio of the QAM modulated channel.

EVM: This displays the Error Vector Magnitude percentage .

Pre-FEC BER: This displays the amount of errors before Forward Error Correction.

Post-FEC BER: This displays the amount of errors after Forward Error Correction.

Cable Velocity Factor: This displays the cable velocity factor of the cable being
tested.

Limit Results: This displays the Pass or Fail results for tests that were conducted as part
of a Autotest Macro. This field is not displayed if the test was conducted outside of an
Autotest Macro.

DSP Result: Shows that the 860 DSP, DSPi, or DSPr hardware worked successfully
during the test. This field can be ignored unless it displays a result other than OK. If the field
displays an error code, contact Trilithic for support.

BER

Scan Time: This displays the BER scan time.

Total Corrected: This displays the total corrected errors.

Total Uncorrected: This displays the total uncorrected errors.

Error Seconds: This displays the amount of errored seconds.

Severely Errored Seconds: This displays the amount of severely errored seconds.
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Markers

For the EQ Taps, BER Corrected Errors, and BER Uncorrected Errors Graph views, you
can set markers. To set a marker perform one of the following actions:

• Move the mouse cursor over the graphical display and then select the left mouse button.

• For the EQ Taps Graph View, select the up or down arrows to the right of the EQ Tap
field to change the value in 0.1 μμμμμsec increments. The distance from the device and the
level at the specified tap will be displayed in the EQ Taps report’s summary pane.

• For the BER Corrected Errors Graph View, select the up or down arrows to the right
of the Time field to change the value in 1 sec increments. The corrected errors at the
specified time will be displayed in the BER Corrected Errors report’s summary pane.

• For the BER Uncorrected Errors Graph View, select the up or down arrows to the
right of the Time field to change the value in 1 sec increments. The uncorrected errors
at the specified time will be displayed in the BER Corrected Errors report’s summary
pane.
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QAM EVS (QAM EVS Mode)

The QAM EVS data log is a report in graphics format that shows the test results of a QAM Error
Vector Spectrum test performed by the 860 DSP, DSPi, or DSPr.

• The channel number for which the test was conducted will be displayed in the channel table
at the bottom of the Data window.

• When in the Graph View, the measurement results will be displayed in the QAM EVS
report’s summary panel at the left side of the Data window.

• The coordinate values (Frequency, Level) of the mouse cursor will be displayed at the top
of the Data window above the graph.

Graph View

An example of the QAM EVS graph view is shown below:

For more information on how to use the Zoom Tools that are
located in the toolbar at the top of this data log report, see
Chapter 2: Analyzing Data, Using the Zoom Tools.
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Measurement Results

The fields displayed in the QAM EVS report’s summary pane are as follows:

Graph

Ref Level: This displays the user adjustable Reference Level. Select the up or down
arrows to the right of the field to adjust the Reference Level in 1 dBmV increments.

Scale: This displays the user adjustable Vertical Scale. Select the up or down arrows
to the right of the field to chose the Vertical Scale to a value of 1, 2, 5, or
10 dB/Div.

Start Freq: This displays the user adjustable Start Frequency. Select the up or down
arrows to the right of the field to adjust the Start Frequency in 0.021 MHz increments.

End Freq: This displays the user adjustable End Frequency. Select the up or down
arrows to the right of the field to adjust the End Frequency in 0.021 MHz increments.

Markers

Marker 1: This displays the frequency in MHz at the location of Marker 1.

Power 1: This displays the power in dB at the location of Marker 1.

Marker 2: This displays the frequency in MHz at the location of Marker 2.

Power 2: This displays the power in dB at the location of Marker 2.

Delta: This displays the difference in dB between Marker 1 and Marker 2.

Peak Value Markers

For QAM EVS data logs, select the  button to set the markers to the peak value that is
displayed.

For more information on how to adjust Markers in this data log
report, see Chapter 2: Analyzing Data, Marker Tools.
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QAM EVS

MER: This displays the Modulation Error Ratio of the digital channel.

EVM: This displays the Error Vector Magnitude percentage.

Level: This displays the level of the Error Vector Magnitude in dBmV.

Pre-FEC BER: This displays the amount of errors before Forward Error Correction.

Post-FEC BER: This displays the amount of errors after Forward Error Correction.

Cable Velocity Factor: This displays the cable velocity factor of the cable being
tested.

DSP Result: Shows that the 860 DSP, DSPi, or DSPr hardware worked successfully
during the test. This field can be ignored unless it displays a result other than OK. If the
field displays an error code, contact Trilithic for support.
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QAM Lite (QAM Lite Mode)

The QAM Lite data log is a
report in text format that
shows the signal qualities of
QAM Modulated channels.

An example of the QAM Lite
Text Data is shown to the
right.

The channel number for
which the test was
conducted will be displayed
in the channel table at the bottom of the Data window.

Measurement Results

QAM Lite

Level: This displays the level in dBmV of the QAM modulated channel.

MER: This displays the Modulation Error Ratio of the QAM modulated channel.

EVM: This displays the Error Vector Magnitude percentage.

Pre-FEC BER: This displays the amount of errors before Forward Error Correction.

Post-FEC BER: This displays the amount of errors after Forward Error Correction.

Cable Velocity Factor: This displays the cable velocity factor of the cable being
tested.

DSP Result: Shows that the 860 DSP, DSPi, or DSPr hardware worked successfully
during the test. This field can be ignored unless it displays a result other than OK. If the
field displays an error code, contact Trilithic for support.
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RSA (Return Sweep Analysis Mode)

The Return Sweep data log is a report in text and graphic formats.  Return Sweeping is used to
locate micro reflections and narrow suck-outs.

• When in the Graph View, the measurement results will be displayed in the Return
SpeedSweep Analysis report summary panel at the left side of the Data window.

• The coordinate values (Frequency, Level) of the mouse cursor will be displayed at the top
of the Data window above the graph.

Graph View
The Return Sweep is
displayed as a graph,
by default.

An example of the
Return Sweep graph
is shown to the right.

There are two
different modes of
return sweep report:
sweep and compare.
The report mode is
selected on the 860
DSP at the time the
test is performed.  The sweep graph has a light blue ingress trace and the sweep trace has a
dark blue line.

For more information on how to use the Zoom Tools that are
located in the toolbar at the top of this data log report, see
Chapter 2: Analyzing Data, Using the Zoom Tools.
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Marker Mode Settings

For Return Sweep data logs you can select the Marker Mode by performing one of the
following actions:

• From the Scan Report Summary Pane,
select the Marker Mode from the Mode
drop-down list as shown to the right, or

• Use one of the keyboard shortcuts shown
in the table below.

Keyboard 
Shortcut 

Name Description 

S Sweep Marker Mode 
This mode causes the markers to show the level 
of the local sweep trace taken by the 860 DSP 
or 860 DSPi. 

I Ingress Marker Mode 
This mode causes the markers to show the level 
of the ingress trace received from the 8310 
RSA. 

 

For more information on how to adjust Markers in this data log
report, see Chapter 2: Analyzing Data, Marker Tools.

Measurement Results

The fields displayed in the Return Sweep report’s summary pane are as follows:

Graph

Ref Level: This displays the user adjustable Reference Level. Select the up or down
arrows to the right of the field to adjust the Reference Level in 1 dBmV increments.

Scale: This displays the user adjustable Vertical Scale. Select the up or down arrows
to the right of the field to chose the Vertical Scale to a value of 1, 2, 5, or
10 dB/Div.
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Start Freq: This displays the user adjustable Start Frequency in MHz. Select the up or
down arrows to the right of the field to adjust the Start Frequency by the Channel
Spacing defined in the instrument configuration.

End Freq: This displays the user adjustable End Frequency in MHz. Select the up or
down arrows to the right of the field to adjust the End Frequency by the Channel
Spacing defined in the instrument configuration.

The Channel Spacing is a user configurable field that can be
setup as shown in Section III:  Managing Configurations,
Chapter 7: 860 DSP and 860 DSPi Configuration Packages.

Markers

Mode: This displays the user adjustable Marker Mode. See the previous section on
instructions on how to set the Marker Mode.

Marker 1: This displays the frequency in MHz at the current location of Marker 1.

Level 1: This displays the level in dBmV of either the ingress trace from the SST
(Ingress Mode) or the local ingress trace taken by the 860 DSP or 860 DSPi (SSR
Mode), at the location of Marker 1.

Marker 2: This displays the frequency in MHz at the current location of Marker 2.

Level 2: This displays the level in dBmV of either the ingress trace from the SST
(Ingress Mode) or the local ingress trace taken by the 860 DSP or 860 DSPi (SSR
Mode), at the location of Marker 2.

Tilt: This displays the frequency in MHz between Marker 2 and Marker 1 (M2 - M1).

Gain: This displays the frequency in MHz between Marker 2 and the headend nominal
frequency (M2 - value of the dashed line).

For more information on how to adjust Markers in this data log
report, see Chapter 2: Analyzing Data, Marker Tools.
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RSA

Unit: The Unit ID (A - F) of the 860 DSP or 860 DSPi. This is used by the 8310 RSA or
9581 SST to identify the 860 DSP or 860 DSPi.

HE Nominal: This displays the headend nominal level in dBmV of the 8310 RSA that
the 860 DSP or 860 DSPi was communicating with.

Telemetry Level: This displays the signal strength of the telemetry signal received by
the 860 DSP or 860 DSPi.

Mode: This displays the mode (Normal, Fast, or Zoom) of the 8310 RSA that the 860
DSP or 860 DSPi was communicating with.

Res Bandwidth: This displays the resolution bandwidth (375 kHz or 525 kHz) of the
8310 RSA that the 860 DSP or 860 DSPi was communicating with.

Detector: This displays the detector mode (Single, Peak, Avg, or Traffic) of the 8310
RSA that the 860 DSP or 860 DSPi was communicating with.

DSP Result: Shows that the 860 DSP or 860 DSPi hardware worked successfully
during the test. This field can be ignored unless it displays a result other than OK. If the
field displays an error code, contact Trilithic for support.
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Reverse Sweep (SSR Mode)

The Reverse Sweep data log is a report in text and graphics formats. Reverse sweeping is used
to adjust the gain and tilt of reverse distribution amplifiers. The 860 DSP’s sweep function
transmits a set of up to eight reverse test carriers to the SST in the hub for analysis.

• When in the Graph View, the measurement results will be displayed in the Reverse Sweep
report’s summary panel at the left side of the Data window.

• The coordinate values (Frequency, Level) of the mouse cursor will be displayed at the top
of the Data window above the graph.

Graph View

To view the Reverse
Sweep Graph, select

the  button from the
toolbar at the top of the
Data window or press
the G key on your
keyboard.

An example of the
Reverse Sweep Graph
is shown to the right.

For more information on how to use the Zoom Tools that are
located in the toolbar at the top of this data log report, see
Chapter 2: Analyzing Data, Using the Zoom Tools.

There are two different modes of reverse sweep report: sweep and compare. The report mode
is selected on the 860 DSP at the time the test is performed. The sweep graph has a light blue
ingress trace and a sweep graph with up to eight green squares or red X’s connected by a
white line. The compare graph has two ingress line graphs (light and dark blue).
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Text Data View

To view the Reverse Sweep Text Data,

select the  button from the toolbar at the
top of the Data window or press the T key
on your keyboard.

An example of the Reverse Sweep Text
Data is shown to the right.
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When the Marker Mode is set to SSR, you will not be able to
adjust the location of either marker. You must first select
Ingress Mode to change the position of the marker(s). The
marker location will appear at the same location in each mode.

Marker Mode Settings

For Return Sweep data logs you can select the Marker Mode by performing one of the
following actions:

• From the Scan Report Summary Pane,
select the Marker Mode from the Mode
drop-down list as shown to the right.

• Use one of the keyboard shortcuts shown
in the table below.

Keyboard 
Shortcut 

Name Description 

S SSR Marker Mode 
This mode causes the markers to show the level 
of the local ingress trace taken by the 860 DSP 
or 860 DSPi. 

I Ingress Marker Mode 
This mode causes the markers to show the level 
of the ingress trace received from the 9580 SST 
or 9581 SST. 

 

For more information on how to adjust Markers in this data log
report, see Chapter 2: Analyzing Data, Marker Tools.
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Measurement Results

The fields displayed in the Forward Sweep report’s summary pane are as follows:

Graph

Ref Level: This displays the user adjustable Reference Level. Select the up or down
arrows to the right of the field to adjust the Reference Level in 1 dBmV increments.

Scale: This displays the user adjustable Vertical Scale. Select the up or down arrows
to the right of the field to chose the Vertical Scale to a value of 1, 2, 5, or
10 dB/Div. This field is not displayed in the Normalized Sweep View.

Start Freq: This displays the user adjustable Start Frequency in MHz. Select the up or
down arrows to the right of the field to adjust the Start Frequency by the Channel
Spacing defined in the instrument configuration.

End Freq: This displays the user adjustable End Frequency in MHz. Select the up or
down arrows to the right of the field to adjust the End Frequency by the Channel
Spacing defined in the instrument configuration.

The Channel Spacing is a user configurable field that can be
setup as shown in Section III:  Managing Configurations,
Chapter 7: 860 DSP and 860 DSPi Configuration Packages.

Compare Offset: This displays the user adjustable comparison offset. This field only
appears on the compare version of the report.

Markers

Mode: This displays the user adjustable Marker Mode. See the previous section on
instructions on how to set the Marker Mode.

Marker 1: This displays the frequency in MHz at the current location of Marker 1.

Level 1: This displays the level in dBmV of either the ingress trace from the SST
(Ingress Mode) or the local ingress trace taken by the 860 DSP or 860 DSPi (SSR
Mode), at the location of Marker 1.

Compare Delta 1: This displays the difference in level between the ingress trace from
the SST and the local ingress trace taken by the 860 DSP or 860 DSPi, or vice versa if
the mode is set to SSR Mode, at the current location of Marker 1.



WorkBench Software - Section II: Managing Devices and Data
II-90

Marker 2: This displays the frequency in MHz at the current location of Marker 2.

Level 2: This displays the level in dBmV of either the ingress trace from the SST
(Ingress Mode) or the local ingress trace taken by the 860 DSP or 860 DSPi (SSR
Mode), at the location of Marker 2.

Compare Delta 2: This displays the difference in level between the ingress trace from
the SST and the local ingress trace taken by the 860 DSP or 860 DSPi, or vice versa if
the mode is set to SSR Mode, at the current location of Marker 2.

Marker Delta: This displays the difference in level between Marker 1 and Marker 2.

SSR

Unit: The Unit ID (A - F) of the 860 DSP or 860 DSPi. This is used by the 9580 SST or
9581 SST to identify the 860 DSP or 860 DSPi.

HE Nominal: This displays the headend nominal level in dBmV of the 9580 SST or
9581 SST that the 860 DSP or 860 DSPi was communicating with.

Telemetry Level: This displays the signal strength of the telemetry signal received by
the 860 DSP or 860 DSPi.

Mode: This displays the mode (Normal, Fast, or Zoom) of the 9580 SST or 9581 SST
that the 860 DSP or 860 DSPi was communicating with.

Res Bandwidth: This displays the resolution bandwidth (375 kHz or 525 kHz) of the
9580 SST or 9581 SST that the 860 DSP or 860 DSPi was communicating with.

Detector: This displays the detector mode (Single, Peak, Avg, or Traffic) of the 9580
SST or 9581 SST that the 860 DSP or 860 DSPi was communicating with

DSP Result: Shows that the 860 DSP or 860 DSPi hardware worked successfully
during the test. This field can be ignored unless it displays a result other than OK. If the
field displays an error code, contact Trilithic for support.

For more information on how to adjust Markers in this data log
report, see Chapter 2: Analyzing Data, Marker Tools.
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Reverse Test (RSVP Mode)

The Reverse Test data log is a report in text and graphics formats that shows the results of the
RSVP test on the 860 DSP or 860 DSPi. In this test, the 860 DSP or 860 DSPi sends test
carriers to the 9580 SST or 9581 SST, which then responds with the level of the received signal.

• When in the Graph View, the measurement results will be displayed in the Reverse Test
report’s summary panel at the left side of the Data window.

• The coordinate values (Frequency, Level) of the mouse cursor will be displayed at the top
of the Data window above the graph.

Graph View

To view the Reverse Test

Graph, select the  button

from the toolbar at the top of
the Data window or press the
G key on your keyboard.

An example of the Reverse
Test Graph is to the right.

For more information on how to use the Zoom Tools that are
located in the toolbar at the top of this data log report, see
Chapter 2: Analyzing Data, Using the Zoom Tools.
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Text Data View

To view the Reverse Test

Text Data, select the 
button from the toolbar at
the top of the Data window
or press the T key on your
keyboard.

An example of the Reverse
Test Text Data is shown to
the right.
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Marker Mode Settings

For Reverse Sweep data logs you can select the Marker Mode by performing one of the
following actions:

• From the Reverse Test Report Summary
Pane, select the Marker Mode from the
Mode drop-down list as shown to the right.

• Use one of the keyboard shortcuts shown
in the table below.

Keyboard 
Shortcut 

Name Description 

S SSR Marker Mode 
This mode causes the markers to show the level 
of the local ingress trace taken by the 860 DSP 
or 860 DSPi. 

I Ingress Marker Mode 
This mode causes the markers to show the level 
of the ingress trace received from the 9580 SST 
or 9581 SST. 

 

For more information on how to adjust Markers in this data log
report, see Chapter 2: Analyzing Data, Marker Tools.
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Measurement Results

The fields displayed in the Forward Sweep report’s summary pane are as follows:

Graph

Ref Level: This displays the user adjustable Reference Level. Select the up or down
arrows to the right of the field to adjust the Reference Level in 1 dBmV increments.

Scale: This displays the user adjustable Vertical Scale. Select the up or down arrows
to the right of the field to chose the Vertical Scale to a value of 1, 2, 5, or
10 dB/Div.

Start Freq: This displays the user adjustable Start Frequency in MHz. Select the up or
down arrows to the right of the field to adjust the Start Frequency by the Channel
Spacing defined in the instrument configuration.

End Freq: This displays the user adjustable End Frequency in MHz. Select the up or
down arrows to the right of the field to adjust the End Frequency by the Channel
Spacing defined in the instrument configuration.

The Channel Spacing is a user configurable field that can be
setup as shown in Section III:  Managing Configurations,
Chapter 7: 860 DSP and 860 DSPi Configuration Packages.

Compare Offset: This displays the user adjustable comparison offset. This field only
appears on the compare version of the report.
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Markers

Mode: This displays the user adjustable Marker Mode. See the previous section on
instructions on how to set the Marker Mode.

Marker 1: This displays the frequency at the current location of Marker 1. If the mode is
set to RSVP, this field also displays the carrier number.

Level 1: This displays the level at the location of Marker 1. If this mode is set to RSVP,
this field shows if the carrier pointed to by Marker 1 passed or failed the RSVP test, as
well as the Carrier-to-Ingress Ratio.

Marker 2: This displays the frequency at the current location of Marker 2. If the mode is
set to RSVP, this field also displays the carrier number.

Level 2: This displays the level at the location of Marker 2. If this mode is set to RSVP,
this field shows if the carrier pointed to by Marker 2 passed or failed the RSVP test, as
well as the Carrier-to-Ingress Ratio.

Delta: This displays the difference in level between Level 1 and Level 2.

For more information on how to adjust Markers in this data log
report, see Chapter 2: Analyzing Data, Marker Tools.
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The Threshold, Max Tx Level, C/I Bandwidth, and Ingress
Sample Fields shown above are user configurable fields that
can be setup as shown in Section III:  Managing Configurations,
Chapter 7: 860 DSP and 860 DSPi Configuration Packages.

RSVP

Threshold: This displays the threshold in dB that the Carrier-to-Ingress Ratio (C/I)
must be greater than for the RSVP test to pass.

Max Tx Level: This displays the maximum level in dBmV that the 860 DSP or 860
DSPi is allowed to transmit at during the RSVP test.

HE Nominal: This displays the headend nominal level of the 9580 SST or 9581 SST
that the 860 DSP or 860 DSPi was communicating with.

C/I Bandwidth: This displays the noise bandwidth in MHz used by the 860 DSP or
860 DSPi to compute the Carrier-to-Ingress (C/I) Ratio.

Telemetry Level: This displays the strength of the telemetry signal received by the 860
DSP or 860 DSPi.

Mode: This displays the mode (Normal, Fast, or Zoom) of the 9580 SST or 9581 SST
that the 860 DSP or 860 DSPi was communicating with.

Ingress Samples: This displays the number of ingress samples taken by the 860 DSP
or 860 DSPi to compute the Carrier-to-Ingress (C/I) Ratio.
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Scan (Scan Mode)

The Scan data log is a report in text and graphics formats that shows the test results of a channel
plan scan performed by the 860 DSP or 860 DSPi.

• The channel numbers for which the test was conducted will be displayed in the channel
table at the bottom of the Data window.

• When in the Graph View, the measurement results will be displayed in the Scan report’s
summary panel at the left side of the Data window.

• The coordinate values (Frequency, Level) of the mouse cursor will be displayed at the top
of the Data window above the graph.

Graph View

To view the Scan

Graph, select the 
button from the
toolbar at the top of
the Data window or
press the G key on
your keyboard.

An example of the
Scan Graph in the
Bar Display is shown
to the right.

For more information on how to use the Zoom Tools that are
located in the toolbar at the top of this data log report, see
Chapter 2: Analyzing Data, Using the Zoom Tools.
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Graphic Display Settings

For Scan data logs you can choose from the following types of Graphic Display Settings; Bar,
Level, or Level/Fill.

To adjust the Graphic Display Settings, from
the Scan Report Summary Pane, select the
Display Setting from the Display drop-down
list as shown to the right.

Bar Display

Level Display
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Text Data View

To view the Scan Text Data,

select the  button from

the toolbar at the top of the
Data window or press the
T key on your keyboard.

An example of the Scan
Test Text Data is shown to
the right.

Level/Fill Display
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Marker Mode Settings

For Scan data logs you can select the Marker Mode by performing one of the following
actions:

• From the Scan Report Summary Pane,
select the Marker Mode from the Mode
drop-down list as shown to the right.

• Use one of the keyboard shortcuts
shown in the table below.

Keyboard 
Shortcut 

Name Description 

C Channel Marker 
Mode 

This mode locks the left marker on a video or 
digital carrier and locks the right marker to the 
audio carrier (if present) on the same channel. 

V 
Video/Digital Marker 
Mode 

This mode locks to the video carrier. Left and 
right markers may be moved independently. 

A Audio Marker Mode This mode locks to the audio carrier. Left and 
right markers may be moved independently. 

Alt + C Carrier Marker Mode 
This mode allows markers to lock to any type of 
carrier. Left and right markers may be moved 
independently. 

 

For more information on how to adjust Markers in this data log
report, see Chapter 2: Analyzing Data, Marker Tools.
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Measurement Results

The fields displayed in the Scan report’s summary pane are as follows:

Graph

Display: This displays the user adjustable Graphic Display Settings. See Graphic
Display Settings earlier in this section for instructions on how to set the Graphic
Display Settings.

Ref Level: This displays the user adjustable Reference Level. Select the up or down
arrows to the right of the field to adjust the Reference Level in 1 dBmV increments.

Scale: This displays the user adjustable Vertical Scale. Select the up or down arrows
to the right of the field to chose the Vertical Scale to a value of 1, 2, 5, or
10 dB/Div.

Start Freq: This displays the user adjustable Start Frequency in MHz. Select the up or
down arrows to the right of the field to adjust the Start Frequency by the Channel
Spacing defined in the instrument configuration.

End Freq: This displays the user adjustable End Frequency in MHz. Select the up or
down arrows to the right of the field to adjust the End Frequency by the Channel
Spacing defined in the instrument configuration.

The Channel Spacing is a user configurable field that can be
setup as shown in Section III:  Managing Configurations,
Chapter 7: 860 DSP and 860 DSPi Configuration Packages.
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Markers

Mode: This displays the user adjustable Marker Mode. See Marker Mode Settings
earlier in this section for instructions on how to set the Marker Mode.

Marker 1: This displays the frequency in MHz at the current location of Marker 1.

Level 1: This displays the level in dBmV at the location of Marker 1.

Marker 2: This displays the frequency in MHz at the current location of Marker 2.

Level 2: This displays the level in dBmV at the location of Marker 2.

Delta: This displays the difference in level between Level 1 and Level 2.

Scan

Total Power: This displays the sum of the calculated power in dBmV for each channel
in the scan.

Min/Max Video: This displays the minimum and maximum video signal strength in
dBmV measured in the scan.

Min/Max VA Delta: This displays the minimum and maximum video level to audio level
delta in dB measured in the scan.

Min/Max Digital: This displays the minimum and maximum digital signal strength in
dBmV measured in the scan.

Maximum Video Delta: This displays the difference between the minimum and
maximum video signal strengths in dB measured in the scan.

Max Adj Video Delta: This displays the maximum difference in level between two
adjacent video carriers in dB.

Limit Results: This displays the Pass or Fail results for tests that were conducted as
part of a Autotest Macro. This field is not displayed if the test was conducted outside of
an Autotest Macro.

DSP Results: Shows that the 860 DSP or 860 DSPi hardware worked successfully
during the test. This field can be ignored unless it displays a result other than OK. If the
field displays an error code, contact Trilithic for support.

For more information on how to adjust Markers in this data log
report, see Chapter 2: Analyzing Data, Marker Tools.
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Spectrum Analyzer (Spectrum Analyzer Mode)

The Spectrum Analyzer data log is a report in graphics format that shows the test results of a
either a Spectrum Scan or a Zero Scan performed by the 860 DSP or 860 DSPi.

• When in the Graph View, the measurement results will be displayed in the Spectrum
Analyzer report’s summary panel at the left side of the Data window.

• There are two modes of spectrum analysis: Spectrum (spectrum power vs. frequency
range) and Zero Span (level of a given frequency over time). The report mode is selected
on the 860 DSP or 860 DSPi at the time the test is performed.

• The coordinate values [ Spectrum Scan (Frequency, Level) or Zero Span (Time, Level)] of
the mouse cursor will be displayed at the top of the Data window above the graph.

Spectrum Scan View
 An example of the
Spectrum Scan is
shown to the right.

For more information on how to use the Zoom Tools that are
located in the toolbar at the top of this data log report, see
Chapter 2: Analyzing Data, Using the Zoom Tools.
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Zero Span View

An example of the Zero Span
spectrum analysis is shown to
the right.

Peak Value Markers

For Spectrum Analyzer data logs, select the  button to set the markers to the peak value
that is displayed.

For more information on how to use the Zoom Tools that are
located in the toolbar at the top of this data log report, see
Chapter 2: Analyzing Data, Using the Zoom Tools.

For more information on how to adjust Markers in this data log
report, see Chapter 2: Analyzing Data, Marker Tools.
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Measurement Results

The fields displayed in the Spectrum Analyzer report’s summary pane are as follows:

Graph

Ref Level: This displays the user adjustable Reference Level. Select the up or down
arrows to the right of the field to adjust the Reference Level in 1 dBmV increments.

Scale: This displays the user adjustable Vertical Scale. Select the up or down arrows
to the right of the field to chose the Vertical Scale to a value of 1, 2, 5, or
10 dB/Div.

Start

Freq: When in Spectrum Scan View, this displays the user adjustable Start
Frequency. Select the up or down arrows to the right of the field to adjust the Start
Frequency in 0.06 MHz increments.

Time: When in Zero Span View, this displays the user adjustable Start Time. Select
the up or down arrows to the right of the field to adjust the Start Time in 33333.33
μSec increments. This value is time zero, which by convention is time zero.

End

Freq: When in Spectrum Scan View, this displays the user adjustable End
Frequency. Select the up or down arrows to the right of the field to adjust the End
Frequency in 0.06 MHz increments.

Time: When in Zero Span View, this displays the user adjustable End Time. Select
the up or down arrows to the right of the field to adjust the End Time in 33333.33
μSec increments. This value is the end time of the Zero Span measurement relative
to the trigger point, which by convention is time zero.



WorkBench Software - Section II: Managing Devices and Data
II-106

Markers

Marker 1: This displays the frequency in MHz (Spectrum Scan View) or time in μμμμμsec
(Zero Span View) at the current location of Marker 1.

Level 1: This displays the level in dBmV at the location of Marker 1.

Marker 2: This displays the frequency in MHz (Spectrum Scan View) or time in μμμμμsec
(Zero Span View) at the current location of Marker 2.

Level 2: This displays the level in dBmV at the location of Marker 2.

Delta: This displays the difference in level between Level 1 and Level 2.

For more information on how to adjust Markers in this data log
report, see Chapter 2: Analyzing Data, Marker Tools.

Spectrum

Peak Level: This displays the peak level in dBmV of the spectrum analysis for the
given span.

Peak Frequency: This displays the frequency in MHz at which the peak level was
measured.

Center: This displays the center frequency in MHz of the spectrum analysis.

Span: This displays the span in MHz of the Spectrum Scan View or the text Zero-
Span in Zero Span View.

Res BW: This displays the resolution bandwidth in MHz of the spectrum analysis. This
determines how close together in frequency two signals can be and still be represented
individually on the spectrum display. The default for the 860 DSP or 860 DSPi is
300 kHz. Narrow resolutions are most useful for tests run at narrow frequency spans,
such as hunting for spurious or reverse ingress, particularly at frequencies near RF
carriers.
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Detector: This displays the detector mode used by the 860 DSP or 860 DSPi for the
displayed measurement. The field will display Norm, Max Hold, Min Hold, Avg 2,
Avg 4,  Avg 8, Avg 16, Avg 32, Avg 64, or Avg 128 based on the settings of the
device. Averaging smooths out noise “jitter” on the display averaging a succession of
spectrum scans (similar to a video filter). Higher averages produce the smoothest
display but the least sensitivity to impulse noise. Lower averages allow the peaks of
signals and impulses to be measured more accurately but give the noisiest displays.
This field is only displayed in the Spectrum Scan View.

Trigger Edge: This displays whether there is an Auto, Positive, or Negative Trigger.
This field is only displayed in the Zero Span View.

Trigger Level: This displays the trigger level in dBmV that was selected on the
860 DSP or 860 DSPi at the time the test was performed. This field is only displayed in
the Zero Span View.

Pre-Trigger: This displays the percentage of time to display before the incoming signal
triggers the 860 DSP or 860 DSPi based on the Trigger Level and Trigger Edge.
This field is only displayed in the Zero Span View.

Limit Results: This displays the Pass or Fail results for tests that were conducted as
part of a Autotest Macro. This field is not displayed if the test was conducted outside of
an Autotest Macro.

DSP Result: Shows that the 860 DSP or 860 DSPi hardware worked successfully
during the test. This field can be ignored unless it displays a result other than OK. If the
field displays an error code, contact Trilithic for support.
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Throughput (Thru Put Mode)

The Throughput data log is a text only report that shows the
transfer rate capabilities of the network connection.

An example of the Throughput Text Data is shown to the right.

Measurement Results

The fields displayed in the Throughput report’s summary pane are as follows:

Throughput

Server IP: This displays the IP address of the server to retrieve or send files to.

Upstream Rate: This displays the average number of kilobits per second achieved
when sending the last file.

Downstream Rate: This displays the average number of kilobits per second achieved
when reading the last file.

Limit Results: This displays the Pass or Fail results for tests that were conducted as
part of a Autotest Macro. This field is not displayed if the test was conducted outside of
an Autotest Macro.

DSP Result: Shows that the 860 DSP or 860 DSPi hardware worked successfully
during the test. This field can be ignored unless it displays a result other than OK. If the
field displays an error code, contact Trilithic for support.

In order to use the Throughput mode with the ACTS software,
the latest version of ACTS must be installed.
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Upstream Time: This displays the time in Msec it takes to send the file to the server.

Downstream Parameters

Downstream File: This displays the user-supplied file name to read from the server.

Downstream File Size: This displays the size in Bytes of the file read. The file size
can be from 10 kB to 130 MB.

Downstream Time: This displays the time in Msec it takes to read the file from the
server.

Upstream Parameters

Upstream File: This displays the fixed name of a 1 MB file to send from the meter.

Upstream File Size: This displays the file size in Bytes of the file to send.

The upstream throughput calculations are based on this file
being 1 MB. If you use a file with a different file size, the
calculations will produce incorrect results.
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Tilt (Tilt Mode)

The Tilt data log is a report in text and graphic formats that shows the amplitudes of a preselected
group of carriers. It also shows the difference in amplitude between two selectable channels in the
group.

• The channel numbers for which the test was conducted will be displayed in the channel
table at the bottom of the Data window.

• When in the Graph View, the measurement results will be displayed in the Tilt report’s
summary panel at the left side of the Data window.

• The coordinate values (Frequency, Carrier Level) of the mouse cursor will be displayed at
the top of the Data window above the graph.

Graph View

To view the Tilt Graph, select

the  button from the toolbar
at the top of the Data window
or press the G key on your
keyboard.

An example of the Tilt Graph is
shown to the right.

For more information on how to use the Zoom Tools that are
located in the toolbar at the top of this data log report, see
Chapter 2: Analyzing Data, Using the Zoom Tools.
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Graphic Display Settings

For Tilt data logs you can choose from the following types of Graphic Display Settings; Bar,
Level, or Level/Fill.

To adjust the Graphic Display Settings, from the
Tilt Report Summary Pane, select the Display
Setting from the Display drop-down list as
shown to the right.

Bar Display
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Level/Fill Display

Level Display
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Text Data View

To view the Tilt Text

Data, select the 
button from the toolbar at
the top of the Data
window or press the T
key on your keyboard.

An example of the Tilt
Text Data is shown to the
right.

Measurement Results

The fields displayed in the Tilt report’s summary pane are as follows:

Graph

Display: This displays the user adjustable Graphic Display Settings. See the previous
section on instructions on how to set the Graphic Display Settings.

Ref Level: This displays the user adjustable Reference Level. Select the up or down
arrows to the right of the field to adjust the Reference Level in 1 dBmV increments.

Scale: This displays the user adjustable Vertical Scale. Select the up or down arrows
to the right of the field to chose the Vertical Scale to a value of 1, 2, 5, or
10 dB/Div.

Start Freq: This displays the user adjustable Start Frequency in MHz. Select the up or
down arrows to the right of the field to adjust the Start Frequency to the next/previous Tilt
Channel as defined in the Channel Plan.

End Freq: This displays the user adjustable End Frequency in MHz. Select the up or
down arrows to the right of the field to adjust the End Frequency to the next/previous Tilt
Channel as defined in the Channel Plan.
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The Tilt Channels are a user configurable and can be selected
as shown in Section III:  Managing Configurations, Chapter 2:
Channel Plans.

Markers

Marker 1: This displays the frequency in MHz at the current location of Marker 1.

Level 1: This displays the level in dBmV at the location of Marker 1.

Marker 2: This displays the frequency in MHz at the current location of Marker 2.

Level 2: This displays the level in dBmV at the location of Marker 2.

Delta: This displays the difference in level between Level 1 and Level 2.

Tilt

Tilt: This displays the tilt level measurement in dB.

High Channel/Level: This displays the highest channel in the channel plan that is
selected for tilt measurement and the corresponding level measurement in dBmV.

Low Channel/Level: This displays the lowest channel in the channel plan that is
selected for tilt measurement and the corresponding level measurement in dBmV.

Limit Results: This displays the Pass or Fail results for tests that were conducted as
part of a Autotest Macro. This field is not displayed if the test was conducted outside of
an Autotest Macro.

DSP Result: Shows that the 860 DSP or 860 DSPi hardware worked successfully
during the test. This field can be ignored unless it displays a result other than OK. If the
field displays an error code, contact Trilithic for support.

For more information on how to adjust Markers in this data log
report, see Chapter 2: Analyzing Data, Marker Tools.
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TraceRoute (Trace Rt Mode)

The Trace Route data log is a report in text format that shows the
results of an internet route trace.

An example of the TraceRoute Text Data is shown to the right.

Measurement Results

The fields displayed in the Trace Route report’s summary pane
are as follows:

Trace Route

Host Name: This displays the host name of the
destination site to route the test to.

IP Address: This displays the IP address of the
destination site to route the test to.

Hops: This displays the number of sites that the test was
routed through to reach the destination site.

Max Response: This displays the maximum response time in msec of all of the sites
that the test was routed through.

Avg Response: This displays the average response time in msec of all of the sites
that the test was routed through.
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Hop 1 through #

Host Name: This displays the host name of each site that the test was routed through.

IP Address: This displays the IP address of each site that the test was routed through.

Response Time: This displays the response time in msec of the site that the test was
routed through.

The information shown above will be listed for each site that the
test was routed through.
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TraffiControl (TraffiControl Mode)

The TraffiControl data log is a report in text and graphic formats that shows the ingress that is
present underneath an upstream cable modem channel.

• When in the Graph View, the measurement results will be displayed in the TraffiControl
report’s summary panel at the left side of the Data window.

• The coordinate values (Frequency, Carrier Level) of the mouse cursor will be displayed at
the top of the Data window above the graph.

Graph View

To view the TraffiControl Graph,

select the  button from the
toolbar at the top of the Data
window.

An example of the TraffiControl
Graph is shown to the right.

The TraffiControl graphs shows
three traces as follows:

Traffic (Green): This trace
shows the last captured
signal containing traffic.

Live Noise (Gray): This
trace shows the last
captured signal without
traffic.

Peak Noise (Blue): This
trace shows a persistent
peak hold of the noise
trace.

For more information on how to use the Zoom Tools that are
located in the toolbar at the top of this data log report, see
Chapter 2: Analyzing Data, Using the Zoom Tools.
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Text Data View

To view the TraffiControl Text

Data, select the  button from
the toolbar at the top of the
Data window.

An example of the TraffiControl
Text Data is shown to the right.

Measurement Results

The fields displayed in the
TraffiControl report’s summary
pane are as follows:

Graph (Graph View
Only)

Ref Level: This
displays the user
adjustable Reference
Level. Select the up or
down arrows to the right
of the field to adjust the Reference Level in 1 dBmV increments.

Scale: This displays the user adjustable Vertical Scale. Select the up or down arrows
to the right of the field to chose the Vertical Scale to a value of 1, 2, 5, or
10 dB/Div.

Markers

Marker: This displays the frequency in MHz at the location of the marker.

For more information on how to adjust Markers in this data log
report, see Chapter 2: Analyzing Data, Marker Tools.
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Channel

Center: This displays the center frequency in MHz of the upstream cable modem
channel that was selected on the 860 DSP or 860 DSPi at the time the test was
performed.

Bandwidth: This displays the bandwidth in MHz of the of the upstream cable modem
channel. This field will display 0.2, 0.4, 0.8, 1.6, 3.2, or 6.4 MHz based on the settings
of the device.

Traffic Control

Traffic: This displays the level in dBmV of the upstream cable modem traffic. This
value corresponds to the green horizontal line shown in the graph view.

Noise: This displays the level in dBmV of the peak noise trace. This value
corresponds to the gray horizontal line shown in the graph view.

Delta: This displays the difference in dB between the total power of traffic and the total
power for noise in the last measurement.

Trigger: This displays the trigger level in dBmV that was selected on the 860 DSP or
860 DSPi at the time that the test was performed. This value corresponds to the yellow
horizontal line shown in the graph view.

DSP Result: Shows that the 860 DSP or 860 DSPi hardware worked successfully
during the test. This field can be ignored unless it displays a result other than OK. If the
field displays an error code, contact Trilithic for support.
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VITS  (VITS Mode)

The VITS data log is a report in graphics format that shows the results of a Vertical Interval Test
Signal (VITS) Channel.

• The channel number for which the test was conducted will be displayed in the channel table
at the bottom of the Data window.

• When in the Graph View, the measurement results will be displayed in the VITS report’s
summary panel at the left side of the Data window.

• The coordinate values (IRE, IREl) of the mouse cursor will be displayed at the top of the
Data window above the graph.

Graph View

Line Viewer Graph View

The Line Viewer
Graph View will
be displayed as
shown to the right
when the
measurement
mode is set to
Line Viewer on
the device.
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Differential Gain/Phase Graph View

The Differential
Gain/Phase
Graph View will
be displayed as
shown to the right
when the
measurement
mode is set to
Diff Gain/Phase
on the device.

Chroma Delay Graph View

The Chroma
Delay Graph
View will be
displayed as
shown to the right
when the
measurement
mode is set to
Chroma Delay
on the device.
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Measurement Results

The fields displayed in the VITS report’s summary pane are as follows:

Graph

Ref Level: This displays the user adjustable Reference Level. Select the up or down
arrows to the right of the field to adjust the Reference Level in 1 IRE or 1 dB (In Channel
Response) increments.

VITS

Line: This displays the line that the test was performed on. The line is selected on the
860 DSP or 860 DSPi at the time the test is performed.

Field: This displays whether the field is Even or Odd. The field is selected on the 860
DSP or 860 DSPi at the time the test is performed.

In Channel Response Graph View

The In Channel
Response Graph View will
be displayed as shown to
the right when the
measurement mode is set
to In Channel Response
on the device.
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Averaging: This displays the detector mode used by the 860 DSP or 860 DSPi for the
displayed measurement. The field will display Avg 16, Avg 32, Avg 64, Avg 128, or
AVG 256 based on the settings of the device. Averaging smooths out noise “jitter” on
the display averaging a succession of spectrum scans (similar to a video filter). Higher
averages produce the smoothest display but the least sensitivity to impulse noise.
Lower averages allow the peaks of signals and impulses to be measured more
accurately but give the noisiest displays. This field is not adjustable and is always set to
Avg 32 in the Line Viewer Graph View.

Num Averages: This displays the actual number of times the average was taken. This
field does not appear in the Line Viewer Graph View.

Mode: This displays the measurement mode used by the 860 DSP or 860 DSPi for the
displayed measurement. The field will display Line Viewer, Diff Gain/Phase, Chroma
Delay, or In Channel Response based on the settings of the device.

Signal: This displays the signal type used by the 860 DSP or 860 DSPi for the
displayed measurement. This will display the following based on the mode that is set in
the device;

Diff Gain/Phase: FCC or NTC7.

Chroma Delay: FCC or NTC7.

In Channel Response: Multiburst or GhostCancelRef.

This field does not appear in the Line Viewer Graph View.

Last Step: This field is not adjustable and always displays Skipped for the Diff Gain/
Phase Graph View.

Gain: This displays the differential gain measurement for the Diff Gain/Phase Graph
View.

Phase: This displays the differential phase measurement for the Diff Gain/Phase
Graph View.

Delay: This displays the chroma response measurement for the Chroma Delay Graph
View.

Response: This displays the in channel response measurement for the In Channel
Response Graph View.

DSP Results: Shows that the 860 DSP, DSPi, or DSPr hardware worked successfully
during the test. This field can be ignored unless it displays a result other than OK. If the
field displays an error code, contact Trilithic for support.
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VoIP (VoIP Mode)

The VoIP data log is a report in text format that shows test results for call and connectivity quality.

Measurement Results

This first screen of the VoIP report is displayed as
shown to the right.

The fields displayed in the first page of the VoIP report
are as follows:

VoIP

Server IP: This displays the server’s IP
Address.

Remote Receive Port: This displays the port
on which the remote data was received.

Local Receive Port: This displays the port on
which the local data was received.

Call Length: This displays the length of the call
in seconds.

Packet Count: This displays the number of
packets that should have been sent.

Packets Sent: This displays the number of
packets that were actually sent.

Packets Received: This displays the number of
packets received.

Packets Size: This displays the size of the
packets.

CODEC Type: This displays the CODEC that
was used during the test.

CODEC Delay: This displays the delay for the
CODEC that was used during the test.

Test Result: This displays the Pass or Fail results for test.
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Remote Results (Upstream Packet Data)

This section displays information about the packets sent from the field to the head end.

Latency: This displays the maximum delay in msec between packets.

Latency Result: This displays the Pass or Fail results for test.

Jitter: This displays the largest delay in msec between adjacent packets.

Jitter Result: This displays the Pass or Fail results for test.

MOS: This displays the Mean Opinion Score (the quality of the phone call scale).

MOS Result: This displays the Pass or Fail results for test.

Local Results (Downstream Packet Data)

This section displays information about the packets sent from the head end to the field.

Latency: This displays the maximum delay in msec between packets.

Latency Result: This displays the Pass or Fail results for test.

Jitter: This displays the largest delay in msec between adjacent packets.

Jitter Result: This displays the Pass or Fail results for test.

MOS: This displays the Mean Opinion Score (the quality of the phone call scale).

MOS Result: This displays the Pass or Fail results for test.
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This second screen of the VoIP report is displayed as
shown to the right.

The fields displayed in the second page of the VoIP
report’s summary pane are as follows:

Remote Details (Upstream Packet Data)

Packets Received: This displays the number of
packets received.

Packets Discarded: This displays the number
of packets discarded because jitter exceeded
the jitter buffer length.

Packets Lost: This displays the number of
packets lost.

Packets Out Of Order: This displays the
number of packets received out of order.

Loss Periods: This is the time periods where
no packets are received.

Loss Periods Min: The minimum time for a
loss period.

Loss Periods Max: The maximum time for a
loss period.

Loss Periods Average: The average time
lost for a period.

Loss Periods Number: The number of loss
periods.

Latency Min: This displays the minimum latency in msec for packets from the field to
the head end.

Latency Max: This displays the maximum latency in msec for packets sent from the
field to the head end.



WorkBench Software - Section II: Managing Devices and Data
II-127

Latency Average: This displays the average latency in msec for packets sent from the
field to the head end.

Jitter Min: This displays the minimum delay in msec between adjacent packages.

Jitter Max: This displays the maximum delay in msec between adjacent packages.

Jitter Average: This displays the average delay in msec between adjacent packets.

R: This displays the R value computed according to the ITU-T G.107 E model.

MOS: This displays the Mean Opinion Score when computed according to the ITU-T
G.107 E model.

Remote Details (Downstream Packet Data)

Packets Received: This displays the number of packets received.

Packets Discarded: This displays the number of packets discarded because jitter
exceeded the jitter buffer length.

Packets Lost: This displays the number of packets lost.

Packets Out Of Order: This displays the number of packets received out of order.

Loss Periods: This is the time periods where no packets are received.

Loss Periods Min: The minimum time for a loss period.

Loss Periods Max: The maximum time for a loss period.

Loss Periods Average: The average time lost for a period.

Loss Periods Number: The number of loss periods.

Latency Max: This displays the maximum latency in msec for packets sent from the
head end to the field.

Latency Average: This displays the average latency in msec for packets sent from
the head end to the field.

Jitter Min: This displays the minimum delay in msec between adjacent packages.

Jitter Max: This displays the maximum delay in msec between adjacent packages.

Jitter Average: This displays the average delay in msec between adjacent packets.

R: This displays the R value computed according to the ITU-T G.107 E model.

MOS: This displays the Mean Opinion Score when computed according to the ITU-T
G.107 E model.
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Web Log

The Web Log data log is a report in text format that
shows the results of a web server based test.

An example of the Web Log Text Data is shown to
the right.

Measurement Results

The fields displayed in the Web Log report are
as follows:

Web Log

Name: This displays the type or name of
the web server based test.

Company: This displays the name of the
company that created and/or performed
the test.

Description: This displays a description
of the test being preformed.

Status: This displays the overall results
of the test.

Test # Results

Header: This displays the test definition
or other identifier.

Value: This displays the resultant data in
msec of the test.

Pass/Fail: This displays the Pass or Fail results of the test.

Comment: This displays any details to describe the test or the results of the test.
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Wi-Fi (WiFi Mode)

The Wi-Fi data log is a report in text format that shows the results
of a
Wi-Fi access point survey.

An example of the Wi-Fi Text Data is shown to the right.

Measurement Results

The fields displayed in the Wi-Fi report are as follows:

Wi-Fi

Access Points: This displays the number of Wi-Fi
access points that are available.

Connected To: This displays the name of the Wi-Fi
access point that was connected at the time of the test.

Access Point #

SSID: This displays the Service Set Identifier (SSID) value of the Wi-Fi access point.

MAC Address: This displays the MAC address of the Wi-Fi access point.

Network Type: This displays the type of network infrastructure associated with the Wi-
Fi access point.

Channel: This displays the radio channel of the Wi-Fi access point.

Security: This displays the type of security associated with the Wi-Fi access point.

Signal Level: This displays the signal level in dBm of the Wi-Fi access point.

Noise Level: This displays the noise level in dBm of the Wi-Fi access point.
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Section III: Configuration Files

WorkBench Software
(and WorkBench Lite Software)

for the 860 DSP, 860 DSPi, 860 DSPh, 860 DSPr, and 8300 FST
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1. Introduction
Chapter 1

Overview

WorkBench can be used to manage the configuration parameters of the following devices:

• 860 DSP

• 860 DSPi

• 860 DSPh

• 860 DSPr

• 8300 FST

These configuration parameters control multiple tuning and measurement attributes.  WorkBench
allows for custom configuration files to be created, edited, and stored for loading to analyzers for
accurate, repeatable measurements in the field.
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2. Channel Plans
Chapter 2

Overview

This chapter shows you how to create and maintain channel plans.

A channel plan is a list of channels, frequencies, and other parameters. You will likely have a
variety of channel plans for your 860 DSP or 860 DSPi, depending on the cable packages and
options offered to your users.

You can create a new channel plan or create a channel plan from an existing channel plan.

Creating a Channel Plan

To create a channel plan, perform the following steps:

1. Perform one of the following steps to create a new channel plan:

From the File menu, hover over New, and then select Channel Plan.

OR

From the Toolbar click on the  button and then select Channel Plan.

OR

From the  tab,  right-click on Channel Plans, and then select New Channel
Plan.

File Menu Toolbar Global Tab

2. The New Channel Plan window will appear.

3. Enter the Name of the channel plan. This can be up to 9 alphanumeric characters.

4. Enter a Description of the channel plan. This can be up to 254 alphanumeric characters.
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5. Perform one of the following steps to select the type of channel plan to create:

Create a new empty channel plan - Select this option to create a new channel plan
with no information in it.

OR

Start with an existing template or channel plan - Select this option to create a new
channel plan based on an existing channel plan. You must also select the name of the
channel plan that you wish to replicate and revise from the list at the bottom of the New
Channel Plan window.

Empty Channel Plan Existing Channel Plan
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6. When you have completed the steps above, select the  button to create the

channel plan, or select the  button to exit without creating a new channel plan.

7. The new channel plan will be displayed.

In order to see the entire channel plan, you can hide the

Navigator window by selecting the  button from the toolbar.

For more information on setting up the channels in the channel
plan, see the following section.

After making changes to a channel plan, you must select the 
button from the toolbar or Save from the File menu before
closing the channel plan.  Otherwise, if you try to close the
channel plan before saving, WorkBench will prompt you to save
the channel plan.
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Channel Plan Settings

The following types of channels and tests can be included in a Channel Plan:

Type Detail Test Types 

(Normal) 

Sync Suppressed 

Sync Suppressed – Drop Field 

Sync Suppressed – Drop Vertical 

Custom 
NTSC 
PAL B, D, G, H, I, K, M & N 
SECAM B, D, G, H, I, K & L 
Single 

Split Sync – No Suppression 

Tilt 
Carrier-to-Noise 
Hum 
Depth of 
Modulation 
FM Deviation 

Annex A QPSK (USER) 

Annex A 16 QAM (USER) 

Annex A 32 QAM (USER) 

Annex A 64 QAM (USER) 

Annex A 128 QAM (USER) 

Annex A 256 QAM (USER) 

Annex A QPSK (USER) 

Annex C 64 QAM (USER) 

Annex B 64 QAM (DOCSIS) 

Annex B 256 QAM (DOCSIS) 

Annex A 64 QAM (EURODOCSIS) 

Annex A 256 QAM (EURODOCSIS) 

Annex D 8 VSB (ATSC) 

Annex A 16 QAM (1.740 msps) 

Annex A 16 QAM (3.480 msps) 

Annex A 16 QAM (6.840 msps) 

Annex A 64 QAM (1.740 msps) 

Annex A 64 QAM (3.420 msps) 

Annex A 64 QAM (6.890 msps) 

Annex A 64 QAM (6.925 msps) 

Digital 

Annex A 256 QAM (6.925 msps) 

Tilt 
MER 
BER 
Pulse 
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Channel Settings

You can modify the following fields for each channel in a channel plan:

Vid/Ctr: Enter the carrier frequency of the channel in this field.

Type: Enter the type of channel in this field by performing one of the following steps:

Select the channel you wish to modify and from the drop-down list select the channel
type.

OR

Right-click on the channel you wish to modify, hover over Configuration, and then
select the type from the list that appears.

Drop-Down List Right-Click Menu

When digital channels are selected in the channel plan, the
carrier frequency will default to the center frequency. Also, the
label for the Vid/Ctr field will change to Video.
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Detail: Enter the modulation details of the channel in this field by performing one of the
following steps:

Select the channel you wish to modify and from the drop-down list select the modulation
details.

OR

Right-click on the channel you wish to modify, hover over Details, and then select the
modulation details from the list that appears.

Drop-Down List Right-Click Menu
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SAP/SR: Enter the auxiliary audio frequency of the channel in this field. If Type is set to
Single, this field is disabled.

Channel: Enter the channel lineup number in this field.

Label: Enter the channel name in this field. This field allows upper and lower case
alphanumeric characters as well as a variety of non-alphanumeric characters.

You can enter another channel in the channel plan by pressing
the Tab key on your keyboard or by clicking the first field in the
next line.

Aud/BW: Enter the audio frequency in this field by performing one of the following steps:

If Type is set to any analog channel type, the audio channel frequency is based on the
modulation details of the channel and cannot be changed.

OR

If Type is set to Digital, enter a bandwidth between 2.00 MHz and 8.00 MHz in this
field.

OR

If Type is set to Custom, enter a bandwidth between 5.00 MHz and 1000.00 MHz in
this field.

OR

If Type is set to Single, this field is disabled.

When digital channels are selected in the channel plan, the
carrier frequency will default to the center frequency. Also, the
label for the Aud/BW field will change to BW.
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Test Settings

Enable any of the tests shown below by performing one of the following steps:

Select the check-box in the corresponding channel plan column.

OR

Right-click on the channel you wish to modify, and then select the type of test to enable from
the list that appears.

The following test are available in the channel plan:

Tilt: Select this field to include the selected channel in a system tilt measurement.

C/N: Select this field to enable Carrier-to-Noise measurements for analog channels.

Hum: Select this field to enable Hum measurements for analog channels.

Mod: Select this field to enable Depth of Modulation measurements for analog channels.

MER: Select this field to enable MER measurements for digital channels.

FM Dev: Select this field to enable FM Deviation measurements for analog channels.

BER: Select this field to enable BER measurements for digital channels.

Pulse: Select this field to enable an 8300 FST pulse channel for the digital channel.

Disabling Channels

To disable a channel in the channel plan, select the corresponding check-box in the Disable
column.

After making changes to a channel plan, you must select the 
button from the toolbar or Save from the File menu before
closing the channel plan. Otherwise, if you try to close the
channel plan before saving, WorkBench will prompt you to save
the channel plan.
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Opening and Closing Channel Plans

You can use the WorkBench software to open any of the included channel plan templates or any
channel plans that you have created. To open any channel plan, perform one of the following
actions:

From the  tab, right-click on the channel plan(s) to open, and then select Open.

OR

From the  tab, right-click on the channel plan(s) to open, and then select Open.

Global Tab Devices Tab

To close any channel plan that is open, perform one of the following
actions:

From the File menu, select Close.

OR

Select  the gray “X” in the upper right corner of the Data window.
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Transferring Channel Plans to Devices

You can use the WorkBench software to transfer any channel plan templates or channel plan to a
connected device. To transfer any channel plan, perform the following actions:

1. From the  tab, right-click on the desired
channel plan(s) to transfer, and then select Transfer to
Device.

If only one device is connected, the channel plan will
automatically be transferred to the device without any other
user interaction.

2. If more than one device is connected the Transfer
Channel Plans window will appear.

3. Select the channel plans you wish to send.

4. Select the device(s) to which you wish to send the
selected channel plans.

5. Select the  button to transfer the channel

plans or select the  button to exit without
transferring.
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Saving Channel Plans to a Local File

You can save channel plans to your local drive to allow you to move data from one WorkBench
software installation to other WorkBench software installations within your company.

Perform the following steps to save a local copy of any of the channel plans described earlier in
this chapter:

1. Perform one of the following steps to select the channel plan(s) to save:

After opening a channel plan, from the File menu hover over Export, and then select
860 DSP Channel Plan File.

OR

After connecting to a device, from the  tab, right-click on the desired channel
plan(s) to save, and then select Save Local File As.

OR

From the  tab, right-click on the desired channel plan(s) to save, and then
select Export to Local Disk.

Devices Tab Global Tab

To select more than one channel plan at once for batch
processing, select the first channel plan that you would like to
save, and then hold the CTRL key on your keyboard while
using your mouse to select the other channel plans.

File Menu
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2. Perform one of the following steps to save the local
channel plan file(s):

If you selected only one file to save, the Save
window will appear. From this window choose the
location and name of the channel plan to save and

then select the  button.

OR

If you selected more than one file to save, the
Browse For Folder window will appear. From this
window choose the location to save the channel

plans to and then select the  button.
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Exporting Channel Plans to a Text File

You can export channel plans to text files for use outside of WorkBench.

Perform the following steps to export any of the channel plans described earlier in this chapter:

1. Open the channel plan that you wish to export.

2. From the File menu hover over Export, and then select either of the following options
Comma-Delimited Text File or Tab-Delimited Text File.

3. The Save As window will appear. From this window
choose the location and name of the channel plan to

save and then select the  button.

Comma-Delimited Tab-Delimited
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Importing Channel Plans from a Local File

You can import channel plans to allow you to move data from one WorkBench software installation
to other WorkBench software installations within your company.

Perform the following steps to import any of the channel plans described earlier in this chapter:

1. From the File menu hover over Import, and then select Channel Plans.

2. The Open window will appear. From this window
choose which channel plan(s) to import and then select

the  button.



WorkBench Software - Section III: Configuration Files
III-19

Deleting Channel Plans

You can delete channel plans that are no longer needed.

Perform the following steps to delete any of the channel plans described earlier in this chapter:

1. Perform one of the following steps to select the channel plan(s) to delete:

From the  tab, right-click on the desired channel plan(s) to delete, and then
select Delete.

OR

From the  tab, right-click on the desired channel plan(s) to delete, and then
select Delete.

Devices Tab Global Tab

To select more than one channel plan at once for batch
processing, select the first channel plan that you would like to
delete, and then hold the CTRL key on your keyboard while
using your mouse to select the other channel plans.
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2. The Confirm Delete window will appear based on how you choose to delete the channel
plan(s) as shown below:

• Devices Tab - Single File Selected

• Devices Tab - Multiple Files Selected

• Global Tab - Single File Selected

• Global Tab - Multiple Files Selected

3. From this window you will confirm whether to delete the channel plan(s) by selecting the
 button, or you can exit without deleting the channel plan(s) by selecting the

 button.

Be very careful when deleting files. Once a file has been deleted
the file cannot be recovered.
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Channel Plan Properties

After a channel plan has been opened, the Channel Plan

Properties can be displayed by selecting the  button from

the toolbar at the top of the Data window or from the 
tab, right-click the Location, and then select Properties. An
example of the Channel Plan Properties window is shown to
the right.

The fields displayed in the Channel Plan Properties window
are as follows:

Name: Displays the file name of the channel plan.

Template: This check-box will be checked when opening
a template file

Description: Displays the file name, device name, and IP
address of the device from which the channel plan was
retrieved or the name of the channel plan that was
imported.

Last Modified: Displays the date that the channel plan
was last modified.

Modified By: Displays the name of the user that last
modified the channel plan.

Channels: Displays the total number of channels in the
channel plan.

Analog Channels: Displays the total number of analog
channels in the channel plan.

Digital Channels: Displays the total number of digital
channels in the channel plan.

Tilt Channels: Displays the total number of tilt test
channels in the channel plan.
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C/N Channels: Displays the total number of C/N test channels in the channel plan.

Hum Channels: Displays the total number of Hum test channels in the channel plan.

Mod Channels: Displays the total number of Mod test channels in the channel plan.

MER Channels: Displays the total number of MER test channels in the channel plan.

FM Dev Channels: Displays the total number of FM Dev test channels in the channel plan.

BER Channels: Displays the total number of BER test channels in the channel plan.

Pulse Channels: Displays the total number of 8300 FST Pulse channels in the channel plan.

Disabled Channels: Displays the total number of disabled channels in the channel plan.
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Printing Without Preview
To print any channel plan that is open without a preview,
perform the following steps:

1. Press the Ctrl+P keys on your keyboard or from
the File menu, select Print.

Printing Channel Plans

2. The Print window will appear.

3. If you wish to change any printer settings do so
at this point.

4. Once you are satisfied with you printer

settings, select the  button to print the

document or select the  button to exit
without printing.

Before printing you may want to setup your printer by first
selecting Printer Setup... from the File Menu. WorkBench will
use the settings of your default Windows printer if you choose
to skip this step.
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Printing With Preview

To print any channel plan that is open with a
preview, perform the following steps:

1. From the File menu, select Print
Preview.

2. A new print preview window will appear in
the Data window. You can then use the
buttons at the top of the print preview
screen as follows:

 - Use this button to print the
document.

 or  - Use these
buttons to scroll through multiple page
channel plans.

 or  - Use these buttons
to change the view from one page to two
pages.

 or  - Use these buttons
to zoom in and out on the document.

 - Use this button to close without
printing.

3. After you have selected the  button,
the Print window will appear.

4. If you wish to change any printer settings do so
at this point.

5. Once you are satisfied with you printer settings,

select the  button to print the document

or select the  button to exit without
printing.
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3. Locations
Chapter 3

Overview

This chapter shows you how to create and maintain locations.

A location identifies a service area and the specific feeder, power, and tolerances. You will likely
have a variety of locations for your 860 DSP or 860 DSPi, depending on the areas being served
and the equipment options that serve them.

You can create a new location or create a location from an existing location.

Creating a Location

To create a location, perform the following steps:

1. Perform one of the following steps to create a new location:

From the File menu, hover over New, and then select Location.

OR

From the Toolbar click on the  button and then select Location.

OR

From the  tab,  right-click on Locations, and then select New Location.

File Menu Toolbar Global Tab

2. The New Location window will appear.

3. Enter the Name of the location. This can be up to 9 alphanumeric characters.

4. Enter a Description of the location. This can be up to 254 alphanumeric characters.
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5. Perform one of the following steps to select the type of location to create:

Create a new empty location - Select this option to create a new location starting
with no information in it.

OR

Start with an existing location - Select this option to create a new location by
modifying the settings of an existing location. You must also select the name of the
location that you wish to replicate and revise from the list at the bottom of the New
Location window.

Empty Location Existing Location
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6. When you have completed the steps above, select the  button to create the

location, or select the  button to exit without creating a new location.

7. The new location will be displayed.

Location Settings

The following types of location information can be included in a location:

Location Settings

You can modify the following fields to describe the location:

Type: Select a location type of “Headend”, “Trunk Amp”, “Line Extender”, “Fiber Node”,
“Field Test”, or “Other” from the drop-down list.

Area: Enter the type of area that describes the location.

Amplifier ID: Enter the amplifier ID of the location.

For more information on setting up the location, see the
following section.

After making changes to a location, you must select the 
button from the toolbar or Save from the File menu before
closing the location. Otherwise, if you try to close the location
before saving, WorkBench will prompt you to save the location.
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Configuration Settings

You can modify the following fields to configure the settings of the location:

Power: Enter a power type of In, Out, or Thru at this location.

Voltage: Enter a voltage level of Low, Medium, or High at this location.

Feeder: Enter the feeder number (1 - 9) at this location using the up or down arrows to the
right of this field.

Reverse Pad: Enter the level in dB (0 - 99) of the Reverse Pad at this location using the
up or down arrows to the right of this field.

Reverse EQ: Enter the level in dB (0 - 99) of the Reverse EQ at this location using the up
or down arrows to the right of this field.

Forward Pad: Enter the level in dB (0 - 99) of the Forward Pad at this location using the
up or down arrows to the right of this field.

Forward EQ: Enter the level in dB (0 - 99) of the Forward EQ at this location using the up
or down arrows to the right of this field.

Trunk Termination: Select this check-box to indicate that this location is at a trunk
termination.

After making changes to a location, you must select the 
button from the toolbar or Save from the File menu before
closing the location. Otherwise, if you try to close the location
before saving, WorkBench will prompt you to save the location.
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Opening and Closing Locations

You can use the WorkBench software to open any of the included location templates or any
locations that you have created. To open any location, perform one of the following actions:

From the  tab, right-click on the desired location(s) to open, and then select Open.

OR

From the  tab, right-click on the desired location(s) to open, and then select Open.

Global Tab Devices Tab

To close any location that is open, perform one of the following actions:

From the File menu, select Close.

OR

Select  the gray “X” in the upper right corner of the Data window.
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Transferring Locations to Devices

You can use the WorkBench software to transfer any location templates or locations to a
connected device. To transfer any location, perform the following actions:

1. From the  tab, right-click on the desired
location(s) to transfer, and then select Transfer to
Device.

2. If more than one device is connected the Transfer
Locations window will appear.

3. Select the locations you wish to send.

4. Select the device(s) to which you wish to send the
selected locations.

5. Select the  button to transfer the locations or

select the  button to exit without transferring.

If only one device is connected, the location will automatically
be transferred to the device without any other user interaction.
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Saving Locations to a Local File

You can save locations to your local drive to allow you to move data from one WorkBench software
installation to other WorkBench software installations within your company.

Perform the following steps to save a local copy of any of the locations described earlier in this
chapter:

1. Perform one of the following steps to select the location(s) to save:

After opening a location, from the File menu select Export.

OR

After connecting to a device, from the  tab, right-click on the desired
location(s) to save, and then select Save Local File As.

OR

From the  tab, right-click on the desired location(s) to save, and then select
Export to Local Disk.

Devices Tab Global TabFile Menu

To select more than one location at once for batch processing,
select the first location that you would like to save, and then
hold the CTRL key on your keyboard while using your mouse
to select the other location.
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2. Perform one of the following steps to save the local
location file(s):

If you selected only one file to save, The Save
window will appear. From this window you will
choose the location and name of the location to

save and then select the  button.

OR

If you selected more than one file to save, The
Browse For Folder window will appear. From this
window you will choose the location to save the

locations to and then select the  button.
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Importing Locations from a Local File

You can import locations to allow you to move data from one WorkBench software installation to
other WorkBench software installations within your company.

Perform the following steps to import any of the locations described earlier in this chapter:

1. From the File menu hover over Import, and then select Locations.

2. The Open window will appear. From this window you
will choose which location(s) to import and then select

the  button.
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Deleting Locations

You can delete locations that are no longer needed.

Perform the following steps to delete any of the locations described earlier in this chapter:

1. Perform one of the following steps to select the location(s) to delete:

From the  tab, right-click on the desired location(s) to delete, and then select
Delete.

OR

From the  tab, right-click on the desired location(s) to delete, and then select
Delete.

Devices Tab Global Tab

To select more than one location at once for batch processing,
select the first location that you would like to delete, and then
hold the CTRL key on your keyboard while using your mouse
to select the other location.
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2. The Confirm Delete window will appear based on how you choose to delete the
location(s) as shown below:

• Devices Tab - Single File Selected

• Devices Tab - Multiple Files Selected

• Global Tab - Single File Selected

• Global Tab - Multiple Files Selected

3. From this window you will confirm whether to delete the location(s) by selecting the
 button, or you can exit without deleting the location(s) by selecting the 

button.

Be very careful when deleting files. Once a file has been deleted
the file cannot be recovered.
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Location Properties

After a location has been opened, the Location Properties can

be displayed by selecting the  button from the toolbar at the

top of the Data window or from the  tab, right-click
the Location, and then select Properties. An example of the
Location Properties window is shown to the right.

The fields displayed in the Location Properties window are
as follows:

Name: Displays the file name of the location.

Description: Displays the description given to the
location when created.

Last Modified: Displays the date that the location was last
modified.

Modified By: Displays the name of the user that last
modified the location.
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Printing Without Preview
To print any location that is open without a preview,
perform the following steps:

1. Press the Ctrl+P keys on your keyboard or from
the File menu, select Print.

2. The Print window will appear.

3. If you wish to change any printer settings do so
at this point.

4. Once you are satisfied with the printer settings,

select the  button to print the

document or select the  button to exit
without printing.

Printing Locations

Before printing you may want to setup your printer by first
selecting Printer Setup... from the File Menu. WorkBench will
use the settings of your default Windows printer if you choose
to skip this step.
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Printing With Preview

To print any location that is open with a preview,
perform the following steps:

1. From the File menu, select Print
Preview.

2. A new print preview window will appear in
the Data window. You can then use the
buttons at the top of the print preview
screen as follows:

 - Use this button to print the
document.

 or  - Use these
buttons to zoom in and out on the document.

 - Use this button to close without
printing.

3. After you have selected the  button,
the Print window will appear.

4. If you wish to change any printer settings do so
at this point.

5. Once you are satisfied with you printer settings,

select the  button to print the document

or select the  button to exit without
printing.
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4. Auto-Test Macros
Chapter 4

Overview

This chapter shows you how to create and maintain auto-test macros.

An auto-test macro is a pre-programmed set of tests and ranges. You will likely have a variety of
macros for your 860 DSP or 860 DSPi, depending on the number and types of tests you need to
run in the field.

You can create a new auto-test macro or create an auto-test macro from an existing auto-test
macro.

Creating a Macro

To create a macro, perform the following steps:

1. Perform one of the following steps to create a new macro:

From the File menu, hover over New, and then select Macro.

OR

From the Toolbar click on the  button and then select Macro.

OR

From the  tab,  right-click on Auto-Test Macros, and then select New Macro.

File Menu Toolbar Global Tab

2. The New Macro window will appear.

3. Enter the Name of the macro. This can be up to 9 alphanumeric characters.

4. Enter a Description of the macro. This can be up to 254 alphanumeric characters.
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5. Perform one of the following steps to select the type of macro to create:

Create a new empty macro - Select this option to create a new macro starting with no
information in it.

OR

Start with an existing macro - Select this option to create a new macro based on an
existing macro. You must also select the name of the macro that you wish to replicate
and revise from the list at the bottom of the New Macro window.

Empty Macro Existing Macro

6. Once you are satisfied with you macro settings, select the  button to create the

macro or select the  button to exit without creating the macro.

After making changes to a macro, you must select the 
button from the toolbar or Save from the File menu before
closing the macro. Otherwise, if you try to close the macro
before saving, WorkBench will prompt you to save the macro.
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Macro Schedule Settings

You can select the type of schedule to use when executing the macro by selecting one of the
following options from the Timing drop-down list:

Immediate One-Time: This creates a macro that is designed
to be run immediately but only one time.

Start/Interval/Count: This creates a macro that is designed to
be run multiple times starting on a specific date and time with a
time interval between tests.

Specified Times: This creates a macro that is designed to be run up to four different times at
four different dates and times.

When the Timing field is set to Start/Interval/Count or Specified
Times, you will be prompted to enter the date, time, and/or test
interval time when executing the macro on the 860 DSP.

Scan Ping 

Tilt Throughput 

Hum Spectrum 

Carrier to Noise VoIP RTP 

Depth of Modulation Modem Stats 

MER/BER Leakage 

QAM + Constellation  
 

Macro Test Steps Settings

You can select the type of test to include when executing the macro by selecting one of the
following options from the Step # drop-down list:

After making changes to a macro, you must select the 
button from the toolbar or Save from the File menu before
closing the macro. Otherwise, if you try to close the macro
before saving, WorkBench will prompt you to save the macro.
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Scan Settings

You can modify the following fields to configure the settings of the scan test:

Check All Channels (Scan)

First, you must select the channel plan to
use for this test from the Channel Plan
drop-down list.

Limits

Adjust the value of any of the following
fields by entering the value, or by
selecting the up or down arrow to the
right of the field.

Minimum Video Level: Enter a
minimum video level in dBmV.

Maximum Video Level: Enter a maximum video level in dBmV.

Minimum Video/Audio Delta: Enter a minimum video/audio delta in dB.

Maximum Video/Audio Delta: Enter a maximum video/audio delta in dB.

Minimum Digital Level: Enter a minimum digital level in dBmV.

Maximum Digital Level: Enter a maximum digital level in dBmV.

Maximum Video Delta: Enter a maximum video delta in dB.

Maximum Adjacent Video Delta: Enter a maximum adjacent video delta in dB.
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Tilt Settings

You can modify the following fields to configure the settings of the tilt test:

Check Tilt

First, you must select the channel plan to
use for this test from the Channel Plan
drop-down list.

Limits

Adjust the value of any of the following fields by entering the value, or by selecting the up or
down arrow to the right of the field.

Minimum Tilt: Enter a minimum tilt level in dB.

Maximum Tilt: Enter a maximum tilt level in dB.

Hum Settings

You can modify the following fields to configure the settings of the hum test:

Check Hum

First, you must select the channel plan to
use for this test from the Channel Plan
drop-down list.

Limits

Enter the value of the Hum % in
Maximum Hum field by entering the value, or by selecting the up or down arrow to the right
of the field.

Parameters

Select a hum type of “50/60 Hz Value”, “100/120 Hz Value”, “< 1 kHz Value” from the Hum
Type drop-down list.



WorkBench Software - Section III: Configuration Files
III-44

Carrier to Noise Settings

You can modify the following fields to configure the settings of the Carrier to Noise test:

Check Carrier to Noise

First, you must select the channel plan to
use for this test from the Channel Plan
drop-down list.

Limits

Enter the value of the minimum carrier to noise level in dB by entering the value directly, or
by selecting the up or down arrow to the right of the field.

Depth of Modulation Settings

You can modify the following fields to configure the settings of the Depth of Modulation test:

Check Depth of Modulation

First, you must select the channel plan to
use for this test from the Channel Plan
drop-down list.

Limits

Adjust the value of any of the following fields by entering the value directly, or by selecting
the up or down arrow to the right of the field.

Minimum Depth of Modulation: Enter a minimum depth of modulation in %.

Maximum Depth of Modulation: Enter a maximum depth of modulation in %.
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MER/BER Settings

You can modify the following fields to configure the settings of the MER/BER test:

Check MER/BER

First, you must select the channel plan to
use for this test from the Channel Plan
drop-down list.

Limits

Adjust the value of any of the following
fields by entering the value directly, or by
selecting the up or down arrow to the
right of the field.

Minimum Digital Level: Enter a
minimum digital level in dBmV.

Maximum Digital Level: Enter a maximum digital level in dBmV.

Minimum Digital MER: Enter a minimum digital MER in dB.

Maximum Digital EVM: Enter a maximum digital EVM in %.

Maximum Digital Pre BER: Enter a maximum digital pre BER.

Maximum Digital Post BER: Enter a maximum digital post BER.

All of these limits except Maximum Pre/Post BER can also be
entered directly, as an alternative to using the up/down arrow to
adjust the values.
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QAM + Constellation Settings

You can modify the following fields to configure the settings of the QAM + Constellation test:

Check QAM + Constellation

First, you must select the channel plan to
use for this test from the Channel Plan
drop-down list.

Limits

Adjust the value of any of the following
fields by selecting the up or down arrow
to the right of the field.

Minimum Digital Level: Enter a
minimum digital level in dBmV.

Maximum Digital Level: Enter a maximum digital level in dBmV.

Minimum Digital MER: Enter a minimum digital MER in dB.

Maximum Digital EVM: Enter a maximum digital EVM in %.

Maximum Digital Pre BER: Enter a maximum digital pre BER.

Maximum Digital Post BER: Enter a maximum digital post BER.
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Ping Settings

You can modify the following fields to configure the settings of the Ping test:

Ping a Server

First, you must enter the IP address to
ping for this test in the IP Address field.

Parameters

Adjust the value of any of the following
fields by selecting the up or down arrow
to the right of the field.

Packet Delay: Enter the packet
delay in msec.

Packet Size: Enter the packet size in
Bytes.

Packets to Send: Enter the number
of packets to send.

CODEC Delay: Enter the CODEC delay in msec.

Buffer Delay: Enter the buffer delay in msec.

Limits

Adjust the value of any of the following fields by entering the value directly, or by selecting
the up or down arrow to the right of the field.

Minimum Launch Level: Enter a minimum launch level in dBmV.

Maximum Launch Level: Enter a maximum launch level in dBmV.

Maximum Lost Packets: Enter the maximum number of lost packets.

Maximum Percent Lost: Enter the maximum percentage of lost packets.

Maximum Transit Time: Enter a maximum transit time in msec.

Maximum Latency: Enter a maximum latency in msec.

Maximum Jitter: Enter a maximum jitter in msec.
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Throughput Settings

You can modify the following fields to configure the settings of the Throughput test:

Check Throughput

First, you must enter the file name and IP
address for this test in the Filename and
IP Address fields.

Parameters

Adjust the value of any of the following
fields by selecting the up or down arrow
to the right of the field.

File Transfer: Select the file transfer protocol “TFTP Upstream Test”, “TFTP
Downstream Test”, “HTTP Upstream Test”, “HTTP Downstream Test”, “UDP Ustream
Test”, or “UDP Downstream Test” from the drop-down list.

Transfer Rate: Enter the transfer rate in Bits/Sec by entering the value directly, or by
selecting the up or down arrow to the right of the field.

Limits

Enter the minimum transfer rate in Bits/Sec in the Minimum Transfer Rate field by entering
the value directly, or by selecting the up or down arrow to the right of the field.

Leakage Settings

You can modify the following fields to configure the settings of the Leakage test:

Limits

Enter the maximum leakage level in
μμμμμV/meter in the Maximum Level field
by entering the value directly, or by
selecting the up or down arrow to the
right of the field.
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Spectrum Settings

You can modify the following fields to configure the settings of the Spectrum test:

Parameters

Start Frequency: Enter the start
frequency in MHz by entering the
value directly, or by selecting the up or
down arrow to the right of the field.

Start Frequency: Enter the stop
frequency in MHz by entering the
value directly, or by selecting the up or
down arrow to the right of the field.

Resolution Bandwidth: Select the
resolution bandwidth of “1 kHz”, “3
kHz”, “10 kHz”, “30 kHz”, “100 kHz”, or
“300 kHz” from the drop-down list.

Sampling Level: Select the sampling level of “1”, “2”, “4”, “8”, “16”, “32”, “64”, “128”, or
“256” by selecting the up or down arrow to the right of the field.

Reference Level: Enter the reference level in dBmV by entering the value directly, or
by selecting the up or down arrow to the right of the field.

Hold Setting: Select the hold setting of “None”, “Max”, or “Min” from the drop-down list.

Limits

Minimum Level: Enter the minimum level in dBmV by entering the value directly, or by
selecting the up or down arrow to the right of the field.

Maximum Level: Enter the maximum level in dBmV by entering the value directly, or
by selecting the up or down arrow to the right of the field.
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VoIP RTP Settings

You can modify the following fields to configure the settings of the VoIP RTP test:

Check VoIP RTP

First, you must enter IP address for this
test in the IP Address field.

Parameters

CODEC Type: Select the CODEC
type of “G.711” or “G.711 (restore
default values)” from the drop-down
list.

CODEC Delay: This is a read-only
field that is automatically adjusted
based on the settings of the Packet
Rate and Packet Size fields.

Packet Rate: Enter the packet rate in msec by entering the value directly, or by
selecting the up or down arrow to the right of the field.

Packet Size: Enter the packet size in msec by entering the value directly, or by
selecting the up or down arrow to the right of the field.

Jitter Buffer Delay: Enter the jitter buffer delay in msec by entering the value directly,
or by selecting the up or down arrow to the right of the field.

Call Length: Enter the call length in sec by entering the value directly, or by selecting
the up or down arrow to the right of the field.

Limits

Maximum Latency: Enter the maximum latency in msec by entering the value directly,
or by selecting the up or down arrow to the right of the field.

Maximum Jitter: Enter the maximum jitter in msec by entering the value directly, or by
selecting the up or down arrow to the right of the field.

Minimum MOS: Enter the minimum MOS value by entering the value directly, or by
selecting the up or down arrow to the right of the field.



WorkBench Software - Section III: Configuration Files
III-51

Modem Stats Settings

You can modify the following fields to configure the settings of the Modem Stats test:

Parameters

Modem MAC: Select the modem
MAC address of  “Use Setup Menu”,
“MAC #1”, or “MAC #2” from the
drop-down list.

Downstream Frequency: Enter the
downstream frequency in MHz by
entering the value directly, or by
selecting the up or down arrow to the
right of the field.

Modem Mode: Select the modem
mode of “Use Setup Menu”. “DOCSIS
1.0”, “DOCSIS 2.0”, “DOCSIS 2.1” or
“DOCSIS 3.0” from the drop-down list.

Annex Type: Select the annex type of “Use Setup Menu”. “Annex A” or “Annex B” from
the drop-down list.

Upstream ID: Enter the upstream ID by entering the value directly, or by selecting the
up or down arrow to the right of the field.

Limits

Minimum Launch Level: Enter the minimum launch level in dBmV by entering the
value directly, or by selecting the up or down arrow to the right of the field.

Maximum Launch Level: Enter the maximum launch level in dBmV by entering the
value directly, or by selecting the up or down arrow to the right of the field.

Minimum Receive Level: Enter the minimum receive level in dBmV by entering the
value directly, or by selecting the up or down arrow to the right of the field.

Maximum Receive Level: Enter the maximum receive level in dBmV by entering the
value directly, or by selecting the up or down arrow to the right of the field.
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Opening and Closing Macros

You can use the WorkBench software to open the macros that you have created. To open any
macro, perform one of the following actions:

From the  tab, right-click on the desired macro(s) to open, and then select Open.

OR

From the  tab, right-click on the desired macro(s) to open, and then select Open.

Global Tab Devices Tab

To close any macro that is open, perform one of the following actions:

From the File menu, select Close.

OR

Select the gray “X” in the upper right corner of the Data window.
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Transferring Macros to Devices

You can use the WorkBench software to transfer macros to a connected device. To transfer any
macro, perform the following actions:

1. From the  tab, right-click on the desired
macro(s) to transfer, and then select Transfer to
Device.

2. If more than one device is connected the Transfer
Macros window will appear.

3. Select the macros you wish to send.

4. Select the device(s) to which you wish to send the
selected macros.

5. Select the  button to transfer the macros or

select the  button to exit without transferring.

If only one device is connected, the macro will automatically be
transferred to the device without any other user interaction.
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Saving Macros to a Local File

You can save macros to your local drive to allow you to move data from one WorkBench software
installation to other WorkBench software installations within your company.

Perform the following steps to save a local copy of any of the macros described earlier in this
chapter:

1. Perform one of the following steps to select the macro(s) to save:

After opening a macro, from the File menu select Export.

OR

After connecting to a device, from the  tab, right-click on the desired
macro(s) to save, and then select Save Local File As.

OR

From the  tab, right-click on the desired macro(s) to save, and then select
Export to Local Disk.

Devices Tab Global TabFile Menu

To select more than one macro at once for batch processing,
select the first macro that you would like to save, and then hold
the CTRL key on your keyboard while using your mouse to
select the other macro.
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2. Perform one of the following steps to save the local
macro file(s):

If you selected only one file to save, The Save
window will appear. From this window you will
choose the location and name of the macro to

save and then select the  button.

OR

If you selected more than one file to save, The
Browse For Folder window will appear. From
this window you will choose the location to save

the macros to and then select the 
button.
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Importing Macros from a Local File

You can import macros to allow you to move data from one WorkBench software installation to
other WorkBench software installations within your company.

Perform the following steps to import any of the macros described earlier in this chapter:

1. From the File menu hover over Import, and then select Macros.

2. The Open window will appear. From this window you
will choose which macro(s) to import and then select

the  button.
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Deleting Macros

You can delete macros that are no longer needed.

Perform the following steps to delete any of the macros described earlier in this chapter:

1. Perform one of the following steps to select the macro(s) to delete:

From the  tab, right-click on the desired macro(s) to delete, and then select
Delete.

OR

From the  tab, right-click on the desired macro(s) to delete, and then select
Delete.

Devices Tab Global Tab

To select more than one macro at once for batch processing,
select the first macro that you would like to delete, and then
hold the CTRL key on your keyboard while using your mouse
to select the other macros.
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2. The Confirm Delete window will appear based on how you choose to delete the macro(s)
as shown below:

• Devices Tab - Single File Selected

• Devices Tab - Multiple Files Selected

• Global Tab - Single File Selected

• Global Tab - Multiple Files Selected

3. From this window you will confirm whether to delete the macro(s) by selecting the 

button, or you can exit without deleting the macro(s) by selecting the  button.

Be very careful when deleting files. Once a file has been deleted
the file cannot be recovered.
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Macro Properties

After a macro has been opened, the Macro Properties can

be displayed by selecting the  button from the toolbar at

the top of the Data window or from the  tab, right-
click  the macro, and then select Properties. An example of
the Macro Properties window is shown to the right.

The fields displayed in the Macro Properties window are
as follows:

Name: Displays the file name of the macro.

Description: Displays the description given to the
macro when created.

Last Modified: Displays the date that the macro was
last modified.

Modified By: Displays the name of the user that last
modified the macro.
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Printing Without Preview
To print any macro that is open without a preview,
perform the following steps:

1. Press the Ctrl+P keys on your keyboard or from
the File menu, select Print.

2. The Print window will appear.

3. If you wish to change any printer settings do
so at this point.

4. Once you are satisfied with the printer

settings, select the  button to print

the document or select the  button
to exit without printing.

Printing Macros

Before printing you may want to setup your printer by first
selecting Printer Setup... from the File Menu. WorkBench will
use the settings of your default Windows printer if you choose
to skip this step.
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Printing With Preview

To print any macro that is open with a preview,
perform the following steps:

1. From the File menu, select Print
Preview.

2. A new print preview window will appear in
the Data window. You can then use the
buttons at the top of the print preview
screen as follows:

 - Use this button to print the
document.

 or  - Use these
buttons to zoom in and out on the document.

 - Use this button to close without
printing.

3. After you have selected the  button, the
Print window will appear.

4. If you wish to change any printer settings do so at
this point.

5. Once you are satisfied with the printer settings,

select the  button to print the document

or select the  button to exit without
printing.
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5. Task Sheets and Tasks
Chapter 5

Overview

This chapter shows you how to create and maintain task sheets.

A task sheet is a template that organizes and defines individual tasks (work orders) or trouble
tickets. Task sheets allow you to group technicians or types of tasks that share a common set of
work parameters or attributes.

Once a task sheet is defined, you can use it create new tasks, assign tasks to technicians and
also view the current status and history of tasks. These work orders can be created for use with
the Trilithic Data Manager (TDM), CSG Workforce Express, or other third party workforce
management systems.

Creating a Task Sheet

To create a task sheet, perform the following steps:

1. Perform one of the following steps to create a new task sheet:

From the File menu, hover over New, and then select Task Sheet.

OR

From the Toolbar click on the  button and then select Task Sheet.

OR

From the  tab,  right-click on Task Sheets, and then select New Task Sheet.

File Menu Toolbar Global Tab
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2. The New Task Sheet window will appear.

3. Enter the Name of the task sheet. This can be up to 9
alphanumeric characters.

4. Enter a Description of the task sheet. This can be up
to 254 alphanumeric characters.

5. Each Attribute ## field represents a custom column
that will appear on the task sheet. Each task sheet can
have up to 24 user-defined attributes. Enter the custom
attributes of the task sheet as follows:

Header - Enter the label that will appear as the
column header in this field.

Value ## - If you want users to choose from a drop-
down box in the task sheet, enter each possible
value for the associated header. Repeat for each
value possible for the corresponding header. Leave this field blank to be able to enter
any value (up to 255 characters) for the corresponding header.

6. Repeat Step 5 for each column that you wish to appear in the task sheet.

7. Once you have finished adding the custom attributes, select the  button to create

a new task sheet or select the  button to exit without creating a new task sheet.

8. A new blank task sheet will appear that includes the custom attributes setup in the previous
steps.

After making changes to a task sheet, you must select the 
button from the toolbar or Save from the File menu before
closing the task sheet. Otherwise, if you try to close the task
sheet before saving, WorkBench will prompt you to save the
task sheet.

Once a task sheet has been created, attribute columns cannot
be created or deleted.
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Entering Tasks into Task Sheets

Once you have created a task sheet, you will then need to create tasks within the task sheet.

To create a task, perform the following steps:

1. Enter a unique Task ID. This can be
up to 6 alphanumeric characters.
Task IDs for all open tasks must be
unique. The tasks that they
represent will later be attached by
860 DSPi operators to data logs for
record keeping purposes.

2. Enter or select from the drop down
box the appropriate information in
each custom column. If an attribute
has a drop down box, an arrow will
appear when the field is selected.
You cannot type information into attributes with drop down lists.

3. The following columns are automatically included in every task sheet:

Admin Note - This field allows you to enter any additional admin notes.

Status - This field is assigned automatically. The three states are Open, Assigned, and
Closed.

Assigned To - This field is automatically updated when the task is sent to an individual
outbox or imported from an individual inbox.

Date Opened - Automatically filled in when the task is created.

Date Assigned - Automatically filled in when the task is sent to an individual inbox.

Date Closed - Automatically filled in once the technician closes the task on the 860
DSPi or when the task administrator right-clicks on the task and chooses Close from
the drop down box.

Tasks can be sorted by selecting the column headers. For
example, if you want to sort the task sheet alphabetically by last
name, select the Last Name column header.
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Opening and Closing Task Sheets

You can use the WorkBench software to open any of the task sheets that you have created. To
open any task sheet, perform one of the following actions:

From the  tab, right-click on the desired task sheet(s) to open, and then select Open.

OR

From the  tab, right-click on the desired task sheet(s) to open, and then select
Open.

Global Tab Devices Tab

To close any task sheet that is open, perform one of the following actions:

From the File menu, select Close.

OR

Select  the gray “X” in the upper right corner of the Data window.
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Transferring Tasks to Devices

You can use the WorkBench software to transfer macros to a connected device. To transfer any
macro, perform the following actions:

1. From the task sheet, right-click on the
desired task(s) to transfer, and then
select Transfer to 860 DSP.

2. If more than one device is connected the Transfer
Tasks window will appear.

3. Select the tasks you wish to send.

4. Select the device(s) that you wish to send the selected
tasks to.

5. Select the  button to transfer the tasks or

select the  button to exit without transferring.

If only one device is connected, the task will automatically be
transferred to the device without any other user interaction.



WorkBench Software - Section III: Configuration Files
III-68

Saving Task Sheets to a Local File

You can save task sheets and tasks to your local drive to allow you to move data from one
WorkBench software installation to other WorkBench software installations within your company.

Perform the following steps to save a local copy of a task sheet:

1. Perform one of the following steps to select the task sheet or task(s) to save:

After opening a task sheet, from the File menu select Export.

OR

After connecting to a device, from the  tab, right-click on the desired
macro(s) to save, and then select Save Local File As.

OR

From the  tab, right-click on the desired macro(s) to save, and then select
Export to Local Disk.

Devices Tab Global TabFile Menu

To select more than one task sheet at once for batch
processing, select the first task sheet that you would like to
save, and then hold the CTRL key on your keyboard while
using your mouse to select the other task sheet.
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2. Perform one of the following steps to save the
local task sheet file(s):

If you selected only one file to save, the Save
window will appear. From this window choose
the location and name of the task sheet to save

and then select the  button.

OR

If you selected more than one file to save, the
Browse For Folder window will appear. From
this window choose the location to save the

task sheets to and then select the 
button.
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Exporting Task Sheets to a Template File

You can export task sheets to definition files for use as a template inside of WorkBench. Exporting
a task sheet definition recreates the structure and attributes of an existing task sheet into a
definition file. This file can later be imported and used to create the exact same task sheet. This
option helps provide a consistency when multiple administrators use the same task sheet.

Perform the following steps to export any of the task sheets described earlier in this chapter:

1. Open the task sheet that you wish to export.

2. From the File menu hover over Export, and then select
Task Sheet Definition.

3. The Save As window will appear. From this window
choose the location and name of the task sheet

template to save and then select the  button.
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Exporting Task Sheets to a Text File

You can export task sheets to text files for use outside of WorkBench.

Perform the following steps to export any of the task sheets described earlier in this chapter:

1. Open the task sheet that you wish to export.

2. From the File menu hover over Export, and then select one either of the following options
Comma-Delimited Text File or Tab-Delimited Text File.

3. The Save As window will appear. From this window
choose the location and name of the task sheet text file

to save and then select the  button.

Comma-Delimited Tab-Delimited
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Exporting Tasks to a Local File

You can export task sheets to text files for use outside of WorkBench.

Perform the following steps to export any of the task
sheets described earlier in this chapter:

1. Open the task sheet and select the task(s) that
you wish to export.

2. Right-click on the task(s), and then select
Export to Local Disk.

To select more than one task sheet at once for batch
processing, select the first task sheet that you would like to
save, and then hold the CTRL key on your keyboard while
using your mouse to select the other task sheet.
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3. Perform one of the following steps to save the
local task file(s):

If you selected only one file to save, the Save
window will appear. From this window choose
the location and name of the task to save and

then select the  button.

OR

If you selected more than one file to save, the
Browse For Folder window will appear. From
this window choose the location to save the

tasks to and then select the  button.
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Importing Task Sheets from a Local File

You can import task sheets to allow you to move data from one WorkBench software installation to
other WorkBench software installations within your company.

Perform the following steps to import any of the task sheets described earlier in this chapter:

1. From the File menu hover over Import, and then select Tasks/Task Sheets.

2. The Open window will appear. From this window you
will choose which task sheet(s) to import and then

select the  button. A task sheet’s file type is
*.tsh.
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Importing Tasks from a Local File

You can import tasks to allow you to move data from one WorkBench software installation to other
WorkBench software installations within your company.

Perform the following steps to import task files:

1. From the File menu hover over Import, and then select Tasks/Task Sheets.

2. The Open window will appear. From this
window you will choose which task(s) to import

and then select the  button. A task
file’s file type can be either *.clsd (closed task)
or *.task (open task).

If you are importing data logs and their associated task file(s)
from a local disk, you must first import the task file(s) before
importing the data logs. Failure to do so will break the
associative link between the task(s) and data log(s).
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Deleting Task Sheets

You can delete task sheets that are no longer needed.

Perform the following steps to delete any of the task sheets described earlier in this chapter:

1. Perform one of the following steps to select the task sheet(s) to delete:

From the  tab, right-click on the desired task sheet(s) to delete, and then
select Delete.

OR

From the  tab, right-click on the desired task sheet(s) to delete, and then
select Delete.

Devices Tab Global Tab

To select more than one task sheet at once for batch
processing, select the first task sheet that you would like to
delete, and then hold the CTRL key on your keyboard while
using your mouse to select the other task sheet.
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2. The Confirm Delete window will appear based on how you choose to delete the task
sheet(s) as shown below:

• Devices Tab - Single File Selected

• Devices Tab - Multiple Files Selected

• Global Tab - Single File Selected

• Global Tab - Multiple Files Selected

3. From this window you will confirm whether to delete the location(s) by selecting the
 button, or you can exit without deleting the location(s) by selecting the 

button.

Be very careful when deleting files. Once a file has been deleted
the file cannot be recovered.
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Deleting Tasks

You can delete tasks that are no longer needed. When an open or assigned task is deleted it is
permanently removed from the task sheet. A closed task cannot be deleted.

Perform the following steps to delete a task:

1. Open the task sheet and select the task(s) that you
wish to delete.

2. Right-click on the task(s), and then select Delete.

Closing Tasks

Normally tasks are closed by a technician via an 860 DSPi. If this does not happen, tasks can
also be closed manually in the task sheet. Closed tasks remain in the task sheet, but are hidden
from view.

Perform the following steps to close a task:

1. Open the task sheet and select the task(s) that you
wish to close.

2. Right-click on the task(s), and then select Close.

To view closed tasks, select Show Closed Tasks from the right-
click menu.
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Archiving Task Sheets

Archiving a task sheet is useful if you want to keep a historical record of tasks contained in a task
sheet that is no longer in active use. Closed task sheets remain in WorkBench, but are hidden
from view.

To archive a task sheet, perform the following steps:

1. From the  tab, right-click on the desired task
sheet(s) to archive, and then select Archive.

To view archived task sheets, select Show Archives from the
right-click menu.

2. The Confirm Archive window appears,
select the Yes button to confirm the
archive or select the No button to exit
without archiving.
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Task Sheet Properties

After a task sheet has been opened, the Task Sheet

Properties can be displayed by selecting the  button from

the toolbar at the top of the Data window or from the 
tab, right-click  the task sheet, and then select Properties. An
example of the Task Sheet Properties window is shown to
the right.

The fields displayed in General tab of the Task Sheet
Properties window are as follows:

Name: Displays the file name of the task sheet.

Description: Displays the description given to the task
sheet when created.

Details: Displays the properties of the currently selected
task sheet.

Modified By: Displays the name of the user that last
modified the location.

The fields displayed in Attributes tab of the Task Sheet
Properties window are as follows:

Header: This value can be edited but not deleted.

Values: These values can be edited but not deleted.

Attribute: Once a task sheet is created, attribute columns
cannot be created or deleted.
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Printing Without Preview

To print any task sheet that is open without a preview,
perform the following steps:

1. Press the Ctrl+P keys on your keyboard or from
the File menu, select Print.

2. The Print window will appear.

3. If you wish to change any printer settings do so at this
point.

4. Once you are satisfied with the printer settings,

select the  button to print the document or

select the  button to exit without printing.

Printing Task Sheets

Before printing you may want to setup your printer by first
selecting Printer Setup... from the File Menu. WorkBench will
use the settings of your default Windows printer if you choose
to skip this step.
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Printing With Preview

To print any task sheet that is open with a preview,
perform the following steps:

1. From the File menu, select Print Preview.

2. A new print preview window will appear in the
Data window. You can then use the buttons at
the top of the print preview screen as follows:

 - Use this button to print the
document.

 or  - Use these buttons
to zoom in and out on the document.

 - Use this button to close without
printing.

3. After you have selected the  button, the
Print window will appear.

4. If you wish to change any printer settings do so at
this point.

5. Once you are satisfied with the printer settings,

select the  button to print the document

or select the  button to exit without printing.
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6. Text Files
Chapter 6

Overview

This chapter shows you how to create and maintain text files. Text files have many uses on the 860
DSP and 860 DSPi, including:

• Detailed notes on channel plans, locations, or macros.

• Bulletins on service conditions.

• Step-by-step procedures for addressing certain technical conditions.

• Contact Information.

• Recommended testing procedures.

Creating a Text File

To create a text file, perform the following steps:

1. Perform one of the following steps to create a new text file:

From the File menu, hover over New, and then select Text File.

OR

From the Toolbar click on the  button and then select Text File.

OR

From the  tab,  right-click on Local Data, and then select New Text File.

File Menu Toolbar Global Tab
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2. The Save As window will appear. From this window
you will choose the location and name of the text file to

save and then select the  button.

3. A new blank text file will appear in the data window.
Text can be entered or posted from another document.
Note that there is no “word wrap” for posted text.

After making changes to a text file, you must select the 
button from the toolbar or Save from the File menu before
closing the text file. Otherwise, if you try to close the text file
before saving, WorkBench will prompt you to save the text file.
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Opening and Closing Text File

You can use the WorkBench software to open the text files that you have created. To open any text
files, perform one of the following actions:

From the  tab, right-click on the desired text file(s) to open, and then select Open.

OR

From the  tab, right-click on the desired text file(s) to open, and then select Open.

Global Tab Devices Tab

To close any text file that is open, perform one of the following actions:

From the File menu, select Close.

OR

Select the gray “X” in the upper right corner of the Data window.
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Transferring Text Files to Devices

You can use the WorkBench software to transfer text files to a connected device. To transfer any
text file, perform the following actions:

1. From the  tab, right-click on the desired text
file(s) to transfer, and then select Transfer to Device.

2. If more than one device is connected the Transfer
Files window will appear.

3. Select the text files you wish to send.

4. Select the device(s) that you wish to send the selected
text files to.

5. Select the  button to transfer the text files or

select the  button to exit without transferring.

If only one device is connected, the text file will automatically be
transferred to the device without any other user interaction.
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Saving Text Files to a Local File

You can save text files from the 860 DSP or 860 DSPi to your local drive to allow you to move
data from one WorkBench software installation to other WorkBench software installations within
your company.

Perform the following steps to save a local copy of any of the text files described earlier in this
chapter:

1. After connecting to a device, from the  tab,
right-click on the desired text file(s) to save, and then
select Save Local File As.

To select more than one text file at once for batch processing,
select the first text file that you would like to save, and then hold
the CTRL key on your keyboard while using your mouse to
select the other text file.



WorkBench Software - Section III: Configuration Files
III-88

2. Perform one of the following steps to save the local
text file(s):

If you selected only one file to save, the Save
window will appear. From this window choose
the location and name of the text file to save and

then select the  button.

OR

If you selected more than one file to save, the
Browse For Folder window will appear. From
this window choose the location to save the text

file(s) to and then select the  button.
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Deleting Text Files

You can delete text files that are no longer needed.

Perform the following steps to delete any of the text files described earlier in this chapter:

1. Perform one of the following steps to select the text file(s) to delete:

From the  tab, right-click on the desired text file(s) to delete, and then select
Delete.

OR

From the  tab, right-click on the desired text file(s) to delete, and then select
Delete.

Devices Tab Global Tab

To select more than one text file at once for batch processing,
select the first text file that you would like to delete, and then
hold the CTRL key on your keyboard while using your mouse
to select the other text file.
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Printing Without Preview
To print any text file that is open without a preview,
perform the following steps:

1. Press the Ctrl+P keys on your keyboard or from
the File menu, select Print.

2. The Print window will appear.

3. If you wish to change any printer settings do
so at this point.

4. Once you are satisfied with the printer

settings, select the  button to print

the document or select the  button
to exit without printing.

Printing Text Files

Before printing you may want to setup your printer by first
selecting Printer Setup... from the File Menu. WorkBench will
use the settings of your default Windows printer if you choose
to skip this step.
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Printing With Preview

To print any text file that is open with a preview,
perform the following steps:

1. From the File menu, select Print
Preview.

2. A new print preview window will appear in
the Data window. You can then use the
buttons at the top of the print preview
screen as follows:

 - Use this button to print the
document.

 or  - Use these
buttons to zoom in and out on the document.

 - Use this button to close without
printing.

3. After you have selected the  button, the
Print window will appear.

4. If you wish to change any printer settings do so at
this point.

5. Once you are satisfied with the printer settings,

select the  button to print the document

or select the  button to exit without
printing.
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Section IV: Configuration Packages

WorkBench Software
(and WorkBench Lite Software)

for the 860 DSP, 860 DSPi, 860 DSPh, 860 DSPr, and 8300 FST
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1. Introduction
Chapter 1

Overview

Once you have used the WorkBench program to create configuration files, you can begin creating,
editing, and managing configuration packages.  A configuration package is a combination of one
or more channel plans, locations, macros, and text files, and a wide variety of individual
configuration parameters. You can use a configuration package as a quick and easy way to install
a suite of channel plans and other information on the following analyzers:

• 860 DSP

• 860 DSPi

• 860 DSPh

• 860 DSPr

• 8300 FST

Within each configuration package, you can customize your analyzers to meet your specific
testing requirements by configuring the following parameters:

• Navigation menus

• Channel plans

• Locations

• Auto-test macros

• Measurement options

• Test  mode options

• Performance limits
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2. Creating Configuration
Packages

Chapter 2

Overview

You can create a new configuration package or create a configuration package from an existing
configuration package.  Once you have created a configuration package, you can modify or delete
them, directly modify the configuration of an 860 DSP, DSPi, DSPh, or DSPr, or download
individual files to an 860 DSP, DSPi, DSPh, or DSPr.

In the following procedures, there are minor differences in some
of the screen options and the screens that appear, depending on
whether you have multiple, one, or no 860 DSP’s connected to
the system.

You cannot create and save configuration packages for the
8300 FST Forward Speed Sweep Transmitter as shown in this
chapter. See Chapter 6: Configuring an 8300 FST for more
information on how to create custom configurations for the
8300 FST.

Creating a New Configuration Package

The WorkBench Configuration Wizard is used to create a configuration package.

It is not necessary to create a complete configuration package. You
can create a configuration package that will add specific features to
an existing configuration then use the Add Selected Items option
on the Package Transfer Mode screen (shown later in this
procedure) to download the configuration information without
deleting any existing configuration information on the 860 DSP.
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To create a configuration package, perform the following steps:

1. Perform one of the following steps to create a new configuration package:

From the File menu, hover over New, and then select Configuration Package.

OR

From the Toolbar click on the  button and then select Configuration Package.

OR

From the  tab,  right-click on Packages, and then select New Configuration
Packages.

File Menu

Toolbar

Global Tab

2. The Trilithic Device Configuration Wizard
window will appear.

3. Click  button to display the Trilithic
Device Configuration Wizard Getting Started
screen.
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4. Perform one of the following steps to create a
configuration package, and then click the 
button:

New configuration - Select this option to
create a new empty device configuration,
selecting all desired items and parameters.

OR

Existing configuration - Select this option to
start with a previously saved configuration
package and modify any item selections or
parameters that you would like to change.

OR

Active device configuration - Select this option to load and modify items and
configuration parameters from a selected device.

You can select the Active Device Configuration option to load
the configuration from the specified device then modify the
specified device’s information and/or download it to another
device.  If an existing device configuration is to be used to
configure other devices, you may find it easiest to create your
main configuration package(s) with this method.

If one or more devices are connected, the Active Device
Configuration option is active.
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5. If you selected the New configuration option from the previous step, proceed to Step 7.
Otherwise, proceed to the next step.

6. Perform one of the following steps to choose which device or existing configuration
package to use to create the new configuration package, and then click the 
button:

If you selected the Existing configuration option from Step 4, select the name of the
configuration package to use as the basis of the new configuration package.

OR

If you selected the Active device configuration option from Step 4, select the name of
the device to use as the basis of the new configuration package.

Existing
Configuration

Active Device
Configuration

Before you can continue, You will need to know the type(s) of
devices for which you want to create configuration packages.
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7. Perform one of the following steps to select the type of device with which the configuration
package is to be used:

860 DSP/DSPi hand-held device - Select this
option to create a device configuration for the 860
DSP or 860 DSPi.

OR

860 DSPh rack-mounted device - Select this
option to create a device configuration for the 860
DSPh.

OR

All 860 DSP devices - Select this option to
create a device configuration that includes channel plans, locations, auto-test macros,
and text files that is compatible with the 860 DSP, DSPi, and DSPh.

8. Once you have chosen the type of device that the configuration package is to be used with,
click the  button and then see the following:

If you selected the 860 DSP/DSPi hand-held device option, proceed to Chapter 2 to
view the available configuration parameters for the 860 DSP and 860 DSPi and then
return to Step 9 to continue creating the configuration package.

OR

If you selected the 860 DSPh rack-mounted device option, proceed to Chapter 3 to
view the available configuration parameters for the 860 DSPh and then return to Step 9
to continue creating the configuration package.

OR

If you selected the All 860 DSP devices option, proceed to Step 9 to continue creating
the configuration package.

The 860 DSPr and 8300 FST are not shown in the Device
Selection Wizard window.  To create a new configuration
package for the 860 DSPr or the 8300 FST, manually connect to
the device then right-click on the device name and select
“Configure, Configuration Wizard” from the menu.
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This step ONLY applies to the 860 DSP or 860 DSPi. Proceed to
Step 13 to continue creating the 860 DSPh configuration
package.

9. After proceeding through the available configuration parameters for your selected device,
the Select Channel Plans window will appear. Perform one of the following steps  to
select the channel plans to include in the configuration, and then click the  button:

Do not include channel plans in this
configuration - Select this option to exclude
channel plans from this configuration package.

OR

Include the selected channel plans in this
configuration - Select this option to include the
selected channel plans in this configuration
package, and then from the list select the channel
plans to include.

10.The Select Locations window will appear. Perform
one of the following steps  to select the locations to include in the configuration, and then
click the  button:

Do not include locations in this configuration
- Select this option to exclude locations from this
configuration package.

OR

Include the selected locations in this
configuration - Select this option to include the
selected locations in this configuration package,
and then from the list select the locations to
include.
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11. The Select Auto-Test Macros window will appear. Perform one of the following steps  to
select the auto-test macros to include in the configuration, and then click the 
button:

Do not include auto-test macros in this
configuration - Select this option to exclude
auto-test macros from this configuration package.

OR

Include the selected auto-test macros in this
configuration - Select this option to include the
selected auto-test macros in this configuration
package, and then from the list select the auto-
test macros to include.

12.The Select Text Files window will appear. Perform one of the following steps to select the
text files to include in the configuration, and then click the  button:

Do not include text files in this configuration -
Select this option to exclude text files from this
configuration package.

OR

Include the selected text files in this
configuration - Select this option to include the
selected text files in this configuration package,
and then from the list select the text files to
include.

This step ONLY applies to the 860 DSP or 860 DSPi. Proceed to
Step 13 to continue creating the 860 DSPh configuration
package.
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14.The Additional Configuration Options window will appear. Select from the following
additional configuration tasks to be performed when the configuration package is applied
to the selected devices, and then click the 
button:

Set Date/Time - Select this option to transfer the
date and time of the PC running the WorkBench
software to the selected devices.

Format Data File System - Not available for
selection at this time.

Reboot Device - Select this option to reboot the
selected devices after the transfer of the
configuration package is complete.

If editing a configuration package directly from a connected
device, proceed directly to Step 17.

13.The Package Transfer Mode window will appear. Perform one of the following steps to
determine how to apply the configuration package to the target device, and then click the

 button:

Add Selected Items - Select this option to
transfer the selected items to the device and
leave all of its existing items unchanged.

OR

Include Selected Items and Delete All Other
Items - Select this option to transfer the
selected items to the device and delete all
existing items. This device will only contain only
those items selected in this configuration
package.

Selecting the second option may cause the channel plan,
location, macro, and text data to be deleted from the selected
devices.
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15.The Save Configuration Package window will appear. Perform one of the following steps
to select whether you would like to save this configuration package, and then click the

 button:

No, don’t save this package - Select this option
to not save the configuration package.

OR

Yes, save this package - Select this option to
save this configuration package, and then enter a
name and description of the configuration
package.

This step does not apply when editing a configuration package
directly from a connected device, proceed directly to Step 17.

16.The Select Target Devices window will appear. Perform one of the following steps to
select whether you would like to transfer this configuration package to a connected device,
and then click the  button:

No, I’m ready to complete the wizard - Select
this option to exit the configuration wizard without
transferring the configuration package to any
devices.

OR

Yes, transfer this package to the device(s)
selected below - Select this option to transfer
the configuration package to the selected
devices, and then from the list select the devices
to transfer to configuration package to.

This step does not apply when editing a configuration package
directly from a connected device, proceed directly to Step 17.



WorkBench Software - Section IV: Configuration Packages
IV-14

Opening an Existing Configuration Package

Once a configuration package has been created, it can be opened
for editing.

To open an existing configuration package, perform the following
steps:

1. Click the Global tab in the Navigator window.

2. Expand the 860 DSP menu tree option, then expand the
Packages menu option.  All available configuration
packages will be displayed.

3. Right-click on the configuration package to be opened, then
click Open in the floating menu.

4. The Trilithic Device Configuration Wizard window will
open.  The configuration package will be opened.  Follow
the standard configuration package process to view or
modify the individual parameters of a configuration package.

17.The Trilithic Device Configuration Wizard
Complete window will appear. Once the transfer
process is complete and you have reviewed the
actions completed by the configuration wizard click

the  button.
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Creating a Configuration Package from an Existing Package

Once you have created one configuration package, you can use it as the basis for creating
additional configuration packages.

To create a new configuration package from an existing package, perform the following steps:

1. Perform one of the following steps to create a new configuration package:

From the File menu, hover over New, and then select Configuration Package.

OR

From the Toolbar click on the  button and then select Configuration Package.

OR

From the  tab,  right-click on Packages, and then select New Configuration
Package.

2. Click the Next button to display the Device
Configuration Wizard Getting Started screen.

3. Select the radio button corresponding to  Existing
configuration then click the Next button.
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Configuration packages are defined by the following icons:

4. Select the configuration package from which to load
information and click Next.

You may load information applicable for all devices (such as
channel plans) from any configuration package (device specific or
not) to create a new configuration package (device specific or not).

Option Description

The configuration package contains no device parameters and
therefore may be applied to all devices.

The configuration package contains device parameters relevant only
to 860 DSP and 860 DSPi hand-held devices.

The configuration package contains device parameters relevant only
to rack-mounted devices.
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5. Enter information in the fields as follows:

860 DSP/DSPi hand-held device: Select this
option to create a configuration package
including device parameters applicable to only
860 DSP(i) hand-held devices.

860 DSPh rack-mounted device: Select this
option to create a configuration package
including device parameters applicable to only
860 DSPh rack-mounted devices.

All 860 DSP devices: Select this option to
create a configuration package excluding
device parameters that is applicable to all 860
DSP devices.

6. Enter information in the fields as follows:

Load all configuration data: Select this option
(the default) to load all the configuration data—
files and parameters—from the selected
configuration package.

Load only the selected types of
configuration data: Select this option if you
want to load only certain types of information
from the configuration package. Check the box
for each category you wish to include. All other
parameter information in the Configuration
Wizard will be set to the standard defaults.

If configuration packages are being created across different
types of devices (such as from an 860 DSPi to an 860 DSPh),
the Load All Configuration Data option and the Device Settings
option will not be available.

7. When you are satisfied with your entries, click Next. The 860 DSP Configuration Wizard
continues with the creation process as described earlier for either 860 DSP(i) hand-held
devices or 860 DSPh rack-mounted devices.
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Modifying a Configuration Package

You can modify a configuration package as follows:

1. Click the Global tab on the Navigator window.  The configuration packages for the
selected device will be shown in the display tree.

2. Double-click the configuration package to be modified.

3. Follow the standard configuration package process to modify a configuration package.

Deleting a Configuration Package

To delete a configuration package, do the following:

1. Click the Global tab on the Navigator window.  The configuration packages for the
selected device will be shown in the display tree.

2. Select the Configuration Packages icon then right-click the configuration package to be
deleted.

3. Select Delete from the floating menu.  WorkBench asks you to confirm your deletion. Click
 Yes to delete the configuration package.

The configuration package that is being modified can be saved
with a new file name to create a new configuration package.
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Directly Modifying the Configuration of a Device

You can make a modification directly to the configuration of an 860 DSP as follows:

1. Connect the 860 DSP to the WorkBench computer. If more than one 860 DSP is
connected to the WorkBench computer, select the desired device from the list of available
devices shown on the Devices tab.

If you have multiple devices connected, the Configuration
Wizard toolbar button and the menu items will be grayed out
until a single device has been selected on the Devices tab.

2. Right-click on the 860 DSP in the Devices menu,
select Configure, then select Configuration
Wizard from the sub-menu. (You can also start the
Configuration Wizard by right-clicking a device
name in the Devices tab of the Navigator window
and then selecting Configure from the floating
menu and then Configuration Wizard from the
sub-menu.) The WorkBench software uploads the
configuration information from the 860 DSP.

If you want to examine and change only a few items, from the
device’s menu, select the individual parameter group to modify.
You can also synchronize the device’s date and time with the
WorkBench computer or reboot the connected device.

3. When the Configuration Wizard is done uploading information from the 860 DSP, you see
the General Device Parameters screen as usual. The defaults are taken from the
configuration of the 860 DSP.

4. Follow the standard configuration package process to modify a configuration package.
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5. At the end of the process WorkBench will download
the configuration information to the selected device.

6. When the file transfer is completed, WorkBench will
display a window indicating that the Configuration
Wizard has completed the file transfer.

7. Click the Finish button to close the Configuration
Wizard window.
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Downloading Individual Files to a Device

You can download individual channel plans, locations, macros, and text files to a device. This is
very convenient if you need to do a quick addition to an device’s configuration and do not need to
or want to create or modify an entire configuration package.

To download individual files to a device, do the following:

1. Click the Global tab on the Navigator window.

2. Select the file(s) you want to download in the Local Files branch of the file tree.

3. Right-click the file and select Transfer to Device from the floating menu.

4. If only one device is connected, the file is downloaded immediately.  If there is more than
one device connected, the appropriate Transfer window will appear (a sample Transfer
Locations window is shown below).

5. Select the check box(es) corresponding to the
files to be transferred, and select the check
box(es) corresponding to the devices to
transfer the files to.

6. Click the Transfer button to transfer the
selected file(s) from WorkBench to the selected
device(s).
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Overview

The configuration parameters shown in this chapter apply to any 860 DSP or 860 DSPi. These
settings are presented in same order in which they would be configured while creating a
configuration package with the Configuration Wizard.

The 860 DSP or 860 DSPi can be configured with various tuning and measurement parameters
that match the particular characteristics of your cable network.  WorkBench simplifies this process
using the familiar user interface of your PC.  The configuration packages can be stored and
transferred to multiple 860 DSP or 860 DSPi field analyzers so every field service technician has
the same correct configuration package.

3. 860 DSP and 860 DSPi
Configuration Parameters

Chapter 3
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Editing Configuration Packages

Perform the following steps to modify the current configuration package on any connected 860
DSP or 860 DSPi:

1. Select the name of the connected 860 DSP or 860 DSPi from the  tab.

2. Perform one of the following steps to edit the configuration package on the selected 860
DSP or 860 DSPi:

From the Toolbar click on the down arrow next to the   button and then select
Configuration Wizard.

OR

From the  tab,  right-click on the name of the connected device, hover over
Configure, and then click on Configuration Wizard.

Devices Tab

3. WorkBench will now load the existing configuration from the connected 860 DSP or 860
DSPi and will then display the General Device Parameters window.

4. Edit the configuration parameters for the 860 DSP and 860 DSPi  as shown later in this
chapter and then return to Step 9 in Chapter 1: Creating Configuration Packages,
Creating a New Configuration Package for instruction on how to complete the
configuration package.

Toolbar
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3. The corresponding configuration parameter window will appear, make any desired

changes and then select the   button to send the configuration parameter that you

chose to modify to the connected 860 DSP or 860 DSPi or select the  button to
exit without changing the configuration parameter.

4. After the transfer process is complete, select the  button.

Editing Configuration Parameters

Each of the configuration parameters shown in this chapter can be edited individually from any
connected 860 DSP or 860 DSPi as follows:

1. Select the name of the connected 860 DSP or 860 DSPi from the  tab.

2. Perform one of the following steps to edit individual configuration parameters on the
selected 860 DSP or 860 DSPi:

From the Toolbar click on the down arrow next to the   button and then select the
configuration parameter that you wish to edit.

OR

From the  tab,  right-click on the name of the connected device, hover over
Configure, and then select the configuration parameter that you wish to edit.

Devices Tab

Toolbar
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General Device Parameters

General device parameters are global settings that affect
the general operation and display of the 860 DSP or 860
DSPi.  To modify the parameters for this section, select the
radio button corresponding to Modify general device
parameters as defined below in the Configuration
Wizard window then enter information in the fields as
follows:

Global Parameters

Active Channel Plan: Select the active channel plan
from the drop-down list.

Language: Select the language for the unit. (This option displays the list of languages
currently loaded in WorkBench. If no languages are loaded, the selection is normally grayed
out.)

Screen Capture Format: Select the file format in which to save screen captures (either .bmp,
.bmpz or .lcd).

Sound: Check the box to enable sound on the 860 DSP or 860 DSPi.

Web Server Port: Enter the port to check for the device.

Lock Out Setup Changes: Check this box to disable any unauthorized configuration
changes to the device.

Secure Link: Check this box to enable Secure860Link (S8L) on the 860 DSP or 860 DSPi.

Measurement Parameters

Temperature Units: Select the temperature units from the drop-down list.

Measurement Units: Select the measurement units from the drop-down list.

Distance Units: Enter the measurement units for distance from the drop-down list.

To obtain the most current language files, check for updates on
the 860 DSP website.
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Analog Noise Bandwidth: Enter the analog video noise bandwidth in MHz.

Cable Velocity Factor: Enter the cable velocity factor used for QAM equalizer and Sweep
displays.

Testpoint Compensation On: Check this box to toggle testpoint compensation.

Testpoint Compensation: Enter the testpoint compensation value in dB.

Probe Compensation: Enter the probe compensation value in dB.

Data Log Attachments: Select the attachments to associate with a data log (either none,
only locations, only tasks, or both locations and tasks).

When you are satisfied with your entries, click Next to continue with the Level Mode parameters.

Level Mode Parameters

Level mode parameters affect the behavior of the 860
DSP or 860 DSPi signal level test mode.  To modify the
parameters for this section, select the radio button
corresponding to Modify level mode parameters as
defined below in the Configuration Wizard window then
enter information in the fields as follows:

Averaging: Select the number of samples per
averaged reading from the drop-down list.

Hum Type: Select the hum type (either 50/100Hz or
60/120Hz) from the drop-down list.

Channel Spacing: Enter the channel spacing in MHz.

When you are satisfied with your entries, click Next to continue with the Scan Mode parameters.
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Scan Mode Parameters

Scan mode parameters affect the behavior of the 860
DSP or 860 DSPi channel scan test mode.  To modify the
parameters for this section, select the radio button that
corresponds to Modify scan mode parameters as
defined below in the Configuration Wizard window then
enter information in the fields as follows:

Averaging: Select the number of samples per
averaged reading from the drop-down list.

When you are satisfied with your entries, click Next to
continue with the Scan Limits parameters.

Scan Limits

Scan limits are used to validate the results of 860 DSP or
860 DSPi channel scan operations.  To modify the
parameters for this section, select the radio button
corresponding to Modify scan limits as defined below in
the Configuration Wizard window then enter information in
the fields for the Tap, Block, Set, and User scan limits as
follows:

Minimum Video Level: Enter the minimum video level.

Maximum Video Level: Enter the maximum video
level.

Minimum Video/Audio Delta: Enter the minimum video/audio delta (in dB).

Maximum Video/Audio Delta: Enter the maximum video/audio delta (in dB).

Minimum Digital Level: Enter the minimum digital level.

Maximum Digital Level: Enter the maximum digital level.

Maximum Video Delta: Enter the maximum video delta (in dB).

Maximum Adjacent Video Delta: Enter the maximum adjacent video delta (in dB).

When you are satisfied with your entries, click Next to continue with the Depth of Modulation
Mode parameters.
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Depth of Modulation Mode Parameters

The depth of modulation mode parameters affect the
behavior and display of the 860 DSP or 860 DSPi depth
of modulation test mode.  To modify the parameters for this
section, select Modify depth of modulation mode
parameters as defined below, then enter information in
the fields as follows:

Optimal: Enter the optimal depth of modulation
percentage.

When you are satisfied with your entries, click Next to
continue with the CSO/CTB Mode parameters.

CSO/CTB Mode Parameters

The CSO/CTB mode parameters affect the behavior and
display of the 860 DSP or 860 DSPi CSO/CTB test mode.
To modify the parameters for this section, select the radio
button corresponding to Modify CSO/CTB mode
parameters as defined below in the Configuration
Wizard window then enter information in the fields as
follows:

Span: Enter the span frequency (in MHz).

Type: Select the type from the drop-down list for Offset
1 through Offset 5.

Frequency: Enter the frequency (in MHz) for Offset 1 through Offset 5.

When you are satisfied with your entries, click Next to continue with the Forward Sweep Mode
parameters.

The span frequency should be wide enough to include all
offsets.
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Forward Sweep Mode Parameters

The forward sweep mode parameters affect the behavior
and display of the 860 DSP or 860 DSPi forward sweep
test mode.  To modify  the parameters for this section,
select the radio button corresponding to Modify forward
sweep mode parameters as defined below in the
configuration window then enter information in the fields as
follows:

Averaging: Select the number of samples per
averaged reading from the drop-down list.

8300 FST Channels: Select this check box to
incorporate the headend transmitter into the sweep.

Name: Enter the name for Test Points 1 through 9. The name can be up to 30 characters.

Low Pilot Nominal: Enter the low pilot nominal parameter for Test Points 1 through 9.

High Pilot Nominal: Enter the high pilot nominal parameter for Test Points 1 through 9.

TAP (Offset): Enter the offset (in dB) for Test Points 1 through 9.

When you are satisfied with your entries, click Next to continue with the QAM Mode parameters.

QAM Mode Parameters

The QAM mode parameters affect the behavior and
display of the 860 DSP or 860 DSPi QAM test mode.  To
modify the parameters for this section, select the radio
button corresponding to Modify QAM mode parameters
as defined below in the Configuration Wizard then enter
information in the fields as follows:

Symbols Per Refresh: Enter the number of symbols
to display on the 860 DSP or 860 DSPi screen at one
time. The symbols will appear darker with higher
numbers, but the screen will refresh less frequently.

Display: Select the display mode from the drop-down
list. MER is Modulation Error Ratio and is shown in dB. EVM is Error Vector Magnitude and is
shown in %.

When you are satisfied with your entries, click Next to continue with the Web Browser
parameters.
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Web Browser Parameters

The web browser parameters affect the behavior and
display of the 860 DSP or 860 DSPi web content viewer.
To modify  the parameters for this section, select the radio
button corresponding to Modify web browser
parameters as defined below in the Configuration
Wizard window then enter information in the fields as
follows:

Home Page: Enter the URL for the browser home
page (the page that appears when the browser is
started).  This is also the page that’s loaded when
Browser Home is pressed on the 860 DSP or 860
DSPi.

Link Title: Up to six user-defined web site titles are shown on the default web page.

Link Address: Up to six user-defined web sites are loaded when the link title is pressed on
the default web page.

Save Cookies: Select this option to retain web page cookies.

Display URL Bar: Select this option to display the URL bar on the browser.

Display Status Bar: Select this option to display the status bar on the browser.

Display Softkey Bar: Select this option to display the softkey bar on the browser.

Display Title Bar: Select this option to display the title bar on the browser.

Restore Default Home Page: Click this button to restore the Trilithic default home page in
the Home Page field.

When you are satisfied with your entries, click Next to continue with the Network Test parameters.
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Network Parameters

The network test parameters configure the connectivity of
the 860 DSP or 860 DSPi.  To modify  the parameters for
this section, select the radio button corresponding to
Modify network parameters as defined below in the
Configuration Wizard window then enter information in the
fields as follows:

Connectivity Parameters

Network Port: The 860 DSP or DSPi only has one
network interface card (NIC).  You must select which
physical port to connect the NIC to for communication.

IP Address: Enter the IP address of the 860 DSP or 860 DSPi.

Subnet Mask: Enter the subnet mask of the 860 DSP or 860 DSPi.

Default Gateway: Enter the gateway the 860 DSP or 860 DSPi needs to use.

Preferred DNS Server: Enter the preferred DNS server’s IP address.  (This field is required
if trap destinations are set as text instead of IP addressed.)

Alternate DNS Server: Enter the alternate DNS server’s IP address.  (This field is required if
trap destinations are set as text instead of IP addressed.)

Wi-Fi Parameters

Enter the following parameters for Wi-Fi Zones 1 through 3:

SSID: Enter the name of the Wi-Fi access point.

Network Type: Select from Infrastructure (normal routing) or Ad Hoc (point-to-point
routing).

Ad Hoc Channel: When in Ad Hoc network mode, select the wireless channel (1 through 11).

Region Code: Select the region (country) where the 860 DSP or 860 DSPi will be used.

Security Type: Set the Security Type to match your Wi-Fi access point’s security settings.

Authentication: Set the Authentication to match your Wi-Fi access point’s security settings.

Key: Set the Key to match your Wi-Fi access point’s security settings.

When you are satisfied with your entries, click Next to continue with the Network Test parameters.
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Network Test Parameters

The network test parameters configure the Ping and
Throughput menus of the 860 DSP or 860 DSPi.  To
modify  the parameters for this section, select the radio
button corresponding to Modify network test
parameters as defined below in the Configuration
Wizard window then enter information in the fields as
follows:

Ping Parameters

Host Name or IP: Enter the server IP address to ping.

Packet Delay: Enter the time between the start of the query packets being transmitted.

Packet Size: Enter the size of the payload in each packet.

Favorite Host Name or Description: Up to four user-defined servers are listed to ping.
Enter the host name of the server (or a description when entering an IP address).

Favorite IP: Up to four user-defined servers are listed to ping. Enter the IP address of the
server.

Only a valid host name or a valid IP address is required.  When
using an IP address, you can enter an optional description of
the server.

Throughput Parameters
Server IP: Enter the server IP address to transfer a file from.

Downstream File: Enter the name of the file to download from the server.

HTTP Port: Enter the connection port on the Test Server to measure throughput.

TFTP Port: Enter the connection port on the Test Server to measure throughput.

UDP Port: Enter the connection port on the Test Server to measure throughput.

When you are satisfied with your entries, click Next to continue with the Return parameters.
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Return Parameters

The return parameters configure the SSR and RSVP
menus of the 860 DSP or 860 DSPi.  To modify  the
parameters for this section, select the radio button
corresponding to Modify return parameters as defined
below in the Configuration Wizard window then enter
information in the fields as follows:

SSR Parameters

Tx Level: Enter the return test carrier level.

Link Frequency: Enter the telemetry stream data
carrier frequency from the SST.

Sweep Carrier: Select any combination of the eight carriers to use.

Gain/Tilt Frequency: Select the two carriers to be used for gain and tilt value calculations.

Unit ID: Enter the unit ID.  (Any SST can handle six units at the same time. Each unit must
have a unique ID.)

Local Input: Select the input (Reverse/Both or SLM/Forward) to be used when measuring
local ingress.  (This is used in compare mode only.)

RSVP Parameters

Tx Level: Enter the maximum return carrier level.

Link Frequency: Enter the telemetry stream data carrier frequency from the SST.

Test Carrier: Select any combination of the eight carriers to use.

C/I Threshold: Enter the minimum-carrier-to-ingress ratio to pass the test.

C/I Bandwidth: Enter the bandwidth used for the carrier-to-ingress calculation.

C/I Samples: Enter the number of ingress scans for the carrier-to-ingress calculation.

When you are satisfied with your entries, click Next to continue with the VoIP parameters.
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VoIP Parameters

The VoIP parameters affect the behavior of the 860 DSP
or 860 DSPi VoIP test mode.  To modify  the parameters
for this section, select the radio button corresponding to
Modify VoIP parameters as defined below in the
Configuration Wizard window then enter information in the
fields as follows:

Server IP: Enter the IP address of the Trilithic VoIP
(ACTS) server.

CODEC Type: Enter the type of codec used for your
VoIP traffic, such as G.711.

CODEC Delay: This display-only field shows the fixed delay using the selected codec.

CODEC Bit Rate: This display-only field shows the raw bit rate required to send voice data
using the selected codec.

CODEC Pkt Rate: Enter the rate that voice packets will be transmitted.

CODEC Pkt Size: Enter the size of each voice packet.  (Note: Packet size in bits * Packet
rate = Bit rate.)

Jitter Buffer Delay: Enter the length of the jitter buffer in milliseconds to be used by voice
receivers.

Call Length: Enter the length (in seconds) of the call in seconds to establish.

Max Latency: Enter the maximum allowable latency required for the test to pass.

Max Jitter: Enter the maximum allowable jitter required for the test to pass.

Min MOS: Enter the minimum MOS required for the test to pass.

When you are satisfied with your entries, click Next to continue with the Telemetry Search
parameters.
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Telemetry Search Parameters

Telemetry search parameters configure SSR and RSVP
modes to search for SST-9581R4 devices to facilitate
remote monitoring.  To modify the parameters for this
section, select the radio button corresponding to Modify
telemetry search parameters as defined below in the
Configuration Wizard window then enter information in the
fields as follows:

Telemetry Search Parameters
Signaling Frequency: Enter the frequency used to
determine the connected headend unit.

SSR Search: Check the box to enable searching the Return Telemetry Frequencies in SSR
mode.

RSVP Search is not currently used and is reserved for future
use.

RSVP Search: Check the box to enable searching the Return Telemetry Frequencies in
RSVP mode.

SSR Search is valid for SST-9581 R4 Normal Mode only.

Return Telemetry Frequencies
Frequency: Enter up to ten frequencies to search for SST-9581R4 devices.

When you are satisfied with your entries, click Next to continue with the FDR Mode parameters.



WorkBench Software - Section IV: Configuration Packages
IV-37

FDR Mode Parameters

Frequency domain reflectometer (FDR) parameters allow
the velocity of propagation (VOP) to be set for each type of
cable when in FDR mode.  To modify the parameters for
this section, select the radio button corresponding to
Modify FDR mode parameters as defined below in the
Configuration Wizard window then enter information in the
fields as follows:

RG-59: Enter the velocity of propagation, as a
percentage, for the tested RG-59 cable.

RG-6: Enter the velocity of propagation, as a
percentage, for the tested RG-6 cable.

RG-11: Enter the velocity of propagation, as a percentage, for the tested RG-11 cable.

Semi-Rigid: Enter the velocity of propagation, as a percentage, for the tested semi-rigid
cable.

Hardline: Enter the velocity of propagation, as a percentage, for the tested hardline cable.

When you are satisfied with your entries, click Next to continue with the Navigation Menus.
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Navigation Menus

You can customize the 860 DSP or 860 DSPi navigation
menus to better fit the way your field technicians operate.
To modify the parameters for this section, select Modify
navigation menus as defined below, then enter
information in the fields as follows:

Menus

Select the page of the menu that appears on the 860
DSP 860 DSPi. The right pane of the screen shows the
items that will appear on the navigation menu for that
page.

Insert Navigation Item: Click this to display a list of the options that can be displayed on
the menu. Items that are already displayed on the menu are grayed out.

Remove Selected Item: Click this to remove the highlighted item in the right pane of the
screen from that navigation menu.

Shift Item Position: Click the previous and next buttons to shift the position of the
highlighted item.

You can add and remove items from each menu. You cannot have the same item on multiple
pages. The menu options will appear on the 860 DSPr on the pages and in the order you
specify.

This feature can be very powerful for customizing the 860 DSP
or 860 DSPi for a particular application or set of installation
options. Although the default menus are good for most general
applications, you may be able to save time and effort by creating
customized navigation menus for the 860 DSP or 860 DSPi that
most accurately reflect the needs of your users.

Macro Shortcuts

Shortcut: Five user-defined shortcuts to quickly launch an auto-test macro directly from a
menu.

When you are satisfied with your entries, click Next to continue with Select Channel Plans.



WorkBench Software - Section IV: Configuration Packages
IV-39

Select Channel Plans

You use this screen to select the channel plans that will be
included in the configuration package for downloading to
the 860 DSP or 860 DSPi. To modify the parameters for
this section, select Include the selected channel plans
in this configuration, then check the boxes for the
channel plans you want to include.

When you are satisfied with your entries, click Next to
continue with Select Locations.

Select Locations

You use this screen to select the locations that will be
included in the configuration package for downloading to
the 860 DSP or 860 DSPi. To modify the parameters for
this section, select Include the selected locations in
this configuration, then check the boxes for the locations
you want to include.

When you are satisfied with your entries, click Next to
continue with Select Auto-Test Macros.

Select Auto-Test Macros

You use this screen to select the macros that will be
included in the configuration package for downloading to
the 860 DSP or 860 DSPi. To modify the parameters for
this section, select Include the selected auto-test
macros in this configuration, then check the boxes for
the macros you want to include.

When you are satisfied with your entries, click Next to
continue with Select Text Files.
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Select Text Files

You use this screen to select the text files that will be
included in the configuration package for downloading to
the 860 DSP or 860 DSPi. To modify the parameters for
this section, select Include the selected text files in this
configuration, then check the boxes for the text files you
want to include.

When you are satisfied with your entries, click Next to
continue with Package Transfer Mode.

Package Transfer Mode

You use this screen to tell WorkBench how to transfer
information to the 860 DSP or 860 DSPi. Select one of the
two following options to transfer files and information in the
configuration package to the 860 DSP or 860 DSPi:

Add Selected Items - Select this option (the default) to
transfer the files and information in the configuration
package without deleting existing files. Files with the
same name will be overwritten, but files that are not
included in the configuration package will not be deleted.

Add Selected Items and Delete All Other Items -
Select this option to transfer the information in the
configuration package to the 860 DSP or 860 DSPi and delete any other files on the 860 DSP
or 860 DSPi. At the end of the transfer process, the only files and information on the 860 DSP
or 860 DSPi will be the files and information contained in the configuration package. This
option is useful for ensuring that 860 DSP’s or 860 DSPi’s are configured to a standard and
that no unauthorized or unacceptable files are included on them.

Selecting the second option may delete information from the 860 DSP
or DSPi. Ensure that the files in the 860 DSP or DSPi are backed up
and that the configuration package being loaded is complete.
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When you are satisfied with your entries, click Next to continue with the Additional Configuration
Options.

Additional Configuration Options

This screen lets you perform a few additional configuration
tasks when you download the configuration package to the
860 DSP or 860 DSPi. To modify the parameters for this
section, enter information in the fields as follows:

Set Date/Time: Check this box to synchronize the 860
DSP or 860 DSPi’s clock to the clock on the
WorkBench computer.

Format Data File System: Check this box to reformat
the 860 DSPr’s flash disk prior to transferring the
selected files. This option may be desired for periodic
maintenance, but is not necessary (and probably
should not be performed) each time a device is configured. This option is only available if you
have selected Add Selected Items and Delete All Other Items on the Packet Mode Transfer
screen shown in the previous step.

Reboot Device: Check this box to reboot the 860 DSP or 860 DSPi after the configuration
package has been downloaded. Some options require the 860 DSP or 860 DSPi to be
rebooted for the options to be applied.

When you are satisfied with your entries, click Next to transfer the configuration package to the
selected 860 DSP or 860 DSPi.

The Transfer Configuration Package window will appear,
indicating the progress of the configuration transfer to the
connected 860 DSP or 860 DSPi.
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After the configuration package has been transferred to
the 860 DSP or 860 DSPi, the Device Configuration
Wizard Complete window will be displayed.

Click the Finish button to close the Configuration
Wizard.
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4. 860 DSPh Configuration
Parameters

Chapter 4

Overview

The configuration parameters shown in this chapter apply to any 860 DSPh. These settings are
presented in same order in which they would be configured while creating a configuration
package with the Configuration Wizard.

The 860 DSPh is configured to tune and measure according to the particular characteristics at the
location in which it is installed.  WorkBench simplifies this process using a familiar, intuitive user
interface.  To save programming and configuration time, the configuration package can be saved,
edited, and transferred to other 860 DSPh analyzers.
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3. The corresponding configuration parameter window will appear, make any desired

changes and then select the   button to send the configuration parameter that you

chose to modify to the connected 860 DSPh or select the  button to exit without
changing the configuration parameter.

4. After the transfer process is complete, select the  button.

Editing Configuration Parameters

Each of the configuration parameters shown in this chapter can be edited individually from any
connected 860 DSPh as follows:

1. Select the name of the connected 860 DSPh from the  tab.

2. Perform one of the following steps to edit individual configuration parameters on the
selected 860 DSPh:

From the Toolbar click on the down arrow next to the   button and then select the
configuration parameter that you wish to edit.

OR

From the  tab,  right-click on the name of the connected device, hover over
Configure, and then select the configuration parameter that you wish to edit.

Devices TabToolbar
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Editing Configuration Packages

Perform the following steps to modify the current configuration package on any connected 860
DSPh:

1. Select the name of the connected 860 DSPh from the  tab.

2. Perform one of the following steps to edit the configuration package on the selected 860
DSPh:

From the Toolbar click on the down arrow next to the   button and then select
Configuration Wizard.

OR

From the  tab,  right-click on the name of the connected device, hover over
Configure, and then click on Configuration Wizard.

Devices Tab

3. WorkBench will now load the existing configuration from the connected 860 DSPh and will
then display the General Device Parameters window, proceed to the following section to
edit the configuration packages.

Toolbar
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General Device Parameters

The general device parameters are global settings that
affect the general operation and display of the 860 DSPh.
To modify  the parameters for this section, select the radio
button corresponding to Modify general parameters as
defined below in the Configuration Wizard window then
enter information in the fields as follows:

Beeps: Check this box to turn SNMP trap beeps  on or
off.

Volume: Enter the volume from 0 to 9 (0 = off; 9 =
maximum) for FM Deviation measurements.

Auto Reboot: Enter the number of days the unit will operate for before automatically
rebooting. (Enter 0 to turn off automatic rebooting.)

Temperature Units: Select Celsius or Fahrenheit.

Lock Out Telnet Changes: Select this check box to disable change to the device
configuration via a Telnet connection.

When you are satisfied with your entries, click Next to continue with the Network parameters.

Network Parameters

The network parameters configure the connectivity of the
860 DSPh.  To modify  the parameters for this section,
select the radio button corresponding to Modify network
parameters as defined below in the Configuration
Wizard window then enter information in the fields as
follows:

Connectivity
IP Address: Enter the IP address of the 860 DSPh.

Subnet Mask: Enter the subnet mask of the 860
DSPh.

Default Gateway: Enter the gateway the 860 DSPh needs to use.

Preferred DNS Server: Enter the preferred DNS server’s IP address.  (This field is required
if trap destinations are set as text instead of IP addressed.)
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Alternate DNS Server: Enter the alternate DNS server’s IP address.  (This field is required if
trap destinations are set as text instead of IP addressed.)

Web Server Port: Enter the remove control network port (the default port is 80.)

COM1 Baud Rate: Select the COM1 baud rate.

COM2 Baud Rate: Select the COM2 baud rate.

Logins

Master Username: Enter the master username.

Master Password: Enter the master password.

Web Username: Enter the web browser username.

Web Password: Enter the web browser password.

Telnet Username: Enter the telnet username.

Telnet Password: Enter the telnet password.

User 1 Username: Enter the User1 username.

User 1 Password: Enter the User1 password.

User 2 Username: Enter the User2 username.

User 2 Password: Enter the User2 password.

User 3 Username: Enter the User3 username.

User 3 Password: Enter the User3 password.

When you are satisfied with your entries, click Next to continue with the Measurement
parameters.
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SNMP Parameters

The SNMP parameters configure trap receiving and
MIB browsing of the 860 DSPh.  To modify  the
parameters for this section, select Modify SNMP
parameters as defined below, then enter information
in the fields as follows:

SNMP Parameters
System Contact: Enter the name of the person
responsible for this device.

System Name: Enter the name of the system.

System Location: Enter the location of the system.

Trap Resend: Enter the time between resending of alarms in case the packets are being lost
on the network.  This is also the time between the unit sending “Hello, I’m alive” messages.

Measurement Parameters

The measurement parameters affect the behavior and
display of acquired data by the 860 DSPh.  To modify  the
parameters for this section, select the radio button
corresponding to Modify measurement parameters as
defined below from the Configuration Wizard window
then enter information in the fields as follows:

Measurement Units: Select the measurement unit
from the drop-down list. You can select dBmV, dBuV, or
dBm.

Analog Noise Bandwidth: Enter the bandwidth used
for carrier-to-noise calculations.

Averaging: Select from the drop-down list the number of times data is averaged before
reading (1 to 1024).

Optimal Depth of Modulation: Enter the percentage for the optimal depth of modulation.

Hum Type: Select the hum type (either 50/100Hz or 60/120Hz) from the drop-down list.

When you are satisfied with your entries, click Next to continue with the SNMP Parameters.
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User 1 to 8

There are eight identical groups of fields for setting up users.  Each user can set up their
parameters for accessing the SNMP data as well as the format of the SNMP trap.

Version: Select the SNMP option (SNMPV1, SNMPV2c, or SNMPV3_USM) used by the
SNMP monitoring software from the drop-down list.  Unused User (the default) identifies that
this is not an active user.

The 860 DSPh only ships from the factory with SNMPV1.
SNMPV2c and SNMPV3_USM require a firmware update,
contact the Trilithic Applications department to obtain this
optional  firmware.

Name/Community: Enter the user or community name.

Authorization Type: Select the authorization type from the drop-down list. (Authorization and
privacy options are used for secure SNMP access.)

Authorization Password: Enter the authorization password for this user.

Privacy Type: Select the privacy type from the drop-down list.

Privacy Password: Enter the privacy password for this user.

Read Only: Select this check box to make the SNMP values read only for this user

Trap Destination: Enter IP address of the trap destination.

When you are satisfied with your entries, click Next to continue with the Input parameters.

SNMP MIB is available for your SNMP Management Software, if
needed contact the Trilithic Applications department .



WorkBench Software - Section IV: Configuration Packages
IV-50

Input Parameters

The input parameters define the testing procedures of the
860 DSPh. To modify the parameters for this section,
select Modify input parameters as defined below, then
enter information in the fields as follows:

Input
Select the measurement input for which you want to set
test limits. The right pane of the screen shows the limits
defined for the selected input.

Name: Enter the name of the input.

Channel Plan: Enter the name of the channel plan used for this input.

Compensation: Enter the test point loss value in this input is connected through a test point
or pad.

Limits
The following options are related to analog channels:

Video Min: Enter the minimum acceptable video level.

Video Max: Enter the maximum acceptable video level.

Video Delta: Enter the video level drift.

Video/Audio Min Delta: Enter the minimum acceptable video-to-audio difference.

Video/Audio Max Delta: Enter the maximum acceptable video-to-audio difference.

The following options are related to digital channels:

Digital Min: Enter the minimum acceptable digital carrier level.

Digital Max: Enter the maximum acceptable digital carrier level.

Digital Delta: Enter the maximum.

The following options are used for analog channels:

Min Depth Of Modulation: Enter the minimum depth of modulation.

Max Depth Of Modulation: Enter the maximum depth of modulation.

Max Hum: Enter the maximum allowable hum.

Min C/N: Enter the minimum carrier-to-noise ratio.
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The following options are used for digital channels:

QAM4 Min MER: Enter the QAM4 minimum modulation error ratio.

QAM16 Min MER: Enter the QAM16 minimum modulation error ratio.

QAM32 Min MER: Enter the QAM32 minimum modulation error ratio.

QAM64 Min MER: Enter the QAM64 minimum modulation error ratio.

QAM128 Min MER: Enter the QAM128 minimum modulation error ratio.

QAM256 Min MER: Enter the QAM256 minimum modulation error ratio.

VSB8 Min MER: Enter the ATSC (8 VSB) minimum modulation error ratio.

Max BER: Enter the maximum allowable bit error rate.

The following options are used for analog channels:

Min FM Deviation: Enter the minimum FM deviation.

Max FM Deviation: Enter the maximum FM deviation.

When you are satisfied with your entries, click Next to continue with the Select Channel
parameters.

Select Channel Plans

You use this screen to select the channel plans that will be
included in the configuration package for downloading to
the 860 DSPh. To modify the parameters for this section,
select Include the selected channel plans in this
configuration, then check the boxes for the channel plans
you want to include.

When you are satisfied with your entries, click Next to
continue with Package Transfer Mode.
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Package Transfer Mode

You use this screen to tell WorkBench how to transfer
information to the 860 DSPh. Select one of the two
following options to transfer files and information in the
configuration package to the 860 DSPh:

Add Selected Items - Select this option (the default) to
transfer the files and information in the configuration
package without deleting existing files. Files with the
same name will be overwritten, but files that are not
included in the configuration package will not be
deleted.

Add Selected Items and Delete All Other Items -
Select this option to transfer the information in the configuration package to the 860 DSPh and
deletes any other files on the 860 DSPh. At the end of the transfer process, the only files and
information on the 860 DSPh will be the files and information contained in the configuration
package. This option is useful for ensuring that 860 DSPh’s are configured to a standard and
that no unauthorized or unacceptable files are included on them.

Selecting the second option may delete information from the
860 DSPh. Ensure that the files in the 860 DSPh are backed up
and that the configuration package being loaded is complete.

When you are satisfied with your entries, click Next to continue with the Additional Configuration
Options.
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Additional Configuration Options

This screen lets you perform a few additional configuration
tasks when you download the configuration package to the
860 DSPh. To modify the parameters for this section, enter
information in the fields as follows:

Set Date/Time: Check this box to synchronize the 860
DSPh’s clock to the clock on the WorkBench computer.

Format Data File System: Check this box to reformat
the 860 DSPh’s flash disk prior to transferring the
selected files. This option may be desired for periodic
maintenance, but is not necessary (and probably
should not be performed) each time a device is
configured. This option is only available if you have selected Add Selected Items and Delete
All Other Items on the Packet Mode Transfer screen shown in the previous step.

Reboot Device: Check this box to reboot the 860 DSPh after the configuration package has
been downloaded. Some options require the 860 DSPh to be rebooted for the options to be
applied.

When you are satisfied with your entries, click Next to
transfer the configuration package to the selected 860
DSPh.

The Transfer Configuration Package window will appear,
indicating the progress of the configuration transfer to the
connected 860 DSPh.
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After the configuration package has been transferred to
the 860 DSPh, the Device Configuration Wizard
Complete window will be displayed.

Click the Finish button to close the Configuration
Wizard.
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5. 860 DSPr Configuration
Parameters

Chapter 5

Overview

The configuration parameters shown in this chapter apply to any 860 DSPr. These settings are
presented in same order in which they would be configured while creating a configuration
package with the Configuration Wizard.

The 860 DSPr is configured to tune and measure according to the particular characteristics at the
location in which it is installed.  WorkBench simplifies this process using a familiar, intuitive user
interface.  To save programming and configuration time, the configuration package can be saved,
edited, and transferred to other 860 DSPr analyzers.
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Editing Configuration Packages

Perform the following steps to modify the current configuration package on any connected 860
DSPr:

1. Select the name of the connected 860 DSPr from the  tab.

2. Perform one of the following steps to edit the configuration package on the selected 860
DSPr:

From the Toolbar click on the down arrow next to the   button and then select
Configuration Package.

OR

From the  tab,  right-click on the name of the connected device, hover over
Configure, and then click on Configuration Wizard.

Devices Tab

3. WorkBench will now load the existing configuration from the connected 860 DSPr and will
then display the General Device Parameters window.

4. Edit the configuration parameters for the 860 DSPr as shown later in this chapter and then
return to Step 9 in Chapter 1: Creating Configuration Packages, Creating a New
Configuration Package for instruction on how to complete the configuration package.

Toolbar
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3. The corresponding configuration parameter window will appear.  Make any desired

changes and then select the   button to send the configuration parameter that you

chose to modify to the connected 860 DSPr or select the  button to exit without
changing the configuration parameter.

4. After the transfer process is complete, select the  button.

Editing Configuration Parameters

Each of the configuration parameters shown in this chapter can be edited individually from any
connected 860 DSPr as follows:

1. Select the name of the connected 860 DSPr from the  tab.

2. Perform one of the following steps to edit individual configuration parameters on the
selected 860 DSPr:

From the Toolbar click on the down arrow next to the   button and then select the
configuration parameter that you wish to edit.

OR

From the  tab,  right-click on the name of the connected device, hover over
Configure, and then select the configuration parameter that you wish to edit.

Devices TabToolbar
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General Device Parameters

General device parameters are global settings that affect
the general operation and display of the 860 DSPr.  To
modify the parameters for this section, select the radio
button corresponding to Modify general device
parameters as defined below in the Configuration
Wizard window then enter information in the fields as
follows:

Global Parameters

Active Channel Plan: Select the active channel plan
from the drop-down list.

Language: Select the language for the unit. (This option displays the list of languages
currently loaded in WorkBench. If no languages are loaded, the selection is normally grayed
out.)

Screen Capture Format: Select the file format to save screen captures in (either .bmp,
.bmpz or .lcd).

Sound: Check the box to enable sound on the 860 DSPr.

Web Server Port: Enter the port to check for the device.

Lock Out Setup Changes: Check this box to disable any unauthorized configuration
changes to the device.

Secure Link: Check this box to enable Secure860Link (S8L) on the 860 DSP or 860 DSPi.

To obtain the most current language files, check for updates on
the 860 DSP website.
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Level Mode Parameters

Level mode parameters affect the behavior of the 860
DSPr signal level test mode.  To modify the parameters for
this section, select the radio button corresponding to
Modify level mode parameters as defined below in the
Configuration Wizard window then enter information in the
fields as follows:

Averaging: Select the number of samples per
averaged reading from the drop-down list.

Hum Type: Select the hum type (either 50/100Hz or
60/120Hz) from the drop-down list.

Channel Spacing: Enter the channel spacing in MHz.

When you are satisfied with your entries, click Next to continue with the Scan Mode parameters.

Measurement Parameters

Temperature Units: Select the temperature units from the drop-down list.

Measurement Units: Select the measurement units from the drop-down list.

Distance Units: Enter the measurement units for distance from the drop-down list.

Analog Noise Bandwidth: Enter the analog video noise bandwidth in MHz.

Cable Velocity Factor: Enter the cable velocity factor used for QAM equalizer and Sweep
displays.

Testpoint Compensation On: Check this box to toggle testpoint compensation.

Testpoint Compensation: Enter the testpoint compensation value in dB.

Probe Compensation: Enter the probe compensation value in dB.

Data Log Attachments: Select the attachments to associate with a data log (either none,
only locations, only tasks, or both locations and tasks).

When you are satisfied with your entries, click Next to continue with the Level Mode parameters.
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Scan Limits

Scan limits are used to validate the results of 860 DSPr
channel scan operations.  To modify the parameters for this
section, select the radio button corresponding to Modify
scan limits as defined below in the Configuration Wizard
window then enter information in the fields for the Tap,
Block, Set, and User scan limits as follows:

Minimum Video Level: Enter the minimum video level.

Maximum Video Level: Enter the maximum video
level.

Minimum Video/Audio Delta: Enter the minimum
video/audio delta (in dB).

Maximum Video/Audio Delta: Enter the maximum video/audio delta (in dB).

Minimum Digital Level: Enter the minimum digital level.

Maximum Digital Level: Enter the maximum digital level.

Maximum Video Delta: Enter the maximum video delta (in dB).

Maximum Adjacent Video Delta: Enter the maximum adjacent video delta (in dB).

When you are satisfied with your entries, click Next to continue with the Depth of Modulation
Mode parameters.

Scan Mode Parameters

Scan mode parameters affect the behavior of the 860
DSPr channel scan test mode.  To modify the parameters
for this section, select the radio button that corresponds to
Modify scan mode parameters as defined below in the
Configuration Wizard window then enter information in the
fields as follows:

Averaging: Select the number of samples per
averaged reading from the drop-down list.

When you are satisfied with your entries, click Next to
continue with the Scan Limits parameters.
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Depth of Modulation Mode Parameters

The depth of modulation mode parameters affect the
behavior and display of the 860 DSPr depth of modulation
test mode.  To modify the parameters for this section,
select Modify depth of modulation mode parameters
as defined below, then enter information in the fields as
follows:

Optimal: Enter the optimal depth of modulation
percentage.

When you are satisfied with your entries, click Next to
continue with the CSO/CTB Mode parameters.

CSO/CTB Mode Parameters

The CSO/CTB mode parameters affect the behavior and
display of the 860 DSPr CSO/CTB test mode.  To modify
the parameters for this section, select the radio button
corresponding to Modify CSO/CTB mode parameters
as defined below in the Configuration Wizard window
then enter information in the fields as follows:

Span: Enter the span frequency (in MHz).

Type: Select the type from the drop-down list for Offset
1 through Offset 5.

Frequency: Enter the frequency (in MHz) for Offset 1
through Offset 5.

When you are satisfied with your entries, click Next to continue with the Forward Sweep Mode
parameters.

The span frequency should be wide enough to include all
offsets.
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QAM Mode Parameters

The QAM mode parameters affect the behavior and
display of the 860 DSPr QAM test mode.  To modify the
parameters for this section, select the radio button
corresponding to Modify QAM mode parameters as
defined below in the Configuration Wizard then enter
information in the fields as follows:

Symbols Per Refresh: Enter the number of symbols
to display on the 860 DSP screen at one time. The
symbols will appear darker with higher numbers, but
the screen will refresh less frequently.

Display: Select the display mode from the drop-down
list. MER is Modulation Error Ratio and is shown in dB. EVM is Error Vector Magnitude and is
shown in %.

When you are satisfied with your entries, click Next to continue with the Web Browser
parameters.

Forward Sweep Mode Parameters

Click Next to continue with the QAM Mode parameters.

The Forward Sweep Parameters configuration is a carry-over
feature from the 860 DSP and 860 DSPi field analyzer, and as such,
is not applicable to the 860 DSPr headend analyzer configuration.
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Web Browser Parameters

The web browser parameters affect the behavior and
display of the 860 DSPr web content viewer.  To modify
the parameters for this section, select the radio button
corresponding to Modify web browser parameters as
defined below in the Configuration Wizard window then
enter information in the fields as follows:

Home Page: Enter the URL for the browser home
page (the page that appears when the browser is
started).  This is also the page that’s loaded when
Browser Home is pressed on the 860 DSPr.

Link Title: Up to six user-defined web site titles are
shown on the default web page.

Link Address: Up to six user-defined web sites are loaded when the link title is pressed on
the default web page.

Save Cookies: Select this option to retain web page cookies.

Display URL Bar: Select this option to display the URL bar on the browser.

Display Status Bar: Select this option to display the status bar on the browser.

Display Softkey Bar: Select this option to display the softkey bar on the browser.

Display Title Bar: Select this option to display the title bar on the browser.

Restore Default Home Page: Click this button to restore the Trilithic default home page in
the Home Page field.

When you are satisfied with your entries, click Next to continue with the Network Test parameters.
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Network Parameters

The network test parameters configure the connectivity of
the 860 DSPr.  To modify  the parameters for this section,
select the radio button corresponding to Modify network
parameters as defined below in the Configuration
Wizard window then enter information in the fields as
follows:

Connectivity Parameters

Network Port: The 860 DSPr only has one network
interface card (NIC).  You must select which physical
port to connect the NIC to for communication.

IP Address: Enter the IP address of the 860 DSPr.

Subnet Mask: Enter the subnet mask of the 860 DSPr.

Default Gateway: Enter the gateway the 860 DSPr needs to use.

Preferred DNS Server: Enter the preferred DNS server’s IP address.  (This field is required
if trap destinations are set as text instead of IP addressed.)

Alternate DNS Server: Enter the alternate DNS server’s IP address.  (This field is required if
trap destinations are set as text instead of IP addressed.)

Wi-Fi Parameters

When you are satisfied with your entries, click Next to continue with the Network Test
parameters.

The Wi-Fi Parameters configuration is a carry-over feature from
the 860 DSP and 860 DSPi field analyzer, and as such, is not
applicable to the 860 DSPr headend analyzer configuration.
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Network Test Parameters

The network test parameters configure the Ping and
Throughput menus of the 860 DSPr.  To modify  the
parameters for this section, select the radio button
corresponding to Modify network test parameters as
defined below in the Configuration Wizard window then
enter information in the fields as follows:

Ping Parameters

Host Name or IP: Enter the server IP address to ping.

Packet Delay: Enter the time between the start of the
query packets being transmitted.

Packet Size: Enter the size of the payload in each packet.

Favorite Host Name or Description: Up to four user-defined servers are listed to ping.
Enter the host name of the server (or a description when entering an IP address).

Favorite IP: Up to four user-defined servers are listed to ping. Enter the IP address of the
server.

Only a valid host name or a valid IP address is required.  When
using an IP address, you can enter an optional description of
the server.

The Throughput Parameters configuration is a carry-over feature
from the 860 DSP and 860 DSPi field analyzer, and as such, is not
applicable to the 860 DSPr headend analyzer configuration.

Throughput Parameters

Click Next to continue with the Return parameters.
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Return Parameters

SSR Parameters

RSVP Parameters

Click Next to continue with the VoIP parameters.

The Return Parameters configuration is a carry-over feature
from the 860 DSP and 860 DSPi field analyzer, and as such, is
not applicable to the 860 DSPr headend analyzer configuration.
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VoIP Parameters

The VoIP parameters affect the behavior of the 860 DSPr
VoIP test mode.  To modify  the parameters for this
section, select the radio button corresponding to Modify
VoIP parameters as defined below in the Configuration
Wizard window then enter information in the fields as
follows:

Server IP: Enter the IP address of the Trilithic VoIP
server.

CODEC Type: Enter the type of codec used for your
VoIP traffic, such as G.711.

CODEC Delay: This display-only field shows the fixed delay using the selected codec.

CODEC Bit Rate: This display-only field shows the raw bit rate required to send voice data
using the selected codec.

CODEC Pkt Rate: Enter the rate that voice packets will be transmitted.

CODEC Pkt Size: Enter the size of each voice packet.  (Note: Packet size in bits * Packet
rate = Bit rate.)

Jitter Buffer Delay: Enter the length of the jitter buffer in milliseconds to be used by voice
receivers.

Call Length: Enter the length of the call in seconds to establish.

Max Latency: Enter the maximum allowable latency required for the test to pass.

Max Jitter: Enter the maximum allowable jitter required for the test to pass.

Min MOS: Enter the minimum MOS required for the test to pass.

When you are satisfied with your entries, click Next to continue with the Telemetry Search
parameters.
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FDR Mode Parameters

Click Next to transfer the configuration parameters to the
860 DSPr.

Telemetry Search Parameters

Telemetry Search Parameters

Return Telemetry Frequencies
Click Next to continue with the FDR Mode parameters.

The Telemetry Search Parameters configuration is a carry-over
feature from the 860 DSP and 860 DSPi field analyzer, and as such,
is not applicable to the 860 DSPr headend analyzer configuration.

The FDR Mode Parameters configuration is a carry-over feature
from the 860 DSP and 860 DSPi field analyzer, and as such, is not
applicable to the 860 DSPr headend analyzer configuration.
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Navigation Menus

You can customize the 860 DSPr navigation menus to
better fit the way your field technicians operate.  To modify
the parameters for this section, select Modify navigation
menus as defined below, then enter information in the
fields as follows:

Menus

Select the page of the menu that appears on the 860
DSPr. The right pane of the screen shows the items
that will appear on the navigation menu for that page.

Insert Navigation Item: Click this to display a list of the options that can be displayed on
the menu. Items that are already displayed on the menu are grayed out.

Remove Selected Item: Click this to remove the highlighted item in the right pane of the
screen from that navigation menu.

Shift Item Position: Click the previous and next buttons to shift the position of the
highlighted item.

You can add and remove items from each menu. You cannot have the same item on multiple
pages. The menu options will appear on the 860 DSPr on the pages and in the order you
specify.

This feature can be very powerful for customizing the 860 DSPr
for a particular application or set of installation options.
Although the default menus are good for most general
applications, you may be able to save time and effort by creating
customized navigation menus for the 860 DSPr that most
accurately reflect the needs of your users.

Macro Shortcuts

Shortcut: Five user-defined shortcuts to quickly launch an auto-test macro directly from a
menu.

When you are satisfied with your entries, click Next to continue with Select Channel Plans.
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Select Channel Plans

You use this screen to select the channel plans that will be
included in the configuration package for downloading to
the 860 DSPr. To modify the parameters for this section,
select Include the selected channel plans in this
configuration, then check the boxes for the channel plans
you want to include.

When you are satisfied with your entries, click Next to
continue with Select Locations.

Package Transfer Mode

You use this screen to tell WorkBench how to transfer
information to the 860 DSPr. Select one of the two
following options to transfer files and information in the
configuration package to the 860 DSPr:

Add Selected Items - Select this option (the default) to
transfer the files and information in the configuration
package without deleting existing files. Files with the
same name will be overwritten, but files that are not
included in the configuration package will not be
deleted.

Add Selected Items and Delete All Other Items -
Select this option to transfer the information in the configuration package to the 860 DSPr and
delete any other files on the 860 DSPr. At the end of the transfer process, the only files and
information on the 860 DSPr will be the files and information contained in the configuration
package. This option is useful for ensuring that 860 DSPr’s are configured to a standard and
that no unauthorized or unacceptable files are included on them.

When you are satisfied with your entries, click Next to continue with the Additional Configuration
Options.

Selecting the second option may delete information from the
860 DSPr. Ensure that the files in the 860 DSPr are backed up
and that the configuration package being loaded is complete.
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Additional Configuration Options

This screen lets you perform a few additional configuration
tasks when you download the configuration package to the
860 DSPr. To modify the parameters for this section, enter
information in the fields as follows:

Set Date/Time: Check this box to synchronize the 860
DSPr’s clock to the clock on the WorkBench computer.

Format Data File System: Check this box to reformat
the 860 DSPr’s flash disk prior to transferring the
selected files. This option may be desired for periodic
maintenance, but is not necessary (and probably
should not be performed) each time a device is
configured. This option is only available if you have selected Add Selected Items and Delete
All Other Items on the Packet Mode Transfer screen shown in the previous step.

Reboot Device: Check this box to reboot the 860 DSPr after the configuration package has
been downloaded. Some options require the 860 DSPr to be rebooted for the options to be
applied.

When you are satisfied with your entries, click Next to transfer the configuration package to the
selected 860 DSPr.

The Transfer Configuration Package window will appear,
indicating the progress of the configuration transfer to the
connected 860 DSPr.
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After the configuration package has been transferred to
the 860 DSPr, the Device Configuration Wizard
Complete window will be displayed.

Click the Finish button to close the Configuration
Wizard.
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6. Configuring an 8300 FST
Chapter 6

Overview

The configuration parameters shown in this chapter apply to any 8300 FST. These settings are
presented in same order in which they would be configured while creating a configuration
package with the Configuration Wizard.

You cannot save configuration packages for the 8300 FST
Forward Speed Sweep Transmitter. You can only edit the
configuration package that is on the device.

Editing Configuration Packages

Perform the following steps to modify the current configuration package on any connected 8300
FST:

1. Select the name of the connected 8300 FST from the  tab.

2. Perform one of the following steps to edit the configuration package on the selected 8300
FST:

From the Toolbar click on the down arrow next to the   button and then select
Configuration Wizard.

OR

From the  tab,  right-click on the name of the connected device, hover over
Configure, and then click on Configuration Wizard.

Devices TabToolbar
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3. WorkBench will now load the existing configuration from the connected 8300 FST and will
then display the General Device Parameters window.

4. Edit the configuration parameters for the 8300 FST as shown later in this chapter and then
return to Step 5 to complete the configuration package.

5. After proceeding through the available configuration parameters for your selected device,
the Select Channel Plans window will appear. Perform one of the following steps  to
select the channel plans to include in the configuration,
and then click the  button:

Do not include channel plans in this
configuration - Select this option to exclude channel
plans from this configuration package.

OR

Include the selected channel plans in this
configuration - Select this option to include the
selected channel plans in this configuration package,
and then from the list select the channel plans to
include.

6. The Package Transfer Mode window will appear. Perform one of the following steps to
determine how to apply the configuration package to the target device, and then click the

 button:

Add Selected Items - Select this option to transfer
the selected items to the device and leave all of its
existing items unchanged.

OR

Include Selected Items and Delete All Other
Items - Select this option to transfer the selected
items to the device and delete all existing items. This
device will only contain only those items selected in
this configuration package.

Selecting the second option may cause the channel plan,
location, macro, and text data to be deleted from the selected
devices.
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7. The Additional Configuration Options window will appear. Select from the following
additional configuration tasks to be performed when the configuration package is applied
to the selected devices, and then click the 
button:

Set Date/Time - Select this option to transfer the
date and time of the PC running the WorkBench
software to the selected devices.

Format Data File System - Not available for
selection at this time.

Reboot Device - Select this option to reboot the
selected devices after the transfer of the
configuration package is complete.

8. The Trilithic Device Configuration Wizard
Complete window will appear. Once the transfer
process is complete and you have reviewed the
actions completed by the configuration wizard click the

 button.
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3. The corresponding configuration parameter window will appear, make any desired

changes and then select the   button to send the configuration parameter that you

chose to modify to the connected 8300 FST or select the  button to exit without
changing the configuration parameter.

4. After the transfer process is complete, select the  button.

Editing Configuration Parameters

Each of the configuration parameters shown in this chapter can be edited individually from any
connected 8300 FST as follows:

1. Select the name of the connected 8300 FST from the  tab.

2. Perform one of the following steps to edit individual configuration parameters on the
selected 8300 FST:

From the Toolbar click on the down arrow next to the   button and then select the
configuration parameter that you wish to edit.

OR

From the  tab,  right-click on the name of the connected device, hover over
Configure, and then select the configuration parameter that you wish to edit.

Devices Tab

Toolbar
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General Device Parameters

General device parameters are global settings that affect
the general operation and display of the 8300 FST.  To
modify the parameters for this section, select the radio
button corresponding to Modify general device
parameters as defined below in the Configuration
Wizard window then enter information in the fields as
follows:

Active Channel Plan: Select the active channel plan
from the drop-down list.

Sweeping On: Select this check box to turn on
forward sweeping for the 8300 FST.

Auto Reboot: Set the frequency, in days, with which the 8300 FST will automatically reboot.

When you are satisfied with your entries, click Next to continue with the Network parameters.
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Network Parameters

The network test parameters configure the connectivity of
the 8300 FST.  To modify  the parameters for this section,
select the radio button corresponding to Modify network
parameters as defined below in the Configuration
Wizard window then enter information in the fields as
follows:

Connectivity Parameters

IP Address: Enter the IP address of the 8300 FST.

Subnet Mask: Enter the subnet mask of the 8300
FST.

Default Gateway: Enter the gateway the 8300 FST needs to use.

Preferred DNS Server: Enter the preferred DNS server’s IP address.  (This field is required
if trap destinations are set as text instead of IP addressed.)

Alternate DNS Server: Enter the alternate DNS server’s IP address.  (This field is required if
trap destinations are set as text instead of IP addressed.)

Login Parameters

Master Username: Enter the username you will use to log in to the 8300 FST via the built-in
web server.

Master Password: Enter the username you will use to log in to the 8300 FST via the built-in
web server.

When you are satisfied with your entries, click Next to continue with the SNMP parameters.
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SNMP Parameters

The SNMP parameters configure the accessibility of the
8300 FST.  To modify  the parameters for this section,
select the radio button corresponding to Modify SNMP
parameters as defined below in the Configuration
Wizard window then enter information in the fields as
follows:

Read Community: Enter the SNMP password for
reading data.

Write Community: Enter the SNMP password for
writing data.

Trap Destination: Enter the IP address of the SNMP management program server that
WorkBench will communicate with.

When you are satisfied with your entries, click Next to continue with Select Channel Plans.

Select Channel Plans

You use this screen to select the channel plans that will be
included in the configuration package for downloading to
the 8300 FST. To modify the parameters for this section,
select Include the selected channel plans in this
configuration, then check the boxes for the channel plans
you want to include.

When you are satisfied with your entries, click Next to
continue with Package Transfer Mode.



WorkBench Software - Section IV: Configuration Packages
IV-80

Package Transfer Mode

You use this screen to tell WorkBench how to transfer
information to the 8300 FST. Select one of the two
following options to transfer files and information in the
configuration package to the 8300 FST:

Add Selected Items - Select this option (the default) to
transfer the files and information in the configuration
package without deleting existing files. Files with the
same name will be overwritten, but files that are not
included in the configuration package will not be
deleted.

Add Selected Items and Delete All Other Items -
Select this option to transfer the information in the configuration package to the 8300 FST and
delete any other files on the 8300 FST. At the end of the transfer process, the only files and
information on the 8300 FST will be the files and information contained in the configuration
package. This option is useful for ensuring that 8300 FSTs are configured to a standard and
that no unauthorized or unacceptable files are included on them.

When you are satisfied with your entries, click Next to continue with the Additional Configuration
Options.

Selecting the second option may delete information from the
8300 FST. Ensure that the files in the 8300 FST are backed up
and that the configuration package being loaded is complete.
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Additional Configuration Options

This screen lets you perform a few additional configuration
tasks when you download the configuration package to the
8300 FST. To modify the parameters for this section, enter
information in the fields as follows:

Set Date/Time: Check this box to synchronize the
8300 FST’s clock to the clock on the WorkBench
computer.

Format Data File System: Check this box to reformat
the 8300 FST’s flash disk prior to transferring the
selected files. This option may be desired for periodic
maintenance, but is not necessary (and probably
should not be performed) each time a device is configured. This option is only available if you
have selected Add Selected Items and Delete All Other Items on the Packet Mode Transfer
screen shown in the previous step.

Reboot Device: Check this box to reboot the 8300 FST after the configuration package has
been downloaded. Some options require the 8300 FST to be rebooted for the options to be
applied.

When you are satisfied with your entries, click Next to transfer the configuration package to the
selected 8300 FST.

The Transfer Configuration Package window will appear,
indicating the progress of the configuration transfer to the
connected 8300 FST.
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After the configuration package has been transferred to
the 8300 FST, the Device Configuration Wizard
Complete window will be displayed.

Click the Finish button to close the Configuration
Wizard.
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Section V: Trilithic Data Manager (TDM)
Component
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1. TDM Introduction
Chapter 1

What is Trilithic Data Manager (TDM)?

TDM (Trilithic Data Manager) is an optional component for WorkBench. It allows field TDM
(Trilithic Data Manager) is an optional component for WorkBench. It allows field technicians to use
the Internet to remotely send and receive information to/from their 860 DSP or 860 DSPi. Before
the availability of TDM, field technicians had to physically bring their meter into the home office for
information transfers.

Information received by the 860 DSP or 860 DSPi via TDM include:

• Device configuration files

• Firmware upgrades

• Updated channel plans

• Locations

• Tasks (work orders)

• Macros

• Web mail

Information send from the 860 DSP or 860 DSPi via TDM include:

• Field data

• Tasks (work orders)

• Screen captures

• Web mail

This chapter:

• Defines TDM’s purpose

• Provides the following diagrams

• TDM-to-860 DSP or 860 DSPi system overview

• Sample network configuration diagram

• TDM port and protocol diagram

• Provides instructions in using TDM with a secure socket layer

• Lists the minimum system requirements
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TDM and 860 DSPi System Overview Diagram
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TDM Network Configuration Diagram

Following is a general view of the components in the TDM network:
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TDM Ports and Protocols Diagram

The following diagram shows the ports and protocols that are used by the TDM network
components. If you have a firewall, it is important to make sure the ports named below are open.
For information on component requirements, refer to Chapter 2: TDM Server Installation, TDM
Server System Requirements in this manual.

TDM is not provided with email server software.  TDM provides
a web interface that allows the 860 DSP or 860 DSPi to interface
with an email server.
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Using TDM with a Secure Socket Layer (SSL)

It is possible to use a secure sockets layer (SSL) to access TDM. This can help prevent sensitive
TDM data from being intercepted.

Before configuring an 860 DSP or 860 DSPi to use an SSL, the
device’s firmware must be changed from the factory default.  To
obtain the SSL-enabling firmware, contact Trilithic at 317-895-
3600 or 800-344-2414 for assistance.

To access TDM using SSL:

1. Obtain an SSL certificate for your TDM server’s default web site. Consult your company’s
IT department for detailed instructions in obtaining an SSL certificate.

2. In the Administrative Tools Control Panel, open Internet Information Services.

3. Navigate to the following folder: local computer => Web Sites => Default Web Site.

4. Right-click on the TDM folder, then click on Properties.

5. Click on the Directory Security tab.

6. In the Secure communications section, click on Edit.

7. Place a check in the Require secure channel (SSL) check box. You may then wish to
place a check in the Require 128-bit encryption check box as well. Click the OK button,
then click the OK button again.

8. In the Inheritance Overrides dialog box that appears, click on Select All, and then click
the OK button.

9. Repeat steps 4 through 8, but for the TrilithicWebServices =>TrilithicDataManager folder
instead of the TDM folder.

10. In WorkBench, click the Global tab, expand the Application Options tree, then double-
click on the TDM label. The Application Options dialog box will appear with the TDM tab
displayed.

11. Place a check in the Use SSL check box, then click the OK button. You will be returned to
the main WorkBench window.
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12. Modify the Web browser settings for each 860 DSP by editing its TDM home page link as
follows:

a. Right-click on the 860 DSP, click on Configure, then click on Web Browser Settings.

b. In the Trilithic 860 DSP Configuration Wizard dialog box that appears, change the
TDM home page from:

http://TDM server hostname or IP address/TDM/860Pages.html

TO

https://TDM server hostname or IP address/TDM/860Pages.html

c. Click on Next. WorkBench will update the 860 DSP with the new link and then display a
Trilithic 860 DSP Configuration Wizard Complete message.

d. Click the Finish button. You will be returned to the main WorkBench window.
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2. TDM Server Installation
Chapter 2

System Requirements

To operate the TDM software, your system must meet the following minimum requirements:

WorkBench for the 860 DSP

• 200 MHz Pentium-II

• 64 MB RAM

• 100 MB free disk space

• Microsoft Windows NT 4.0, 2000 or XP

• Color monitor running at 256 colors or higher, 800 x 600 minimum screen resolution

• Windows compatible keyboard and mouse

WorkBench TDM Component

• WorkBench for the 860 DSP v1.5 or higher

• Internet connection

TDM Server

• 1 GHz Pentium-III

• 256 MB RAM

• 2 GB free disk space

• Microsoft Windows XP (10 concurrent connection limit) or Windows Server 2003

• Microsoft SQL Server 2000 with Service Pack 3a

• Color monitor running at 256 colors or higher, 800 x 600 minimum screen resolution

• Windows compatible keyboard and mouse

• Private Network Security

• NAT (firewall, router or computer) with TCP port 80 mapped to TDM server and TCP
port 24007 open for outgoing packets

• Static IP Address

This chapter provides instruction in:

• Installing the TDM application

• Logging in to the TDM Administration

• Registering the TDM application
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Installation Instructions

If TDM Server has already been installed, proceed to Step 2: Grant Others Permission to
Access TDM Administration.

860 DSP or 860 DSPi with web browser capabilities (v6.1.1.1 or higher)

TDM Mail Server (Not supplied by Trilithic)

• Incoming email server using POP3 or IMAP

• Outgoing email server using SMTP or SMTP-AUTH

• Email servers must be accessible via TCP/IP from the TDM server

Check the software installation CD for release notes that may
affect the installation and configuration process.

Step 1: Install TDM Server

To install TDM:

1. Log onto your server as the local Administrator, or as a user that is a member of the
local Administrators group.

2. Insert the TDM installation CD into your CD-ROM drive.

3. If you have Autorun enabled for the CD-ROM drive, the TDM setup program will
start automatically.

If you DO NOT have Autorun enabled for the CD-ROM drive,

a. Click Start (which is found on the lower left-hand side of your screen).

b. Select Run from the pop-up window.

c. Type D:\setup.exe (substitute the appropriate drive path if D is not your CD-ROM
drive).

d. Click the OK button.

4. To complete the installation, follow the on-screen directions.
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Step 2: Grant Others Permission to Access TDM Administration

By default, only the Windows user who is the Administrator of the computer on which TDM is
installed will have access to the TDM administration web interface.

To grant other individuals permission to access the TDM administration web pages, perform
either of the following procedures:

Microsoft Windows XP

• Go to the Windows Control Panel > User Accounts (then click on the Advanced tab)

• In Advanced User Management category click on the Advanced button (Local Users
and Groups) > Groups folder

• Double-click the TDM Administrators menu choice and add the appropriate names

Microsoft Windows 2003

• Go to the Windows Control Panel > Administrative Tools > Computer
Management then click System Tools to expand the menu tree

• Click the Local Users and Groups menu choice to expand the menu tree

• Double-click the Groups menu selection to open the Groups folder

• Double-click the TDM Administrators menu choice and add the appropriate names
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Step 3: Log In to TDM Administration

There are two ways to log into TDM Administration:

From Workbench (with the TDM component enabled)

Right click on either the TDM Inbox or TDM Outbox and select TDM Administration
from the drop down menu.

Note: To log in, you must have TDM administrative access to the computer on which TDM
is installed.

OR

From a web browser (i.e. Microsoft Internet Explorer)

You can also access TDM Administration by typing your TDM server’s administration home
page URL into any internet browser.

If you are not using SSL, the URL will be in the following format:

http://insert host name or IP address of the TDM server here/TDM/AdminPages.html

If you are using SSL, the URL will be in the following format:

https://insert host name or IP address of the TDM server here/TDM/AdminPages.html
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Step 4: Register the TDM Application

Before registering the TDM component, you must log in to TDM.   In the WorkBench program,
perform the following procedure to log in to TDM:

1. On the Global tab, right-click on either the TDM Inbox or the TDM Outbox.

2. Select TDM administration from the floating menu.

Once you have logged into the TDM Component of WorkBench, you can register the TDM
component.  Perform the following procedure to register the component:

1. Click the Main Menu link.

2. On the following page, click the registration link: Have You Registered?

3. Enter the Product Key.

4. Enter the Registration Key.

5. Click the OK button.

6. Click the Main Menu link to return to the TDM Administration menu.

If the Trilithic Product Activation dialog box shown in steps 3 through 5 does not appear,
follow the instructions displayed in the TDM browser window.
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3. TDM Component Setup
Chapter 3

Prerequisites

Before you can access the TDM feature within the WorkBench application:

• The TDM Server software must have previously been installed.  For installation instructions,
refer to Chapter 2: TDM Server Installation in this manual.

Before you can use the TDM Component of WorkBench to make configuration changes on the
860 DSP or 860 DSPi:

• WorkBench must have been installed with the Full Access option enabled.  If WorkBench
was installed with Limited Access enabled, you will not be able to perform any functions
associated with the TDM Outbox or Task Sheets.

• You will not be allowed to configure an 860 DSP or 860 DSPi to point to TDM.

Before you can configure WorkBench to point to the TDM server:

• You must know the Host Name or IP Address of the TDM server.

Enable the TDM Component in WorkBench

1. Open the WorkBench program.

2. Select the Global tab.

3. Right-click on the Application Options
menu choice then select Open from the
floating menu.

This chapter:

• Provides step-by-step instructions in setting up the TDM Component of WorkBench
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4. Select the General tab from the pop-up
Application Options window.

5. Select the check box corresponding to Enable
TDM Component.

6. Click the Apply button.

7. You may be prompted to register the TDM
Component if you have not yet done so.  Click the
OK button to continue.

To register the TDM Component, click the Help menu then
select Register TDM Component.  The software registration
screen will prompt you to provide the Product Key (included
with the original software disk) and the Registration Key
(obtained by calling Trilithic at 800-344-2412 during normal
business hours.

The TDM Inbox and Outbox menu options will now appear in
the Navigator Window, under the Global tab.  A TDM option will
appear under Application Options on the Global tab, and a TDM
tab will also appear after the Devices tab.
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Configuring WorkBench to Point to the TDM Server

1. Click the TDM tab.

2. Click the mouse pointer in the Host Name or IP
field then enter the host name or IP address of the
TDM server (if you do not know the host name or
IP address, contact your IT administrator).  Press
the Enter key on the keyboard.

3. Select the check box corresponding to Use SSL
if secure socket layer encryption is used.

4. The default Port will be 80 for non-SSL
communications and 443 for SSL
communications.

5. Scroll down in the Configuration window and select the
display mode for the TDM Inbox and TDM Outbox when
WorkBench is first opened.  Left-click in the Initial View
field then select the appropriate option from the drop-
down window.

For detailed instructions in creating a work group, refer to the
TDM for Administrators operation manual.

You can now choose which specific work groups to subscribe to.  This allows you to filter which of
the 860 DSP’s or 860 DSPi’s will receive and send data.  Only set subscriptions if you do not
want to send and receive data from all available 860 DSP’s and 860 DSPi’s on the TDM network.

For additional information in setting subscriptions, continue to step 1 in the next section,
Subscribing to 860 Work Groups.

If the subscription service is not needed, proceed to step 2 in the next section, Subscribing to
860 Work Groups.
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Subscribing to 860 Work Groups

1. To subscribe to a specific work group or work
groups, left-click to select the work group(s) then
click the Add button.

To unsubscribe from a specific work group, left-
click to select the work group(s) then click the
Remove button.

2. To subscribe a specific (or multiple) 860 DSP or
860 DSPi which are not members of a work
group, enter the MAC Address of the 860 DSP(s)
or 860 DSPi(s) then click the Add button.

To unsubscribe a specific (or multiple) 860 DSP
or 860 DSPi left-click to select the 860 DSP(s) or 860 DSPi(s) then click the Remove
button.

3. Click the OK button to close the Application Options window and configure the TDM Inbox
and TDM Outbox.

It may take several minutes for the TDM Inbox and TDM Outbox
to appear in the navigator window, as WorkBench requires time
to synchronize with the TDM server.

Each 860 DSP or 860 DSPi included in the TDM network will have its own inbox and outbox
which are displayed under the TDM Inbox and TDM Outbox headings in the navigator window.

The TDM Outbox will contain a Global outbox as well as any work group outboxes.
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Set Up the 860 DSP or DSPi to Connect to the TDM Server

In Chapter 3: TDM Component Setup, Configuring WorkBench to Point to the TDM Server,
the procedure for configuring WorkBench to the TDM server was performed.  Following the
WorkBench configuration, the 860 DSP or DSPi must also be configured to point to the TDM
server.  Perform the following procedure to configure the 860 DSP or DSPi to point to the TDM
server:

1. Click the Devices tab.

2. Right-click on the 860 DSP menu choice then select
New Connection from the floating menu.

3. In the pop-up Connect 860 DSP window, continue to create
new connections as described in WorkBench’s help menu.

Click the Help menu, then select the Help Topics menu
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choice.  Click the Search tab then select the Adding and Maintaining 860 DSPs help
topic.

Once an 860 DSP or 860 DSPi has been
connected to WorkBench, a web link must be
created which allows the 860 DSP or 860 DSPi to
access the TDM network through its web browser.

4. On the Devices tab, right-click the 860
DSP or 860 DSPi that was just connected
to WorkBench.

5. From the floating menu, select the
Configure menu option then select the
Web Browser Settings menu option from
the second floating menu.

To make TDM the home page that is displayed
when you select the WWW icon in the 860 DSP or
860 DSPi, go to step 6.

To make TDM a selectable link under the WWW
menu on the 860 DSP or 860 DSPi, go to step 7.

6. To set TDM as the 860 DSP’s or 860 DSPi’s home
page, right-click the 860 DSP or 860 DSPi in the
Navigator window.  From the floating menu, select
Configure, then select Web Browser
Parameters.

From the pop-up Web Browser Parameters
window, set the Home Page value to be the same
as the 860 DSP URL address shown on the TDM tab, under Application Options.

7. To create a link that the 860 DSP or 860 DSPi will use to access the TDM network via the
WWW application, enter the name of the link in the Line 2 Title field.

Enter the web address for the 860 DSP or 860 DSPi home page on the TDM server in the
Link 2 Address field.  This address is the same as the 860 DSP URL address shown on
the TDM tab, under Application Options.
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4. TDM Administration Pages
Chapter 4

This Chapter:

• Provides an overview of TDM Administration and it’s features

• Describes how to log in to the TDM Administration application

• Explains how to access the Administration pages in TDM’s main menu

• Provides a description of TDM Administration’s features

• Provides instruction in using TDM Administration’s features

Overview

TDM Administration serves as a headquarters for managing the functions and features of the
TDM application.  TDM Administration performs the following tasks:

860 DSP Maintenance

• Lists details about any 860 DSP or DSPi in the TDM network

• List, add, and delete 860 DSP’s or DSPi’s in the TDM network

TDM Inbox and Outbox Maintenance

• List, download, and delete files from TDM inboxes and outboxes

Email Maintenance

• Add, edit, or remove email users from the TDM network

• Select and configure servers that will be used to send and receive TDM email

• Add or remove email groups and their members

• Set up address books for individual users, groups, and for global use

Field Data File Type, Transaction History, and Web Link Maintenance

• List, add, and delete field data type extensions

• List date-specific activity, including file transfers and account maintenance

• Add and delete web links that can be accessed by the 860 DSPs in the TDM network



WorkBench Software - Section V: Trilithic Data Manager (TDM)
V-22

Logging in to TDM Administration

Two methods are available to log in to TDM Administration; through the WorkBench software
(with the TDM component enabled) or from an internet web browser.

Logging in from WorkBench

Right-click on TDM Inbox or TDM Outbox then select TDM Administration from the floating
menu.

Logging in from a Web Browser

You can access the TDM Administration by typing you TDM server’s administration URL into
the address bar of an internet browser.

If you are not using SSL, the URL will be in the following format:

http://insert host name or IP address of the TDM server here/TDM/AdminPages.html

If you are using SSL, the URL will be in the following format:

https://insert host name or IP address of the TDM server here/TDM/AdminPages.html

To log in, you must have TDM administrative access to the
computer TDM is installed on.
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Guided Tour of the TDM Administration Pages

Initial Setup Instructions

When TDM Administration is first set up, the following menu order must be followed in order to
ensure proper configuration:

• 860 DSPs - Add the 860 DSP’s or DSPi’s you want to access the TDM network

• Work Groups - Create groups of 860 DSP’s or DSPi’s

• Work Group Members - Assign work group members

• Field Data File Types - Make sure all needed field data file types are listed

To set up TDM email, the following menu order must be followed in order to ensure proper
configuration:

• Email Site Configuration -Select and configure the server that will be used to send
and receive TDM email

• Email Users - Add users you want to have email access

• Email Address Books - Setup address books for individual users, groups and for
global use

• Email Groups - Add email groups

• Database Locations - View and manage test data archived in multiple databases

The following administration menus are not necessary for initial setup, and can be used on an
as-needed basis:

• Web Links -Add web links you want to be accessed by the 860 DSP’s or DSPi’s in
your TDM network

• 860 DSP Details - View details about any 860 DSP or DSPi in your TDM network

• Inboxes -Manage TDM Inboxes

• Outboxes -Manage TDM Outboxes

• Transaction History - View date-specific activity

• Work Order Details - View specific details about assigned work orders

• Exception Log - View and edit exceptions noted by TDM
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Overview

The TDM Administration screen is divided into three sections.  Following is an explanation of
the layout of the TDM screen.

1

2

3

1. Title bar - the TDM Administration title bar indicates the name of the program.  This title
bar is static and will not change while the TDM Administration application is used.

2. Main menu - The main menu includes hyperlinks to all of the TDM Administration
pages.  Each of the links is explained in detail in the following sections of this chapter.

3. Data window - Each of the functions that correspond to the hyperlinks in the main
menu will be displayed in the data window.  The content of the data window will change,
depending on which hyperlinks are selected from the main menu.
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TDM Administration Menu

A brief explanation of each of the main menu hyperlinks is on the following page.

13

12

11
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9

8

7

6

5

4

3

2

1
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1. Displays all 860 DSP’s or DSPi’s included in the TDM network.  You can add new 860
DSP’s or DSPi’s you want to access the TDM network and delete ones you don’t.

2. Go here to create and delete groups of 860 DSP’s or DSPi’s.

3. View, download and delete files from inboxes.

4. View, add and delete files from outboxes.

5. Add, edit or  remove email users from the TDM network.

6. Add, edit or remove groups of email users on the TDM network.

7. Setup address books for individual users, groups and also for global use.

8. Add and delete web links that can be accessed by the 860 DSP’s or DSPi’s in the
TDM network.

9. Lists file extensions for all known types of field data.  You can add new file types and
delete those that are obsolete.

10.Create additional databases for archiving historical data uploaded from 860 DSP’s or
DSPi’s.

11. Use this to view date specific activity including file transfers and account maintenance.

12.View specific details about work orders that have been assigned to 860 DSP or DSPi
users in the TDM network.

13.Use this menu to display records of when an exception is noted by TDM.
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Using the TDM Administration Pages

860 DSP’s and DSPi’s

Use this menu to view all 860 DSP’s and DSPi’s included in the TDM network. You can also
add new 860 DSP’s or DSPi’s to the TDM network and delete 860 DSPs or DSPi’s you no
longer want to have access. An 860 DSP’s or DSPi’s properties can be edited here as well.

When a new 860 DSP or DSPi first attempts to connect with the
TDM server it is automatically added to this list with a “No” in
the Authorized column.  Before a new 860 DSP or DSPi is
allowed to connect to the TDM server, you must authorize it by
changing the “No” to “Yes.”

1

2

3

1. Takes you to that 860 DSP’s or DSPi’s details page.

2. To add a new 860 DSP or DSPi to the TDM network, type in the 860 DSP’s or DSPi’s
Mac Address.

3. If desired, type in the Operator Name.  This is a short name you can use to identify
your 860 DSP or DSPi.
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4

5

6

4. If you want the 860 DSP or DSPi to log into TDM email automatically, choose what user
name the 860 DSP or DSPi will log in as.

5. Select the appropriate option from the drop down to add a DSP to an existing work
group.

6. Click the Add button.

The Operator Name field will update automatically when an 860
DSP or DSPi connects to TDM.

If a user name is deleted from TDM, the Auto-Login feature for
the deleted name will not function.
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7. Select the appropriate 860 DSP or DSPi by putting a check in the correct box under
the Select column.

8. Click the Flip Auth button.

To delete an 860 DSP or DSPi from the TDM network:

9. Select the unwanted 860 DSP or DSPi by putting a check in the correct box under the
Select column.

10.Click the Delete button.

To authorize or unauthorize an 860 DSP or DSPi on the TDM network:

7

8

9

10
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To edit an 860 DSP’s or DSPi’s properties:

11

12

13

11. Click the Edit button for the appropriate 860 DSP or DSPi.

12.Edit the properties as necessary.  You may need to scroll down to reach the editing
section.

13.Click the Save button.
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Work Groups

Use this menu to create and delete groups of 860 DSP’s or DSPi’s.  A work group is a
collection of 860 DSP’s or DSPi’s that have something in common, such as the type of work
the technicians do or their geographical location.  Using work groups, changes can be applied
to several 860 DSP’s or DSPi’s at once instead of individually.

1

2

3

4

5

6

1. To add a work group, enter the name of the work group in the Name field, and a brief
description of the work group in the Description field.  Enter the user name and
password used to access the work group’s parameters in the User Name and
Password fields.

2. If the new work group and its members are to be added to an existing work group,
select the existing work group from the pull down list.

3. Click the Add button.

4. To delete a work group, select the check box corresponding to the work group to be
deleted.

5. Click the Delete button.
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6. To add or delete 860 DSP’s or DSPi’s to or from a specific work group, click the
Members link.  The Work Group Members page for the selected work group will load.

To add users to or delete 860 DSP’s or DSPi’s from a work group:

7

8

9

10

11

7. Select the work group whose members will be edited using the drop-down list, then
click the Display button.

8. Select the check box corresponding to the 860 DSP or DSPi to be removed from the
work group.

9. Click the Remove button.

10.Select the check box corresponding to the 860 DSP or DSPi to be added to the
selected work group.

11. Click the Add button.
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9

10

11

9. To edit a work group, click the Edit button for the appropriate work group.

10.You may need to scroll down to reach the editing section.  Edit the properties as necessary.

11. Click the Save button.
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Inboxes

This menu provides an alternate way to view the contents of your TDM Inbox and should only
be used if WorkBench is not available.  Use this menu to view, download and delete files from
your TDM Inboxes.  Changes made in the Inbox will be reflected in WorkBench.

The TDM Inbox contains data logs that have been received from an 860 DSP or DSPi.  Data
logs imported from the TDM Inbox go into the WorkBench database.

1

2

1. Select an inbox from the drop down list.

2. Click the Display button to refresh this screen.

Once an inbox has been selected, the following screen will be displayed.
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3

4

5

6

7

8

3. To choose another inbox, select the appropriate Inbox from the drop down list.

4. Click the Display button to refresh this screen.

5. To delete a file from an inbox, choose the unwanted file by selecting its check box.

6. Click the Delete button.

7. To download a file from an inbox, click the Download link.

Only a copy of the file will be downloaded.  Using TDM
Administration to download a file from an inbox does not delete
it from that inbox.

8. Click either Previous or Next to move back and forth in the list of inbox files.
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Outboxes

This menu provides an alternate way to view the contents of your TDM Outbox and should only
be used if WorkBench is not available.  Use this menu to view, upload and delete files from
your Outboxes.  Files added to or deleted from the Outbox will be reflected in WorkBench.

The TDM Outbox houses the Global outbox, work group outboxes and individual 860 DSP
outboxes.  An outbox stores the data that will be sent to its respective 860 DSP or DSPi.
Among the data types that can be stored in outboxes are firmware upgrades, updated channel
plans, locations, macros, tasks (work orders) and device configurations.

1

2

1. Select an outbox from the drop down list.

2. Click the Display button to refresh this screen.

Once an outbox has been selected, the following screen will be displayed.
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3

4
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3. To choose another outbox, select the appropriate Outbox from the drop down list.

4. Click the Display button to refresh this screen.

5. To delete a file from an outbox, choose the unwanted file by selecting its check box.

6. Click the Delete button.

7. To upload a file to an outbox, click the Browse button, then locate and select the file.

8. Click the Upload button.

9. Click either Previous or Next to move back and forth in the list of outbox files.
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Email Users

TDM allows 860 DSP’s or DSPi’s to send and receive email messages.  Use this menu to
add, edit or remove email users from the TDM network.

1
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1. To add an email  user, enter the name of the user in the Userame field, and the user’s
full name in the User’s Full Name field.  Enter the email address and password that
the user will use to access their account in the E-Mail Address and Password fields.

2. If the new email user is to be added to the global address book, select the check box
corresponding to the Global Address Book option.

3. Choose the email group(s) to like to add the user to by putting a check in the box next to
the appropriate group name.

4. Place a check here to automatically add this user to the address books for the email
groups you selected in the previous step.

5. Click the Add button.

6. To delete an email user, select the check box corresponding to the user to be deleted.

7. Click the Delete button.
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8
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8. To authorize or unauthorize an email user, select the appropriate user by putting a
check in the correct box under the Select column.

9. Click the Flip Auth button.
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10

11

12

10.To edit an email user, click the Edit button for the appropriate email user.

11. Edit the user properties as necessary.  You may need to scroll down to reach the editing
section.

12.Click the Save button.
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Email Groups

Use this menu to add or delete email groups or add or delete individual email users from an
email group.

Email groups are a way to classify email users.  For example, you can create one email group
for maintenance technicians and another for installation technicians.

1

2

3
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1. To add an email  group, enter the name of the group in the Name field.

2. To add email users to the new group, select the check box corresponding to the users
that will be added to the new group.

3. If the users in the new email group are to be added to the address book for the new
group, select the check box corresponding to the Address Book option.

4. Click the Add button.

5. To delete an email group, place a check in the box next to the email group you want to remove.

6. Click the Delete button.

7. Click either Previous or Next to move back and forth in the list of email groups.
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8

9
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8. To edit an email group, click the Edit button for the appropriate email group.

9. Edit the group properties as necessary.  You may need to scroll down to reach the
editing section.

10.Click the Save button.
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Address Books

Use this menu to set -up address books for individual users, groups and also for global use.

1

2

1. Select an email address book from the drop down list.

2. Click the Display button to refresh this screen.

Once an outbox has been selected, the following screen will be displayed.
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1. To choose another email address book, select the appropriate email address book
from the drop down list.

2. Click the Display button to refresh this screen.

3. To delete a member from an email address book, place a check in the box next to the
member you want to remove.

4. Click the Delete button.

5. To add a new member to an email address book, type in the name you want displayed.

6. Type in the Email address.

7. Click the Add button.

8. Click either Previous or Next to move back and forth in the list of email addresses.
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9

10
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9. To edit an email address within an address book, click the Edit button for the
appropriate email address.

10.Edit the email address properties as necessary.  You may need to scroll down to reach
the editing section.

11. Click the Save button.
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Web Links

Use this menu to add or delete Web links (for search engines, vendor websites, intranet sites,
etc.) that can be accessed by the 860 DSP’s or DSPi’s in the TDM network.  You can assign
links globally, by work group, or by individual 860 DSP or DSPi.

1

2

1. Select a drop box from the drop down list.

2. Click the Display button to refresh this screen.

Once a drop box has been selected, the following screen will be displayed.
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1. To choose another drop box, select the appropriate drop box from the drop down list.

2. Click the Display button to refresh this screen.

3. To delete a web link, select the unwanted web link by putting a check in the box.

4. Click the Delete button.

5. To add a new web link, type in the web link’s name.

6. Type in the URL.

7. Click the Add button.

8. Click either Previous or Next to move back and forth in the list of web links.
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Field Data File Types

Use this menu to define the field data file types that can be received from an 860 DSP or
DSPi.  File extensions for all known types of field data can be listed here.  You can also add
new field data file types and delete obsolete ones.

Field data file types not on the list are not recognized by TDM.  These field data files will
remain on the 860 DSP or DSPi and will not be received by TDM.
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1. To add a new file type, enter the file extension in the File Extension text box.

2. Enter a description of the file type in the Description text box.

3. Click the Add button.

4. To delete an obsolete file type, select the unwanted file type(s) by putting a check in the
box.

5. Click the Delete button.

6. Click either Previous or Next to move back and forth in the list of field data file types.
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Database Locations

Use this menu to view archived test data.  This menu allows two or more databases to be
maintained; one database for current data and a separate database (or databases) for
archive data.  This feature is rarely used and will not be included with future versions of TDM.
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1. Enter the IP address for the new database in the Host field.

2. Enter the name of the new database in the Database field.

3. Enter the user name with which the new database will be accessed in the Username
field.

4. Enter the password with which the new database will be accessed in the Password
field.

5. Click the Add button.
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Transaction History

Use this menu to view date specific activity including file transfers and account maintenance.

1

2

3

1. To view a specific 860 DSP’s or DSPi’s transaction history, choose a date range to
view.  Click each calendar icon and select a starting (From Date:) date and ending (To
Date:) date.

2. Select an 860 DSP or DSPi from the drop down list.

3. Click the Display button to refresh this screen.

Once a drop box has been selected, the following screen will be displayed.
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4. To view the transaction history for a different set of dates, choose a date range you’d
like to view.

5. Select an 860 DSP or DSPi from the drop down list.

6. Click the Display button to refresh this screen.

7. The transaction history for the selected 860 DSP or DSPi is displayed.

8. Click either Previous or Next to move back and forth in the list of transactions.
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Work Order Details

Use this menu to view specific details about work orders that have been assigned to 860 DSP
or DSPi users in the TDM network.

1

2
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4

1. Enter the work order number to search for in the Work Order field, or

2. Enter the technician’s identification to search for in the Tech ID field, or

3. Enter the starting and ending date with which to search for work orders in the Start
Date and End Date fields.  The date must be entered in MM/DD/YYYY (month, date,
year) format.

4. Click the Search button to refresh the screen.

Once the work order search criteria has been selected, the following screen will be displayed.



WorkBench Software - Section V: Trilithic Data Manager (TDM)
V-53

5

6

5. The work order records matching the search criteria are displayed.

6. Click either Previous or Next to move back and forth in the list of work orders.
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Exception Log

Use this menu to display records of when an exception is noted by TDM.  When a task
assigned to a technician is completed by a different technician and the data uploaded from the
860 DSP or DSPi to TDM, the TDM application will make note of the exception.  This menu
can be used to search for exceptions, which can then be reassigned to the original technician.

1

2

3

1. Enter the starting and ending date with which to search for exceptions in the From Date
and To Date fields.  The date must be entered in MM/DD/YYYY (month, date, year)
format.

2. Select the 860 DSP or 860 DSPi for which exceptions will be searched.

3. Click the Search button to refresh the screen.
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4
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4. The exceptions matching the search criteria will be displayed.

5. To view details for a specific exception and to edit the exception, click the Task ID
number.

The following screen will be displayed.
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6. The details for the selected exception are displayed.

7. Select the appropriate check box to assign the task to a different TDM user, or enter a
work order number to assign the task to.

8. Click the Save button to save changes made to the task.

9. Click the Delete button to permanently remove the task from TDM.
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To delete a noted task exception:

10
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10.Select the check box corresponding to the task exception to be deleted.

11. Click the Delete button.
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5. Using the TDM Component
Chapter 5

TDM Outbox

The TDM Outbox houses the Global outbox, work group outboxes and individual 860 DSP and
DSPi outboxes.  All outboxes store data that will be sent to an 860 DSP or DSPi.  Among the data
types that can be stored in outboxes are firmware upgrades, updated channel plans, locations,
macros, tasks (work orders) and device configurations.

1

2

3

4, 5, 6

This chapter discusses:

• The TDM Outbox

• The TDM Inbox

• Task Sheets

1. The Global Outbox icon shows an envelope in front
of a globe.

2. Work Group outbox icons show an envelope in
front of multiple folders.

3. Individual outbox icons show an envelope in front
of one folder.

4. To delete an outbox item, right-click on it and pick Remove from Outbox from the drop
down menu.  You can also highlight the item and press Delete on your keyboard.

5. To delete more than one outbox at time, highlight the appropriate items by holding down
the CTRL button on your keyboard and then left-clicking on them. Then, right-click on any of
the highlighted items and select Remove from Outbox from the drop down menu.  You
can also highlight the items and then press your keyboard’s Delete key.

6. To open an outbox item, double-click on it or right-click on the item and select Open from
the drop down menu.
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7. Placing an item into the Global outbox automatically sends it to ALL of your outboxes.

All items placed in the Global outbox need to be manually deleted if you:

a. no longer want them after they have been received by all outboxes

b. don’t want them sent to the outboxes of 860 DSP’s or DSPi’s that are added in the
future

c. do not subscribe to any work groups

8. You can place an item in an individual 860 DSP or DSPi outbox if you don’t want that item
to be shared with other 860 DSP’s or DSPi’s.  Individual 860 DSP or DSPi outboxes
automatically empty after items are sent to the 860 DSP or DSPi.

9. The numbers in the () indicate how many undelivered items are in an outbox.

10.You can place an item in a work group outbox if you only want it to go to the 860 DSP’s or
DSPi’s that are work group members. Work group outboxes automatically empty after
items are distributed to the work group members.
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Sending Packages to an Outbox

A (configuration) package is a combination of one or more channel plans, locations, macros,
and text files, as well as a wide variety of device parameters. You can use a configuration
package as a quick and easy way to install a suite of plans and other information on an 860
DSP or DSPi.

To learn more about Packages, go to WorkBench’s Help menu and select Help Topics from
the drop down list.  Then go to the Search tab and look for the Setting Up Configuration
Packages topic.

1

2

1. Choose the Global tab.

2. Go to Packages and find the item you want to send to an outbox.
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3
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3. Right-click on the name of the package(s) you want to send and select Send to
Outbox from the drop down menu.

4. Select your desired outbox category from the next drop down menu and proceed by
selecting the appropriate options and then clicking Send.
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Sending Channel Plans to an Outbox

A channel plan is a list of channels, frequencies, and other device parameters. Depending on
your cable network, you may have a variety of channel plans for your 860 DSP’s or DSPi’s.

To learn more about Channel Plans, go to WorkBench’s Help menu and select Help Topics
from the drop down list. Then go to the Search tab and look for the Creating and
Maintaining Channel Plans topic.

1

2

1. Choose the Global tab.

2. Go to Channel Plans and find the item you want to send to an outbox.
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3. Right-click on the name of the channel plan(s) you want to send and select Send to
Outbox from the drop down menu.

4. Select your desired outbox category from the next drop down menu and proceed by
selecting the appropriate options and then clicking Send.
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Sending Auto-Test Macros to an Outbox

An auto-test macro (or simply macro for short) is a pre-programmed set of tests and ranges.
Each 860 DSP or DSPi can store a maximum of 9 macros. Each macro can contain up to 16
steps.

To learn more about Macros, go to WorkBench’s Help menu and select Help Topics from the
drop down list.  Then go to the Search tab and look for the Creating and Maintaining
Macros topic.

1

2

1. Choose the Global tab.

2. Go to Auto-Test Macros and find the item you want to send to an outbox.
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3. Right-click on the name of the macro(s) you want to send to an outbox and select Send
to Outbox from the drop down menu.

4. Select your desired outbox category from the next drop down menu and proceed by
selecting the appropriate options and then clicking Send.
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Sending Locations to an Outbox

A location provides a method to tag data with information about where that data was taken.

To learn more about Locations, go to WorkBench’s Help menu and select Help Topics from
the drop down list.  Then go to the Search tab and look for the Creating and Maintaining
Locations topic.

1

2

1. Choose the Global tab.

2. Go to Locations and find the item you want to send to an outbox.

3

4

3. Right-click on the name of the location(s) you want to send to an outbox and select
Send to Outbox from the drop down menu.

4. Select your desired outbox category from the next drop down menu and proceed by
selecting the appropriate options and then clicking Send.
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3. Right-click on the name of the location(s) you want to send to an outbox and select
Send to Outbox from the drop down menu.

4. Select your desired outbox category from the next drop down menu and proceed by
selecting the appropriate options and then clicking Send.
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Sending Firmware Upgrades to an Outbox

Trilithic periodically issues updates to the 860 DSP or DSPi firmware. These are posted on
the 860 DSP website (http://www.860DSP.com) for downloading to your computer.

You can also check for updates by going to WorkBench’s Help menu and selecting Check for
Updates.  After the new firmware has been downloaded:

1

2

3

4

1. Choose the Global tab.

2. Go to the TDM Outbox and right-click on the global, work group, or individual outbox to
which you’d like to install the upgrade.

3. Select Send Configuration from the drop down menu.

4. Select Apply 860 DSP Upgrade... from the next drop down menu.
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5

6

5. Choose the correct upgrade file from your hard drive.

Note: If you have more than one upgrade file stored in your directory, be sure to use the
one with the most recent date in its name.

6. Select Open.
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Sending Option Codes to an Individual Outbox

Send option codes allows you to remotely enable a purchased option on an 860 DSP or
DSPi.  Examples of purchased options include: Power Pack, QAM Option QA-2, Spectrum
Analyzer Option SA-1, Return Sweep Receiver Option SR-1, and Return Tester Option VP-1.

Option codes come from Trilithic and are specific to a particular 860 DSP or DSPi.

1

2

3

1. Choose the Global tab.

2. Go to the TDM Outbox and right-click on the outbox of the 860 DSP on which you’d
like to install the new option(s).

3. Select Send Options’ Codes from the drop down menu.
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4

5

4. Enter the code for the option(s) using the same format as shown.

Note: Trilithic will send you this code when you purchase the option(s).

5. Click the OK button.
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Sending Local Files to an Outbox

This feature is used to send files stored on your local hard drive to an 860 DSP or DSPi.

Note: Normally, files sent to an Outbox come from your server and not your local hard drive.

1

2

1. Choose the Global tab.

2. Go to Local Files and find the file you want to send to an outbox.
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3. Right-click on the file you want to send and select Send to Outbox from the drop down
menu.

4. Select your desired Outbox category from the next drop down menu and proceed by
selecting the appropriate options and then clicking on Send.
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1

2

3

4

5

Sending Configurations to an Outbox

The send configuration is feature is used to send a new or updated device configuration to an
860 DSP or DSPi.

It is not recommend that modifications be made this way
because your configuration changes will not be tracked. It is
better to use packages instead.

1. Choose the Global tab.

2. Go to the TDM Outbox and right-click on the outbox of the 860 DSP to which you’d like
to send a new configuration.
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3. Choose Send Configuration from the drop down menu and continue by selecting the
appropriate configuration option.

Right-click on the Global outbox to send the same new
configuration to all individual 860 DSP outboxes at once.

4. For a walk through of the entire configuration process, choose Configuration
Wizard... from the drop down menu. Continue by selecting the appropriate options.

For step-by-step instructions on using the configuration wizard, go to WorkBench’s
Help menu and select Help Topics from the drop down menu.

Then go to the Search tab and look for the Creating a New Configuration Package
topic.

5. To configure only a specific setting, select it from the drop down menu. Continue by
selecting the appropriate options.
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Creating New Task Sheets

To create a new task sheet, perform the following procedure.

1

2

Task Sheets

A task sheet is a template that organizes and defines individual tasks (work orders) or trouble
tickets. Task sheets allow you to group technicians or types of tasks that share a common set of
work parameters or attributes.  Once a task sheet is defined, you can use it to create new tasks,
assign tasks to technicians and also view the current status and history of tasks.

Once a task is sent to an 860 DSP, it can be accessed on the 860
DSP by selecting the TASKS icon.  Besides being viewed, a data
log can also be associated with a task to provide tracking
information.

1. Choose the Global tab.

2. Right-click on Task Sheets and select New Task Sheet... from the drop down menu.
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3
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5

3. Type in a Name for your new task sheet.

4. Type in a Description for your new task sheet (this step is optional).

5. Each Attribute represents a column that will appear on your task sheet.  Each task
sheet can have up to 12 user-defined attributes.

Type in a Header (title) for each column.

You now need to decide how you want the information in this column to be entered.

If you want users to choose from specific drop down list options, type in a Value for
each option.

If you don’t enter values, users may type free-form text (up to 255 characters) under that
column header in the task sheet.

Your task sheet is now created. Start entering individual tasks as shown on the following page.
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6

7

8

6. Type in a unique Task ID.  The Task ID can consist of letters or numbers and can be up
to six characters long.

Task IDs for all open tasks must be unique.  The tasks they represent will later be
attached by 860 DSP or DSPi operators to data logs for record keeping purposes.

7. The Priority, Last Name, and First Name columns are the attributes you entered
earlier in step 5.  Type in or select from the drop down list the appropriate information.

If an attribute has a drop down list, an arrow will appear when
that field is selected.  You cannot type information into attributes
with drop down lists.
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8. The Admin Note, Status, Assigned To, DateOpened, Date Assigned and Date
Closed columns are automatically included in every task sheet.

Admin Note = Type in any extra information.

Status = Assigned automatically. The three states are Open, Assigned and Closed.

Assigned To = Automatically updated when the task is sent to an individual outbox or
imported from an individual inbox. (For detailed instructions on assigning tasks, see the
To Send a Task to an Individual Outbox section of this manual.)

Date Opened = Automatically filled in when the task is created.

Date Assigned = Automatically filled in when the task is sent to an individual inbox.

Date Closed = Automatically filled in once the technician closes the task on his 860
DSP or DSPi or when the task administrator right-clicks on the task and chooses
Close from the drop down menu.

Tasks can be sorted by clicking on the column headers.
Using the task sheet above as an example, if you want to
sort the task sheet alphabetically by Last Name, click on
the Last Name column header.
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Entering Tasks Into Task Sheets

To add an existing task to a task sheet, perform the following procedure.

1

2

3

4

1. Choose the Global tab.

2. Under the Task Sheets menu selection, double-click the task sheet for which to add
tasks to.

3. The individual tasks assigned to the selected task sheet will appear in the Data
Window.

4. Double-click in the next available row to enter the parameters of a new task.  All new
tasks will be assigned to the currently-selected task sheet.  Click the Save button to
save the new task to the task sheet.



WorkBench Software - Section V: Trilithic Data Manager (TDM)
V-82

Sending a Task to an Individual Outbox

To send a task to an individual outbox, perform the following procedure.

1

2

1. Highlight the task(s) you want to send.

2. Right-click on the highlighted task(s) and select Send to Individual Outbox from the
drop down menu.

3

4

3. Place a check next to the Outbox(es) to which you’d like to send the task.

4. Click the Send button.
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Sending a Task to an Individual 860 DSP or 860 DSPi

Only use this method to send a task when the TDM server is
not available.

If the 860 DSP or DSPi you want to send a task to is NOT currently connected to WorkBench,
go to step 1.

If the 860 DSP or DSPi you want to send a task to IS currently connected to WorkBench, go to
step 4.

1

2

1. Select the Devices tab.

2. Right-click on 860 DSP and select New Connection... from the drop down menu.
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3

For step-by-step instructions on creating a new connection, go
to WorkBench’s Help menu and select Help Topics from the
drop down list.  Then go to the Search tab and look for the
Adding and Maintaining 860 DSPs topic.

3. Continue creating a new connection by selecting the appropriate options.
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4
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6

4. Continue creating a new connection by selecting the appropriate options.

5. Open the task sheet with the task you want to send to an 860 DSP or DSPi.

6. Right-click on the task you want to send and select Transfer to 860 DSP from the drop
down menu.
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7
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7. Select the 860 DSP or DSPi to send the task to by placing a check in the appropriate
box.

8. After making your selection, click on Transfer.

This screen will not appear if only one 860 DSP or DSPi is
currently connected to WorkBench.
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Manually Closing Tasks

Tasks are normally closed by a technician via an 860 DSP or DSPi. If this does not happen,
tasks can also be closed manually in the task sheet. Closed tasks remain in the task sheet, but
are hidden from view.  To manually close a task, perform the following procedure.

1

2

1. Right-click on the task(s) you want to close.

2. Select Close from the drop down menu.

Showing Closed Tasks
Normally, when tasks are closed they are automatically hidden within the task sheet. If you want
closed tasks to remain visible, follow the steps below.

1

2

1. Right-click anywhere in the task sheet.

2. Select Show Closed Tasks from the drop down menu.
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Deleting a Task

When an open or assigned task is deleted it is permanently removed from the task sheet. A
closed task cannot be deleted.  To delete a task, perform the following procedure.

1

2

1. Right-click on the task(s) you want to delete.

2. Select Delete from the drop down menu.

Deleting a Task Sheet

When a task sheet is deleted it is permanently removed from WorkBench.  To delete a  task,
perform the following procedure.

1

1. Right-click on the task sheet you want to delete and select Delete from the drop down
menu.



WorkBench Software - Section V: Trilithic Data Manager (TDM)
V-89

Editing a Task Sheet

To edit a task sheet, perform the following procedure.

1

1. If the task sheet is open, left-click on the Properties icon.

OR

2

2. If the task sheet is closed, right-click on it and select Properties from the drop down
menu.
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3. If necessary, edit the Name or Description on the Task Sheet Properties window that
appears.

4. The properties of the currently-selected task sheet are shown in the Details window.
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7

5. Select the Attributes tab.

6. Make the appropriate changes to the Header or Value fields.  Headers can be
modified but not deleted, and values can be added, deleted or modified.

Once a task sheet is created, attribute columns cannot be
created or deleted.

7. After finishing your edits, click the OK button.
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Archiving a Task Sheet

Archiving a task sheet is useful if you want to keep a historical record of tasks contained in a
task sheet that is no longer in active use.  To archive a task sheet, perform the following
procedure.

1

2

1. Right-click on the task sheet you want to archive.

2. Select Archive from the drop down menu.
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Viewing Archived Task Sheets

Select this option if you want to view a list of archived task sheets and/or their tasks.  To view
an archived task sheet, perform the following procedure.

1

2

3

1. Right-click on Task Sheets.

2. Select Show Archives from the drop down menu.

3. This Archives folder will appear. All archived task sheets are stored here.



WorkBench Software - Section V: Trilithic Data Manager (TDM)
V-94

Importing Tasks and Task Sheets

Importing Task Sheet Definitions from a Local Disk

A task sheet definition serves as a template. Importing a task sheet definition file recreates
the structure and attributes of an existing task sheet into a new task sheet.  To import a task
sheet definition, perform the following procedure.

1

2

1. Go to File.

2. Select Import and then Tasks/Task Sheets from the drop down menu.

3

4

3. Locate the task sheet file to import. A task sheet definition’s file type is *.tsh.

4. Click the Open button.
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Importing Individual Tasks from a Local Disk

If you are importing data logs and their associated task file(s) from a local disk, you must
first import the task file(s) before importing the data logs. Failure to do so will break the
associative link between the task(s) and the data log(s).  To import an individual task,
perform the following procedure.

1

2

1. Go to File.

2. Select Import and then Tasks/Task Sheets from the drop down menu.
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4

3. Locate the task you’d like to import. A task file’s file type can be either .clsd (closed
task) or .task (open task).

4. Click on Open.
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Exporting Task and Task Sheets

Exporting Task Sheet Definitions to a Local Disk

A task sheet definition serves as a template. Exporting a task sheet definition recreates the
structure and attributes of an existing task sheet into a definition file. This file can later be
imported and used to recreate the exact same task sheet. This option helps provide
consistency when multiple administrators use the same task sheet.  To export a task sheet
definition, perform the following procedure.

1

2

1. Make sure the task sheet whose definition you want to export is open. Go to File
and select Export.

2. Select Task Sheet Definition... from the drop down menu.
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Exporting Individual Tasks to a Local Disk

Use this option to store a task or tasks on a server or hard drive.  To export an individual
task, perform the following procedure.

1

2

1. Highlight the individual task(s) you want to export.

2. Right-click on the highlighted task(s) and select Export to Local Disk from the
drop down menu.
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3. Select a location to save the file.

4. After selecting a location, click on Save.

If you exported more than one task, each task will export into its
own separate file. For example, three tasks will export into three
different files.
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Exporting a Task Sheet to a Local Disk

Use this option if you’d like to store a task sheet on a server or hard drive.  To export a task
sheet, perform the following procedure.

1

OR

2

1. Right-click on the task sheet you want to export and highlight Export to Local Disk
from the drop down menu.

2. Open the task sheet you wish to export and then go to File and select Export. Now,
select Task Sheet File... from the drop down menu.



WorkBench Software - Section V: Trilithic Data Manager (TDM)
V-101

3

4

3. Select a location to save the file.

4. After selecting a location, click on Save.
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TDM Reports

Overview

Following is a brief explanation of the different reports available in TDM, with a brief
description. More detailed explanations of these reports are in following sections.

At-Tap Node History - Shows all records within specified date range for selected macro,
organized by node.

Calibration Check - Shows all records within specified date range for selected macro.
Shows percentage of pass/fail.

House History - Shows all records for selected address, organized by descending work
date. Searchable by city or street address.

Meter Inventory - Displays operator name, model, firmware, last calibration date and options.

Set Top Compliance Details - Shows all records within specified date range for “set top”
macro.

Set Top Compliance Summary - Same as Set Top Compliance Details report but not
expandable down to macro results. Better for larger date ranges.

Technician Compliance - Shows degree of technician compliance based on TDM
Compliance Matrix.
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At-Tap Node History

Introduction

The At Tap Node History report provides information on macros run in the field, listed by
node.  This can be useful for tracking problem areas of the outside plant. Typically, this
report is used to track escalated service calls by listing failed macros run at the tap by the
installation technician.

This report can also be used to display pass/fail percentages for any macro listed by node,
city, zip code, etc.

Report Parameters

The report parameters are defined as follows:

Comments: Text entered in this field will be
displayed on the report.

Date Range: Limits results displayed to
specified date range.

Work Group Depth: Displays depth of work
group hierarchy listed on report Expand to:
Denotes level of report detail.  Choices are
work group, node, work order, macro and data
log.

Show Failed Only: If checked, displays only
failed macro results.

Order Nodes By: Denotes how nodes are
organized. Choices are Node Name, Number,
Fail, and Percent Fail.

Node Attribute: Organizes results according to
node name, city, zip code, etc. Entries in this
field must match flat file headers for desired field.

Macro Name Expression: Defines name of macro. Wild card in the form of %Macro
Name%.
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Explanation of the Report

Below is an example of an At Tap Node History report expanded to the macro level:

The sample above displays the name of the report, the date and time the report was
generated, the specified date range for the report, and the text entered in the Comments
field (Application Note Test Comment).

A green check mark beside the work order number denotes the
macro has passed. A red X indicates that one or more steps in
the macro has failed. If a yellow triangle with an explanation
mark appears, this indicates there is no job type information for
that work order.
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The report headers are defined as follows:

Work Groups - Displays the hierarchy of work groups, displays the names of the
specific work groups.

Node - Displays the total number of nodes for each work group hierarchy. Displays
results organized by node name (as in this example) or by city, zip code, etc. This is
determined by the Node Attribute field in the report parameters.

Work Order - Displays number and percentage of failed macros for each node, as well
as throughout work group hierarchy. Also displays work order number, job type, and
technician for each macro run.

Address - Displays the address of the work order. The macros run are listed under this
header.

Data Log - Displays the number of macros run and the percentage of those that
passed for each node and throughout the work group hierarchy. The date of the macro
is listed as well. If the macro name is expanded the individual steps of the macro and
the time run will be listed.
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Below is the same At Tap Node History report, this time organized by city and with one
macro expanded to the data log:
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At the top of the report there are some additional options. These are defined as follows:

Refresh - Refreshes the current report if parameters are
changed

Print - Enables option to print the report

Print Layout - Print preview

Page Setup - Defines the page layout for printing

Save - Allows saving of the report in Excel or PDF format

Zoom - Adjusts the displayed size of the report
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Calibration Check

Introduction

In some companies, the technicians are required to run a macro to verify that the meter is
measuring signal levels accurately. This macro (typically a Scan test) would be run at a test
point with known levels and would have narrow limits for a pass/fail result. The typical
macro name for this test is “cal chk” and TDM has a report to display the results of this test.

Report Parameters

The report parameters are defined as follows:

Comments - Text entered in this box will be
displayed in report.

Date Range - Limits results displayed to specified
date range.

Work Group Depth - Displays pass/fail numbers for
work group hierarchy.

Expand to - Denotes level of report detail. Choices
are work group, technician, macro and data log.

Macro Name - Defines name of macro. Wild card in
the form of %Macro Name%.

Technician - Limits results to specific user defined
technician or technicians.

Work Group - Limits results to user defined work
group or work groups.

Show Passed - If checked, displays technicians with
passing results. Otherwise only failed results are displayed.

In the Technician and Work Group fields, multiple technicians or
work groups can be selected. Separate the values in this field
with a comma. For example, if “1234, 2345” was entered in
the Technician field the report would display only the results for
technicians 1234 and 2345.
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Explanation of the Report

Below is an example of the Calibration Check report expanded to the Data Log level:

The sample above displays the name of the report, the date and time the report was
generated, the specified date range for the report, and the text entered in the Comments
field (Application Note Test Report).
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The report headers are defined as follows:

Work Groups: Displays the hierarchy of work groups, displays the names of the
specific work groups.

Technician Total: Displays the total number of technicians in the specific work groups
and their hierarchy. The technician names are the operator names of the meter when
the test was performed. If an operator name is not listed in the meter, the meter’s CPE
MAC address is listed.

Cal Check Compliance: Displays the number of failed macros, no data (no macro
was run), and passed macros for each work group and hierarchy. If technician is
expanded (click on + sign) a link to the macro will be displayed. This link will generate a
Macro Summary Report listing the details of the macro.

Test Results: Displays the number of tests run and the number of tests passed as well
as the date/time the macro was run. If the macro link for the technician is expanded, a
link to the data log will appear. This can only be viewed with the Workbench program
and gives specific details and results of the macro.

Meter Calibration Date: Displays the calibration date of the meter as it was recorded
the last time the meter connected to the TDM server.
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At the top of the report there are some additional options. These are defined as follows:

Refresh - Refreshes the current report if parameters are
changed

Print - Enables option to print the report

Print Layout - Print preview

Page Setup - Defines the page layout for printing

Save - Allows saving of the report in Excel or PDF format

Zoom - Adjusts the displayed size of the report
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House History

Introduction

The house history report shows all records for the selected address, organized by the date
of each work order.  The house history report is searchable by city or street address and is
typically used for viewing of “problem” houses.  The house history report displays work
orders and macros for each searched address.  The report allows the operator to view a
house’s service calls and the outcome of each call.

Report Parameters

The report parameters are defined as follows:

Comments - Text entered in this box will be displayed in
report.

Date Range - Limits results displayed to specified date
range.

Street Address - Search house history report data for the
specified address.

City - Search house history report data for the specified
city.

Expand To - Denotes level of report detail. Choices are
work groups, technician, work order, macro and data log. Report can be manually
expanded.
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Explanation of the Report

Below is a sample of a House History report. The report will list the work order number, the
technician who was assigned to the work order, the macros that were run, the date the
macros were run, and the pass or fail status of each macro.



WorkBench Software - Section V: Trilithic Data Manager (TDM)
V-114

At the top of the report there are some additional options. These are defined as follows:

Refresh - Refreshes the current report if parameters are
changed

Print - Enables option to print the report

Print Layout - Print preview

Page Setup - Defines the page layout for printing

Save - Allows saving of the report in Excel or PDF format

Zoom - Adjusts the displayed size of the report
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The report headers are defined as follows:

Work Order - Displays the number of completed (passed) macros, failed macros,
number of total installs (jobs requiring the macro), and percentage completed (number
of jobs passed over total number of jobs). If the macro name is expanded the report will
list the individual tests that were performed and indicate pass or fail for each test.

Technician - Displays the technician assigned to the work order.

Macro Compliance - Displays number of macros run by technician, number of macros
required by the Job Compliance Matrix, and the percentage of those run to those
required for the current work order. If the macro name is expanded, the report will
display the individual tests run as part of the marco. Clicking on the macro name will
generate a Macro Summary Report.

Data Log Compliance - Displays total number of macro steps run and the percentage
of those that passed. Displays the date the macro was run and if the macro is
expanded, will list the individual macro steps and the times they were run. If a macro
step is clicked on the data log can be viewed. Remember, the Workbench software
must be installed and open on the machine viewing the reports to view a data log.
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Meter Inventory

Introduction

The Meter Inventory Report is simply a detailed listing of all the 860 DSP and DSPi meters
recorded on the TDM server.

Report Parameters

The report parameters are defined as follows:

Comments - Text entered in this field will be displayed on
the report.

Order Meters By - Drop down menu. Choices are
Operator, Model, Firmware, Last Connection and
Calibration Date. Defines how results are listed.

Show Option Detail - If checked, report displays options
enabled on each meter.
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Explanation of the Report

Below is a sample of a Meter Inventory Report. The report will list the name of the report,
the date the report was generated, and how the report is displayed (Ordered by).

The report headers list the operator name of the meter, the model, the firmware version,
days since the meter last connected to the TDM server, the calibration date, and if selected
the various options installed on each meter.
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At the top of the report there are some additional options. These are defined as follows:

Refresh - Refreshes the current report if parameters are
changed

Print - Enables option to print the report

Print Layout - Print preview

Page Setup - Defines the page layout for printing

Save - Allows saving of the report in Excel or PDF format

Zoom - Adjusts the displayed size of the report
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Set Top Compliance Details

Introduction

The Set Top Compliance Details report could also be named the Macro Compliance
Details Report. Originally designed to provide technician compliance for the “set top”
macro, this report can be used to provide technician compliance for any macro listed on
the TDM Job Compliance Matrix.  The “set top” macro would typically be a macro run at the
set top box to ensure the technician was leaving the job with satisfactory measurements at
the customers TV set.

Report Parameters

The report parameters are defined as follows:

Comments - Text entered in this box will be displayed
in report.

Date Range - Limits results displayed to specified
date range.

Work Group Depth - Displays depth of work group
hierarchy listed on report.

Expand To - Denotes level of report detail. Choices
are work groups, technician, work order, macro and
data log. Report can be manually expanded.

Technicians - Specific tech IDs can be entered. If left
blank all technicians will be listed.

Work Groups - Specific work groups can be entered. If left blank all work groups will
be listed.

Macro Name - Defines name of macro. Wild card in the form of %Macro Name%.
Macro name must match macro name used in compliance matrix.

In the Technician and Work Group fields, multiple technicians or
work groups can be selected. Separate the values in this field
with a comma. For example, if “1234, 2345” was entered in
the Technician field the report would display only the results for
technicians 1234 and 2345.
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Explanation of the Report

Below is a sample of a Set Top Compliance Details report for the macro “home” with one
technician’s work order expanded to the data log level:

The sample above displays the name of the report, the date and time the report was
generated, the specified date range for the report, and the text entered in the Comments
field (Application Note Test Comments).

A green check beside the work order indicates all the tests in
the macro have passed. A red X indicates one or more steps
have failed.
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The report headers are defined as follows:

Work Groups - Displays the hierarchy of work groups, displays the names of the
specific work groups.

Technician - Displays the number of technicians in the work group hierarchy. Lists the
individual technicians according to work group. The plus sign beside the technician will
expand the report to the specific work orders for that technician.

Work Orders - Displays the number of completed (passed) macros, failed macros,
number of total installs (jobs requiring the macro), and percentage completed (number
of jobs passed over total number of jobs) for each technician up through the work group
hierarchy. If the technician is expanded the report will list the individual job numbers and
indicate pass or fail.

Macro Compliance - Displays number of macros run by technician, number of macros
required by the Job Compliance Matrix, and the percentage of those run to those
required for the individual technician up through the work group hierarchy. If the job
number is expanded, the report will display the macro name. Clicking on the macro
name will generate a Macro Summary Report.

Data Log Compliance - Displays total number of macro steps run and the percentage
of those that passed for individual technician up through the work group hierarchy.
Displays the date the macro was run and if the macro is expanded, will list the individual
macro steps and the times they were run. If a macro step is clicked on the data log can
be viewed. Remember, the Workbench software must be installed and open on the
machine viewing the reports to view a data log.
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At the top of the report there are some additional options. These are defined as follows:

Refresh - Refreshes the current report if parameters are
changed

Print - Enables option to print the report

Print Layout - Print preview

Page Setup - Defines the page layout for printing

Save - Allows saving of the report in Excel or PDF format

Zoom - Adjusts the displayed size of the report
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Set Top Compliance Summary

Introduction

The Set Top Compliance Summary Report could also be named the Macro Compliance
Summary Report. Originally designed for the “set top” macro, this report can be used to
display compliance results for any macro used in the TDM Job Compliance Matrix. Similar
to the Set Top Compliance Details Report, this report shows only the results for the work
group hierarchy. This report is not expandable to the technician or any lower level. The
advantage of this report is that on systems with large TDM databases, this report will
generate quickly and give management an overview of work group macro compliance.

Report Parameters

The report parameters are defined as follows:

Comments - Text entered in this box will be displayed
in report.

Date Range - Limits results displayed to specified
date range.

Work Group Depth - Displays depth of work group
hierarchy listed on report.

Technicians - Best left blank. Will give results for
specific tech if desired.

Work Groups - Specific work groups can be entered.
If left blank all work groups will be listed.

Macro Name - Defines name of macro. Wild card in
the form of %Macro Name%. Macro name must match macro name used in
compliance matrix.

In the Technician and Work Group fields, multiple technicians or
work groups can be selected. Separate the values in this field
with a comma. For example, if “1234, 2345” was entered in
the Technician field the report would display only the results for
technicians 1234 and 2345.
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Explanation of the Report

Below is an example of a Set Top Compliance Summary report for the “home” macro:

The sample above displays the name of the report, the date and time the report was
generated, the specified date range for the report, and the text entered in the Comments
field (Application Note Comment).

The report headers are defined as follows:

Work Groups - Displays the hierarchy of work groups, displays the names of the
specific work groups.

Technician - Displays the number of technicians in the work group hierarchy.

Work Orders - Displays the number of completed (passed) macros, failed macros,
number of total installs (jobs requiring the macro), and percentage completed (number
of jobs passed over total number of jobs) for each work group and the work group
hierarchy.

Macro Compliance - Displays number of macros run by technicians, number of
macros required by the Job Compliance Matrix, and the percentage of those run to
those required for the individual work groups up through the work group hierarchy.

Data Log Compliance - Displays total number of macro steps run and the percentage
of those that passed for individual work groups up through the work group hierarchy.
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At the top of the report there are some additional options. These are defined as follows:

Refresh - Refreshes the current report if parameters are
changed

Print - Enables option to print the report

Print Layout - Print preview

Page Setup - Defines the page layout for printing

Save - Allows saving of the report in Excel or PDF format

Zoom - Adjusts the displayed size of the report
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Technician Compliance

Introduction

Probably the most commonly used TDM report is the Technician Compliance Report. This
report is at the heart of TDM’s workforce management capabilities. With this report,
management can determine the answer to two basic questions: Did the technician run the
tests we want him to run for the particular job type, and did he leave the customer’s home
with passing results for those tests? This report can be used to grade technician
performance over time, as well as identify problem technicians.

Report Parameters

The report parameters are defined as follows:

Comments - Text entered in this box will be displayed
in report.

Date Range - Limits results displayed to specified
date range. Date ranges longer than seven days
automatically generate a summary report.

Work Group Depth - Displays depth of work group
hierarchy listed on report.

Expand To - Denotes level of report detail. Choices
are work group, technician, work order, and macro.
Report can be manually expanded.

Summary Only - If checked, will display non-
expandable report at technician level only.

Show Non-Required - If checked, will display all
macros uploaded for work order, regardless of whether or not they are required.

Technicians - Specific technicians can be entered. If left blank all technicians will be
listed.

Work Groups - Specific work groups can be entered. If left blank all work groups will
be listed.

Areas - Leave blank. Used for specific contractor version of TDM.

As stated above, if the date range is set to a period longer than seven days the report
generated will be a non-expandable summary report. The reason for this is that on larger
systems, the amount of requested data is so large that the report would take several
minutes to generate.
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Explanation of the Report

Below is an example of a Technician Compliance Report with one technician’s work order
expanded to the macro level:

In the Technician and Work Group fields, multiple technicians or
work groups can be selected. Separate the values in this field
with a comma. For example, if “1234, 2345” was entered in
the Technician field the report would display only the results for
technicians 1234 and 2345.

A green check mark beside the work order number denotes a
passing job. A red X indicates a job where one or more macro
steps have failed, or a required macro was not run. A yellow
triangle indicates there is no flat file information for that job
number. A mistyped work order number (task number) in the
technicians meter is a common cause for this.
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The report headers are defined as follows:

Work Groups - Displays the hierarchy of work groups, displays the names of the
specific work groups.

Technician - Displays the number of technicians in the work group hierarchy. Lists the
individual technicians according to work group. The plus sign beside the technician will
expand the report to the specific work orders for that technician.

Work Orders - Displays the total number of work orders for each technician up through
the work group hierarchy. Displays the percentage of those work orders that had
passing results (all steps in all required macros passed). Lists the job type as
determined by the flat file.

Macro Compliance - Displays number of macros run by technician, number of macros
required by the Job Compliance Matrix, and the percentage of those run to those
required for the individual technician up through the work group hierarchy. If the job
number is expanded, the report will display the macro name. Clicking on the macro
name will generate a Macro Summary Report. From this report the individual data logs
can be accessed. To open a data log, the Workbench software must be installed and
open on the local machine.

Data Log Compliance - Displays total number of macro steps run and the percentage
of those that passed for individual technician up through the work group hierarchy.
Displays the date the macro was run.

Report Analysis

In the example above, if we look at the values in the horizontal fields for tech 1111 we can
see that this tech had 5 work orders. Of those 5, 60% fully passed. He ran 7 of the 8
required macros for a compliance percentage of 88%. In the data log compliance field we
see that of the 16 macro steps run 94% passed. This indicates that, with a few exceptions,
this tech is running the required macros and leaving the job with passing results.

If we look at tech 2222 we see that of the 5 work orders he had only 20% passed. He was
fully compliant regarding the number of macros run (100%), however the data log
compliance shows that of the 20 macro steps run only 40% passed. This indicates that the
tech is running the required macros but leaving the job with mostly failed results.

Based on these two technicians, the analysis shows that tech 2222 is likely to have more
service callbacks than tech 1111. If technician 2222’s performance can be improved,
repeat visits to the customer’s home can be reduced. This will lower costs due to fewer
truck rolls and improve overall customer satisfaction.

The Technician Compliance Report is a powerful tool to help identify technicians that need
additional training or supervision and work groups that may need attention due to poor
performance.
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At the top of the report there are some additional options. These are defined as follows:

Refresh - Refreshes the current report if parameters are
changed

Print - Enables option to print the report

Print Layout - Print preview

Page Setup - Defines the page layout for printing

Save - Allows saving of the report in Excel or PDF format

Zoom - Adjusts the displayed size of the report
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